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はじめに
ようこそ！ FBV ShortboardTM MkII、FBV ExpressTM  MkII を入手された方は、Line 6 製品の数々の機能やサードパー
ティーのソフトウェアを「ハンズフリー」で遠隔操作することが可能です。本冊子は、POD® X3 や POD® X3 Pro、Line 6 
POD FarmTM 2, GearBoxTM ソフトウェア、そして MIDI コントロールに対応するサードパーティーの MIDI/DAW ソフト
ウェアをFBV MkII シリーズでコントロールするために必要なセットアップ、そして操作の方法について説明するガイド
ブックです。

お 手 持 ち の P OD  X 3、P OD  F a r m  2 ,  G e a r B o x、M I D I / D AW  ソフトウェアを 存 分 にご 活 用 頂くた
め 、ま た 、F B V  の ボ タン や ペ ダ ル か ら アク セ ス 可 能 な 機 能 を 十 分 に 理 解 して 頂 くた め 、ま ず は
各 製 品 の ユ ー ザ ー  マ ニ ュ ア ル に 目 を 通 さ れ る こと を お 勧 め 致 し ま す 。F B V  パ ッ ケ ー ジ に 同
梱された「FBV MkII Series Controller User Manual」にも有用な情報が記されています。 
これらの書類がお手元にない場合、Line 6 のサポートページより無償でダウンロードできます:    
http://line6.com/support/manuals/

FBV MkII と Line 6 Spider IV アンプ
L ine  6  FBV  Mk I I  シリーズのコントローラーは数々の  L i ne  6  アンプにも使用できるよう設計されてい
ます。特に新機種の  L ine  6  Spider®  IV  /  Spider  ValveTM MkI I  アンプでは、Quick  Loop、カスタムプリ
セットへ の アクセ ス 、アン プ や エ フェクトの パ ラメー タ 操 作 、そして そ の 他 、搭 載 され た 多 数 の 機 能
を 遠 隔 操 作 することが 可 能です。尚 、F BV  Mk I I  コントローラーで  S p i d e r  I V  を 操 作 する方 法 につ い
ては、「Spider IV Advanced User Guide」で説明しています。     
Line 6 のサポートページより無償でダウンロードできます:      
http://line6.com/support/manuals/

Line 6 Monkey でのアップテートとユーザー登録
さて、FBV MkII や他の Line 6 製品のアップデート、そしてユーザー登録の手続きに関してはすでにご存知かもしれませ
ん。が、もしも今、新しい機材を手にして興奮されているのなら、ここでその手続きを済ませてしまいましょう！ その手順
は本当にシンプルです。インターネットに接続されたコンピュータ上で Line 6 Monkey を起動するだけです。このインテ
リジェントなアップデート ソフトウェア「Line 6 Monkey」は、通常、Line 6 製品のソフトウェアと同時にインストールされ
ますが、まだインストールされていない場合、Line 6 のサイトより無償でダウンロードできます:    
www.line6.com/monkey/

Line 6 Monkey ソフトウェアのインストールが完了したら、FBV MkII をコンピュータの USB ポートに接続してくださ
い（Line 6 Monkey には FBV だけをチェックさせたいので、この時、他の Line 6 USB デバイスは接続しないでくださ
い）。また、Line 6 FBV Control アプリケーションや MIDI/DAW アプリケーションが起動している場合、それらを終了し
てください。そしてコンピュータがインターネットに正常に接続されていることを確認し、以下のように選択して Line 6 
Monkey を起動します...

• Mac®の場合: アプリケーション > Line 6 > Line 6 Monkey

• Windows®の場合: スタートメニュー > プログラム > Line 6 > Tools > Line 6 Monkey

  

http://line6.com/support/manuals/
http://line6.com/support/manuals/
http://www.line6.com/monkey/
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ログインのアカウント
Line 6 Monkey がオンラインで Line 6 サーバーと交信し、お使いの特定の製品に関する更新があるかを確認するた
め、ログインする必要があります。アカウントは数クリックで作成でき、無料です！

• Line 6 のアカウントをお持ちであれば、Monkey ダイアログ上部に “User Name”（ユーザーネーム）と “Password”
（パスワード）を入力してください。

• アカウントを作成していない方は、“New User” ボタンをクリックしてください。アカウント作成手順に進みます。

FBV を登録する
アップデートや製品の認証など、お使いの Line 6 製品の登録が必要とされている場合があります。また、登録を行うこと
により、保証サービスが発効し、ソフトウェアの新バージョンの提供や他のクールな機能強化（最先端のテクノロジー）の
恩恵を受けられるようにもなります！

まだ登録がお済みでない場合、接続された FBV MkII の登録を促すダイアログが表示されます。“Register” ボタンをク
リックし、ウェブページでの空欄に入力してください。このページには登録済みの Line 6 製品がすべてまとめて表示され
ます。

アップデートを入手する
Line 6 Monkey を起動すると、接続された FBV MkII デバイスが自動的に検知されます。Line 6 Monkey の “Updates” ス
クリーン内にエクスクラメーション マーク（  のシンボル）が付されているアイテムがある場合、リストでそのアイテム
を選択し、“Update Selection” ボタンをクリックしてください。有能な秘書である Monkey により、インストール手順がス
タートします。“Updates” スクリーン内で緑色のチェック（  のシンボル）が付されているアイテムは最新の状態です。
お使いの FBV をコンピュータに接続して使用するのであれば、ここで是非とも、Monkey 経由で Line 6 FBV Control ア
プリケーションを入手しておいてください（このアプリケーションについては次の項で説明しています）。

右の欄には、現在インストールされているアイテムのバージョン ナンバーと有効な最新バージョンのナンバーが並んで
います。“Updates” リストでアイテムをクリックすると、その詳細が下の “Help and Info” の枠に示されます。左側には接
続された FBV デバイスと、その個別 ESN（エレクトロニック シリアル ナンバー）が示されます。登録や保証サービスの際
には、この ID ナンバーをご参照ください。

Line 6 Monkey を起動するだけで、Line 6 ソフトウェア/ハードウェアを常に最新のものにアップデートすることが可能
です！
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Flash Memory のアップデート
お使いの FBV の “Flash Memory” の最新版が入手可能であると Monkey が告げている場合、パフォーマンスと製品の
互換性の向上のため、最新版をインストールすることが重要です。Monkey の指示に従い、いくつかの手順を実行してく
ださい。以下の事項に注意してください:

• 起動している Line 6 ソフトウェア、サードパーティーの MIDI/DAW アプリケーション（FBV MkII デバイスを使用し
ている可能性のあるもの）を終了します。

• アップデートが完了するまで、FBV デバイスのボタンやペダルを操作したり、ケーブルの接続を変更することはお
やめください。

• Line 6 Monkey により、アップデートの正常な完了が知らされたら、一度 Line 6 Monkey を終了した後、再度これ
を起動して、その他にアップデートが必要なものがあるかどうかを確認します。

Line 6 FBV Control アプリケーションのインストール
Mac® または Windows® のコンピュータ上に起動したソフトウェアを FBV MkII でコントロールすることをお考えであ
れば、最新版の Line 6 FBV Control アプリケーションをインストールしてください。この無償ソフトウェアにより、FBV プ
リセット（カスタマイズされた MIDI コントローラー設定のフルセット）の作成、読み込み、編集、保存が可能となります。 
とても使い勝手のよいアプリケーションです！

ノート: この項では、Line 6 FBV Control アプリケーションの入手とインストールの方法について説明します。ソフトウェ
アの使用法については、「Line 6 FBV Control アプリケーション」（ 3•1 ページ） をご参照ください！
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システムの必要条件
システムの必要条件の詳細、他のハードウェア/ソフトウェアとの現時点での互換性に関しては、別書類「Line 6 FBV 
Control Release Notes」をご参照ください。この書類は、Line 6 Support Community、または FBV MkII Online Help  
のページから入手できます。

Line 6 FBV Control アプリケーションは以下のコンピュータ OS（オペレーティング システム）をサポートしています:

• Windows® XP Home または Professional（Service Pack 2 以上）、32 と 64 bit バージョン

• Windows Vista® Home、Business または Ultimate Edition、32 と 64 bit バージョン

• Windows® 7 Home または Professional、32 と 64 bit バージョン

• Mac OS® X 10.4 （Tiger®）. 10.5 (Leopard®), 10.6 (Snow Leopard®) 

Windows® 7 / Vista® ユーザーへのノート: Line 6 FBV Control アプリケーションを起動している場合、もしくは、FBV 
を USB ポートに接続している場合、Windows® をスリープ モードにすることはお勧めできません。Windows® の USB 
Class Compliant ドライバの特有な挙動により、スリープからの脱却時に USB デバイス（FBVなど）が適切に初期化さ
れない場合があります。

すでに Line 6 Monkey ソフトウェア ユーティリティーをインストールしてある場合...
Line 6 FBV MkII デバイスを Mac® または Windows® コンピュータの USB ポートに接続したら、Line 6 Monkey を起動
することができます。システムがスキャンされ、最新版の Line 6 FBV Control インストーラーの有無が示されます（前項
を参照）。Line 6 Monkey 内で Line 6 FBV Control アプリケーションを選択すると、ソフトウェアのダウンロードとインス
トーラーの起動へ進むことができます。その場合、インストーラーの指示に従ってください。

まだ Line 6 Monkey ソフトウェア ユーティリティーをインストールしていない場合...
最新版の Line 6 FBV Control アプリケーションのインストーラーは、www.line6.com/software/ から無償で入手可能で
す。“Product” セレクタでは、お使いの FBV MkII のデバイス名を正しく選択するようご注意ください。“Software” セレ
クタでは “Line 6 FBV Control” を選択し、“OS” セレクタではコンピュータのオペレーティング システム（“Mac®” または
“Windows®”）を特定します。ダウンロードが完了したらインストーラーを起動し、示される手順を実行してください。

Line 6 FBV Control インストーラーは Line 6 Monkey の最新版もインストールします。つまり、これらを別々にダウン
ロードする必要はありません。また、ご使用の FBV MkII ハードウェアには、特にインストールの必要な「USB デバイスの
ドライバ ソフトウェア」というものはありません。単に USB ケーブルで Mac® または Windows® コンピュータに接続して
頂くだけで、オペレーティング システムにより、新しい USB MIDI デバイスとして自動的に検知されます。

Line 6 ソフトウェアの互換性について
POD Farm 2スタンドアローン・アプリケーションとPOD Farm 2 プラグインは、共に広範囲に渡る、MIDI コントロール能
力が備わっています。お手持ちのFBV MkIIは、この両方を活用できるまさに完璧な USB‒MIDIコントローラー・デバイス
です(「FBV™ MkIIと共にLine 6 POD Farm™ 2」（ 4•1 ） 参照)! 初期の POD Farm™ 1.1 バージョンでは外部 MIDIコント
ロールのサポートをすることができません。 お手持ちのFBV MkIIハードウエアを使用してLine 6 GearBox™ソフトウエ
アをコントロールさせたい場合は、最高のパフォーマンスを発揮させるためにGearBox 3.7バージョン(またはそれ以降
のバージョン)をインストールする事をお勧めします(「FBV™ MkII と Line 6 GearBox™」（ 5•1 ） 参照)。 最新のGearBox
バージョンを入手する際は、 GearBox (TonePort™, POD Studio™ または GuitarPort™ ハードウエア)に使用する Line 6 
USBオーディオ・デバイスを接続し、Line 6 Monkeyを起動させてください。または直接 Line 6 Software Downloads ウエ
ブページへアクセスして 「GearBox」を選択して最新のインストーラーを入手してください。

http://line6.com/support/
http://line6.com/manuals/footcontrollers/
http://line6.com/software/
http://line6.com/software/
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 Line 6 FBV Control のアンインスール
アプリケーションをアンインストールする必要がある場合、次の手順を実行してください:

• Mac® - ファインダーで “アプリケーション” フォルダにある “Line 6” フォルダを開き、“Line 6 FBV Control” アプリ
ケーションをゴミ箱に移動することによって削除します。 

• Windows® - “スタート > Programs > Line 6 > Tools” と辿り、“Line 6 Uninstaller” ユーティリティーを選択しま
す。Line 6 のアプリケーションやデバイス ドライバーの削除をエスコートする便利なユーティリティーです。削除
手順の途中で “Line 6 FBV Control” を選択します。

FBV MkII と POD® X3 を接続する
FBV Shortboard MkII または FBV Express MkII と、 POD X3 または POD X3 Pro デバイスとの接続は簡単です。ケーブ
ルを1本だけ使用します:

• まず、POD X3 の電源をオフにします。

FBV ユニットには、両端に「RJ-45」コネクタを備えた長いケーブルが付属します。このケーブルは、
本当に標準的な「カテゴリ5」のコンピュータ ネットワーク用のケーブルですので、紛失の際や、バ
ンドのドラマーがケーブルの上にシンバルを落としてしまった場合は、お近くの電気店やコン
ピュータ ショップで、このタイプのケーブルをお買い求めください。 

• ケーブルの一端を FBV の背面の TO AMP 端子に、もう一端を POD X3 の FBV PEDAL 端子に接続します。

• POD X3 の電源をオンにします。

FBV MkII ユニットへの電源も、このケーブル経由で供給されます。FBV ディスプレイにパッチネームが表示され、インジ
ケーター類が点灯するはずです。

ノート: 通常、上記のように RJ-45 ケーブルを接続している場合、FBV MkII デバイスに USB ケーブルを接続する
ことはしません。USB ケーブルを接続した場合、FBV は「USB モード」となり、コンピュータと交信するためです。 
けれども、FBV で POD X3 をコントロールしながら、POD X3 を USB オーディオ デバイスとして使用する、あるい
は Line 6 GearBox ソフトウェアと一緒に使用する場合には、USB ケーブルで POD X3 とコンピュータを接続する
ことができます（POD X3 からコンピュータの USB 2.0 ポートへ）。

FBV MkII をコンピュータに接続する
FBV Shortboard MkII または FBV Express MkII を使用してソフトウェアをコントロールするには、標準のコンピュータ用 
USB ケーブルを用いて、FBV ユニットの USB 端子と Mac® または Windows® コンピュータの USB 1.1 または 2.0 ポート
を接続してください。FBV MkII ユニットへの電源も、この USB ケーブル経由で供給されます。FBV の LCD ディスプレイ

での表示やインジケーター類の点灯により、電源のオンが示されます。

初めて FBV Shortboard/Express MkII デバイスをコンピュータの USB ポートに接続すると（初回）、FBV がコンピュータ
のソフトウェアやハードウェアと共に正常に動作するように、オペレーティング システム（Mac® または Windows®）はデ
バイス ドライバのインストールを要求します。Mac® または Windows® 7 / Windows Vista® コンピュータの場合、このプ
ロセスは自動的に行われますので、次の項は読み飛ばして頂いて構いません。
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Windows® XP の場合、いくつかのダイアログ内をクリックして進み、デバイス ドライバをインストールします。USB ケー
ブルを接続すると、Windows® XP が新しいデバイスを検知したことを知らせる表示が画面右下に現れます。

次に、“Windows® Hardware Wizard” が起動します。“No, not this time” を選択し、“Next” をクリックしてください。

次に開かれるダイアログでは、“Install automatically” オプションを選択し、“Next” をクリックします。

ここに注目してください。XP は FBV を認識し、
“USB Audio Device” としてインストールします。 
これは、Windows® XP USB Class Compliant ドラ
イバの正常な動作です。

そして、インストール完了を告げる最終ダイアログが表示されるはずです。“Finish” をクリックしてください。これで FBV 
を使用する準備が整いました！
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FBV のペダルのキャリブレーション

注意：次のキャリブレーションの手続きは、FBV MkII のフラッシュメモリーのバージョンが1.00である場合は必
要ありません。しかし、フラッシュメモリーのバージョンが1.00より前である場合、パフォーマンスを最適化するた
め、FBV pedal をキャリブレートする必要があります。 FBV MkII の現在のフラッシュメモリーのバージョンを確
認したり、入手可能な新しいフラッシュメモリーのバージョンをダウンロードしてインストールするには、Line 6 
Monkey を使い、1•2 ページのアップデート方法に従ってください。

お使いの FBV Shortboard、Express MkII デバイスのオンボード ペダルからベストのパフォーマンスを引き出すため、 
コンピュータや Line 6 Amp または POD との使用を開始される前に、以下の手順でペダルのキャリブレーションを実行
することをお勧めします。

FBV Shortboard MkII でのキャリブレーション手順
• FBV デバイスが USB ポートや Line 6 デバイスに接続されていない状態にします（電源はオフとなります）。

• フットスイッチ “D” を踏み続けながら、FBV の電源をオンにします（コンピュータの USB ポートや FBV で使用す
る Line 6 デバイスに接続してください）。この時、LCD には “CALIBRATE PEDAL” と表示されるはずです。フットス
イッチ “D” を放すと “1 PEDAL TOE” と表示されます。

• オンボードのペダルを前へ完全に踏み込み、LCD 表示が “2 PEDAL MIN” となるまで、ペダルのトゥ スイッチを
作動させ続けます。通常、表示はすぐに切り替わります。

• ペダルをヒール ポジション（かかと側、最小）にします。ペダルをそのままの状態に保ちながら、“D” ボタンを押し
て放します。LCD には “3 PEDAL MAX” と表示されます。

• ペダルをトゥ ポジション（つま先側、最大）にします。この時、トゥ スイッチは作動させないでください。ペダルを
トゥ ポジションに保ちながら、“D” ボタンを押して放します。LCD には “CHECK VALUE 127” と表示されます。

• ペダルを動かしてみましょう。最小ポジションで “CHECK VALUE  0”、最大ポジションで “CHECK VALUE 127”、と 
LCD に表示されることを確認します。

• “0” や “127” 以外の数値が表示される場合、上記キャリブレーション手順を繰り返し行ってください。数値が正し
ければキャリブレーションは成功です。一旦、FBV の電源をオフにし、再度オンにして準備万端です！
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FBV Express MkII でのキャリブレーション手順
• FBV デバイスが USB ポートや Line 6 デバイスに接続されていない状態にします（電源はオフとなります）。

• フットスイッチ “D” を踏み続けながら、FBV の電源をオンにします（コンピュータの USB ポートや FBV で使用す
る Line 6 デバイスに接続してください）。フットスイッチ “D” を放すと、FBV チューナーの数値ディスプレイに “1” 
と表示されます。

• オンボードのペダルを前へ完全に踏み込み、チューナーの表示が “2” となるまで、ペダルのトゥ スイッチを作動
させ続けます。通常、表示はすぐに切り替わります。

• ペダルをヒール ポジション（かかと側、最小）にします。ペダルをそのままの状態に保ちながら、“D” フットスイッ
チを押して放します。チューナー ディスプレイには “3” と表示されます。

• ペダルをトゥ ポジション（つま先側、最大）にします。この時、トゥ スイッチは作動させないでください。ペダルを
トゥ ポジションに保ちながら、“D” フットスイッチを押して放します。チューナーの数値ディスプレイの上に位置す
る 7 個の LED が点灯します。

• チューナーの数値ディスプレイの LED に注目しながらペダルを動かします。ペダルを最小ポジションに向けて動
かすと LED が順次に消灯し、最大ポジションに向けて動かすとすべての LED が順次に点灯することをご確認く
ださい。

• 7 個の LED が前記のように点灯しない場合、上記キャリブレーション手順を繰り返し行ってください。LED が正し
く点灯すればキャリブレーションは成功です。一旦、FBV の電源をオフにし、再度オンにして準備万端です！

EX-1 Expression Pedal 
FBV Shortboard MkII のオーナーの方には、さらなるコントロールを実現するために2つ目のペダルを追加するという選
択肢があります！ 「Line 6 EX-1 Expression Pedal」（エクスプレッション ペダル）は、FBV Shortboard MkII と一緒に使用
するように設計されています（シャーシ背面の “Expression Pedal” 端子に接続）。EX-1 は Line 6 Online Store （オンラ
イン ストア）でも直接お買い求め頂けます。あるいは、Line 6 販売店までお問い合わせください。 

ノート: Expression Pedal の場合、キャリブレーション手順は必要ありません。 

上記手順を終えたら、Line 6 FBV MkII シリーズ コントローラーを手にして、以下の章へと読み進みましょう！ 次の章で
は、お手持ちの FBV でコントロールされるギア、POD X3 について記します。

http://line6.com/store/
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FBV™ MkII と POD® X3 
この章は、FBV Shortboard または Express MkII を使用して POD X3 「Bean（豆）」 または POD X3 Pro デバイスをコント
ロールする際に特有の機能について説明しています。記された説明は、特に注意書きのない限り、POD X3 「Bean（豆）」 
または POD X3 Pro に共通となっています。あらかじめ FBV MkII を POD X3 に接続し、共に正しく動作するよう準備して
おいてください（「はじめに」（ 1•1 ） をご参照ください）。それでは先に進みましょう...

クイック スタート
さて、「テスト ドライブもせずに、この章を読破するなんて我慢が続かない」というお気持ちはわかります！ ご存知と思わ
れますが、FBV MkII と POD X3 は箱から取り出して、そのまますぐに使用できるような製品です。そこでまず、即効性のあ
るヒントをいくつかご紹介しましょう...

• “A”、“B”、“C”、“D” のチャンネル ボタン： POD X3 の “User” フォルダ内の現在のバンクの 4つの「チャンネル」のど
れか1つを選択して呼び出します。

• FBV Shortboard™ MkII： まず、「バンク ボタン」（上下の矢印のラベル）でユーザー バンクをスクロールし
ます。次に、“A” から “D” のボタンを使用して選択バンク内の目的のプリセットを呼び出します。

• FBV Express™ MkII： POD 上で “Press to Save” と記されたノブを回してユーザー バンクをスクロールし
てください。“A” から “D” のチャンネル ボタンで現在のユーザー バンク内のプリセットを選択できます。

• ペダル: 通常、現在のプリセットのワウ（Wah）またはボリューム（Volume）をコントロールします。ペダルを前に押
し込んでトゥ スイッチを作動させると、ワウ/ボリュームが切り替わります。

• Tap: テンポに合わせてタップすると、アクティブなディレイまたはモジュレーション エフェクトが追随します。

• エフェクト フットスイッチ（Shortboard のみ）: 現在のプリセット内のエフェクトをオン/オフします。

• Function 1 & 2 フットスイッチ（Shortboard のみ）: 初期設定の場合、それぞれのスイッチで現在のプリセット
内の Comp エフェクトと Amp をオン/オフします。

詳細に進む用意はできましたか？ この先には数々のオプションやワザやトリックが控えています！

ユーザー プリセットを呼び出す
これこそ、FBV MkII コントローラーを使う第一の目的とも言えるでしょう。苦心して作り上げたプリセットをハンズフリー
で呼び出せます！ その仕組みはまったくシンプルです。FBV を使用すれば、POD X3 のユーザー フォルダに保存された
プリセットに直接アクセスできます。すでにロードされているプリセットがユーザー フォルダに保存されているものであ
るかどうかに関わらず、プリセットを呼び出すために FBV を踏むと、自動的にユーザー フォルダに切り替わることを確認
できます。

FBV Shortboard™ MkII
バンク アップ/ダウン: バンク アップ/ダウンを踏むごとに、次のユーザー バンク/チャンネルにキューします。例えば、現
在、プリセット “1B” がロードされているとします。バンク アップを踏むと、FBV のディスプレイはプリセット “2B” に選択さ
れたトーンの名称を点滅表示します。実際にはまだ音色が切り替わりませんが、そこに何があるのかを確認できます。

チャンネルのロード: “A”、“B”、“C”、“D” のチャンネル ボタンにより、現在のユーザー バンク内の各プリセットを瞬時に
ロードすることができます。バンク アップ/ダウン ボタンを踏むとディスプレイは点滅しますが、これはチャンネル選択を
待機していることを意味します。前記の例の場合、“A” を踏むとプリセット “2A” が、“B” を踏むとプリセット “2B” がロード
されます。



FBV MkII Advanced User Guide:   POD X3

2•2

FBV Express™ MkII
チャンネルのロード: “A”、“B”、“C”、“D” のボタンにより、現在のユーザー バンク内の各プリセットを瞬時にロードすること
ができます。POD X3 のユーザー フォルダ内の 1 - 32 までナンバリングされたバンクのいずれかを選択するには、POD 
上で “Press to Save” ノブを回してください。

POD X3 の「ホーム」ページ
POD X3 の「ホーム」ページは、現在のプリセットの各要素を表示するメインの画面です。POD X3 がユーザー フォルダ
にセットされている場合、“HOME” ボタンを押して「トーン経路」表示と「ビッグ ユーザー」表示とを切り替えることができ
ます。ビッグ ユーザーの場合、トーンの名称に加え、遠目でも確認できるサイズでプリセットのバンク/チャンネルが表示
されます。FBV/POD X3 をライブで使用する場合、安物のサングラスでお洒落している場合など、とても役立つでしょう！

POD X3 の「ホーム」ページ - 「トーンの経路」表示（左）と「ビッグ ユーザー」表示（右）

ユーザー プリセット フォルダ
すでにお気づきかもしれませんが、 POD X3 はトータルで 350 以上のプリセットを持ち、それらは「フォルダ」の中に整
然と分類されています。POD X3 のホームページでは、対応するマルチ機能のノブを使用して、これらのフォルダをナビ
ゲートすることができます:  

ユーザー フォルダには、ご自身のカスタム プリセットを保存するのに使用可能な「ユーザー ロケーション（User 
location）」が 128 あります。FBV でチャンネル ボタン（“A”、“B”、“C”、“D”）のいずれかを踏むと、自動的に POD X3 がユー
ザー フォルダに切り替わり、現在のバンクのプリセットを呼び出すことを確認できます。FBV と POD X3 を組み合わせて
使用する際の大きなポイントは、ご自身のプリセットを細かく目的通りに作成し、それらをユーザー フォルダの 128 の
メモリ ロケーション内に保存しておくということです。以降、FBV から、これらのユーザー プリセットにアクセスすること
が可能です。

あらかじめ、お役に立てるよう、ユーザー フォルダのチャンネル ロケーションの若い番号にいくつかのプリセットが用意
されています。もちろん、これらをご自由に編集できます。ご自身の手で POD X3 ユニットの他のフォルダを選択し、POD 
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X3 のオンボードのノブで他のプリセット（*）をスクロールすることもできます。これらも編集可能です。編集後は、“SAVE” 
ボタンを使用し、ユーザー フォルダの中の 128 のロケーションのいずれかを選択して、カスタム プリセットとして保存

すれば、FBV からアクセスすることが可能になります。

* FBV Shortboard MkII モデルの場合、LCD ディスプレイは常に「POD X3 の現在のプリセット名」を表示することに
ご注意ください。そのプリセットがユーザー フォルダ以外のフォルダ内にある場合も同様です。そして FBV のエフェ
クト スイッチとペダルはこの現在のトーンをコントロールします。けれども、バンクと“A”、“B”、“C”、“D” のボタンは、常
に POD X3 をユーザー フォルダに自動的に切り替え、128 のユーザー プリセットのいずれかを呼び出します。

エフェクトをコントロールする
FBV を使用すると、POD X3 の機能の深部に入ってチューンナップのようなことをしたり、エフェクトを変則的に使用した
り・・・などが可能です。

ノート: POD X3 のプリセットは、2 つのトーン（独自のエフェクトのセットとパラメータを設定可）で構成することも可
能です。POD X3 自身からエフェクト ブロックやパラメータに直接アクセスするのと同様、後述のフットスイッチ ボタ
ンで、現在選択中のトーンのこれらのエフェクト（のみ）をコントロールすることができます。「トーン 1」と「トーン 2」
の切り替えは POD X3 の “TONE 2” ボタンで行います。Shortboard の場合、“FUNCTION 1” ボタンにトーン切り替え
を割り当てることも可能です。詳しくは、「デュアル トーンのプリセットをコントロールする」 （2•9） をご参照ください。

FBV Shortboard™ MkII
FUNCTION 1: 初期設定の場合、このボタンは COMP エフェクトのオン/オフを切り替えますが、AMP+CAB のオン/オ
フ、トーン 1/2 の切り替え、FX Loop のオン/オフ（X3 Pro ユニットのみ）のコントロール用にもカスタマイズできます。

ヒント: POD X3 の“SYSTEM” スクリーンには、トーン 1とトーン 2、それぞれの “LP SW” （Loop Switch）設定があり、
FBV Shortboard の “FUNCTION 1” スイッチでトリガーする動作を選択できます。この設定はユーザー プリセットご
とに指定できます。詳しくは 「POD X3 システム設定 - ペダルのセッティング」 （2•4） をご参照ください。

FUNCTION 2: AMP+CAB ブロックのオン/オフの切り替え

STOMP: STOMP ブロックのオン/オフの切り替え

MODULATION: MOD ブロックのオン/オフの切り替え

DELAY: DLY ブロックのオン/オフの切り替え

REVERB: VERB ブロックのオン/オフの切り替え

TAP: テンポに合わせてタップすると、対応する DELAY と MOD エフェクトが追随します。ボタンの上の LED が点滅し、
現在のテンポを示します。

TUNER: TAP ボタンを 2 秒間押したままにすると、チューナー機能が呼び出され、FBV ディスプレイは便利なチュー
ナー画面となります。ボタンを再度押すとチューナー機能が終了します。

ヒント： POD X3 上（“Tuner” ページ）では、チューナー モード時のオーディオ ミュートのオン/オフを設定できます。 
観客はチューニングの正しいギター演奏を聞きに来ているのでしょうが、チューニングの様子は聞きたがらないかも
しれません！
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ペダル: オンボードのペダル（接続された Expression Pedal も同様）は、「トーン 1/トーン 2/両方のトーン」のコントロー
ルとに割り当てたり、異なる機能（WAH、VOLUME、TWEAK）に割り当てたりすることが可能です。トーンごとのペダルの
動作設定など、詳しくは後述の「POD X3 システム設定」をご参照ください。

ペダルの VOL & WAH インジケーター: オンボード ペダルの左に位置する 2 つの LED により、現在のモードが示さ
れます。両方の LED が点灯している場合、ペダルはアサインされた TWEAK パラメータをコントロールしています。 
数多くのエフェクト パラメータから 1 つのメニューを選択し、それを TWEAK パラメータとしてペダルでコントロール
できます。下記「POD X3 システム設定」の項をご参照ください。

FBV Express™ MkII
テンポのタップ: テンポに合わせてタップし、対応する Delay と Mod エフェクトを追随させるには、現在点灯している
チャンネル ボタン（“A”、“B”、“C”、“D” のどれか）をタップしてください。チューナー ディスプレイの LED の点滅で、現在の
テンポを確認できます。

チューナー: チューナー モードに入るには、現在点灯しているチャンネル ボタン（“A”、“B”、“C”、“D” のどれか）を 2 秒間踏
み続けてください。オンボードのチューナーがアクティブとなります。チューナー モードを終了するには、チャンネル ボタ
ンのどれかを踏んで放します（同じトーン プリセットに戻ります）。また、ペダルを最大まで踏み込んでトゥ スイッチを作
動させるとチューナー モードが終了すると同時に、ペダル コントロール（WAH と VOL）が切り替わります。

ヒント： POD X3 上（“Tuner” ページ）では、チューナー モード時のオーディオ ミュートのオン/オフを設定できます。 
観客はチューニングの正しいギター演奏を聞きに来ているのでしょうが、チューニングの様子は聞きたがらないかも
しれません！

ペダル: オンボードのペダルは、「トーン 1/トーン 2/両方のトーン」のコントロールに割り当てたり、異なる機能（WAH、
VOLUME、TWEAK）に割り当てたりすることが可能です。トーンごとのペダルの動作設定など、詳しくは後述の「POD X3 
システム設定」をご参照ください。

ペダルの VOL & WAH インジケーター: オンボード ペダルの左に位置する 2 つの LED により、現在のモードが示さ
れます。両方の LED が点灯している場合、ペダルはアサインされた TWEAK パラメータをコントロールしています。 
数多くのエフェクト パラメータから 1 つのメニューを選択し、それを TWEAK パラメータとしてペダルでコントロール
できます。下記「POD X3 システム設定」の項をご参照ください。

POD X3 システム設定 - ペダルのセッティング
POD X3 の SYSTEM スクリーンの最初のページには、FBV Shortboard または Express のペダルの動作に関して確認
すべきオプションがいくつかあります。POD X3 上で OUTPUTS/HOLD FOR SYSTEM ボタンを押し続け、システム設定
画面を表示させてください。

POD X3 システム画面の最初のページ
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トップの列の 3 つの “PEDAL” 設定は、FBV MkII の「WAH/VOLUME/TWEAK ペダル」が現在のプリセットにどのように作
用するかを設定するものです。ペダルには「操作モード」（WAH/VOLUME/TWEAK のいずれかをコントロール）があるこ
とにご注意ください。また、ペダルは、トーン 1/トーン 2 ごとに、異なるモードで操作可能です。

• FBV Shortboard MkII - オンボードのペダルを搭載しています。これはペダル “1” です。FBV Shortboard に 
Expression Pedal が接続されていない場合、ペダル “2” のオプションは無効となります（これらの設定は、前図の
ように括弧で括られます）。

• FBV Shortboard に接続された Expression Pedal は、ペダル “2” となります。下図のようにペダル “2” がアク
ティブとして表示されます（括弧なし）:

POD X3 システム画面 - Shortboard に Expression Pedal を接続した場合

• FBV Express MkII - オンボードのペダルを搭載しています。これはペダル “1” です。2 つ目のペダルを接続する
ことはできないので、システム画面ではペダル “2” のオプションが括弧に括られ、無効であることが示されます。

これらのシステム設定（“PEDAL”、“TWK”、“LP SW”）はすべて現在のプリセットに特有です。 つまり、これらの各設定を行
い、現在の設定と一緒に保存すると、FBV のペダルはそれぞれのプリセットに見合う機能を果たします。

ノート: POD X3 のどのプリセット ロケーションも、1 つまたは 2 つの独立したトーン（トーン 1 とトーン 2）で構成する
ことができます。このシステム設定では、いつでも（現在編集中のプリセットでトーン 2 が現在アクティブでない場合
にも）、トーン 2 の設定を確認し、編集することが可能です。 

PEDAL CNTRL - システム設定で一番左の “PEDAL” では、ペダルが作用する対象（トーン 1 とトーン 2 のどちらか、ある
いは両方のトーン）を選択します。初期設定の場合、すべての現在のプリセットで BOTH TONES となっています。ペダ
ルには非常に高い自由度が与えられています。プリセットの各トーンごとにペダルの設定が可能です。まずは、以下の選
択による動作の違いにご注意ください:

TONE 1 ONLY - ペダル 1（そして、接続されている場合はペダル 2 も）は、トーン 1 にのみ影響を及ぼし、トーン 1 の
「ペダル モード設定」に従います。トーン 2 のペダル モード設定とオン/オフ状況は無視されます。

TONE 2 ONLY - ペダル 1（そして、接続されている場合はペダル 2 も）は、トーン 2 にのみ影響を及ぼし、トーン 2 の
「ペダル モード設定」に従います。トーン 1 のペダル モード設定とオン/オフ状況は無視されます。

BOTH TONES - ペダル 1（そして、接続されている場合はペダル 2 も）は、トーン 1 のペダル モード設定に従い、トー
ン 1 に影響を及ぼします。同時に、トーン 2 のペダル モード設定に従い、トーン 2 に影響を及ぼします。

ノート: デュアル トーン プリセットにおける FBV ペダルのオプションと動作については、後述する「デュアル トーンで 
FBV ペダルを使用」の項をお読みください。

TONE1 PEDAL - この “TONE1” 設定では、トーン 1 に対する、ペダル 1 とペダル 2（接続されている場合）の操作モード
を設定します。この設定は厳密にトーン 1 のみに関するものであり、トーン 1 がペダルでコントロールされるか否かは、
“PEDAL CNTRL” での設定値（上記参照）により決定します。FBV Shortboard に Expression Pedal を接続した場合、表
示されるペダルのオプションが異なることにご注意ください...
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Expression Pedal のない場合、FBV Express と Shortboard の “PEDAL TONE1” オプションは以下のようになります:

• 1-W/V 2-VOL - ペダル 1 はトーン 1 の Wah または Volume エフェクトの Position パラメータをコントロールし
ます。トゥ スイッチで、これら 2 つのエフェクトのコントロールを切り替えます。ペダル 2 のオプションは無効です。

• 1-TWK 2-VOL - ペダル 1 は、現在トーン 1 にアサインされている Tweak パラメータをコントロールします（下記、
「TONE1 TWK」の項を参照）。ペダル 2 のオプションは無効です。

• 1-W/V 2-TWK - ペダル 1 はトーン 1 の Wah または Volume エフェクトの Position パラメータをコントロールし

ます。トゥ スイッチで、これら 2 つのエフェクトのコントロールを切り替えます。ペダル 2 のオプションは無効です。

Expression Pedal のある場合、 FBV Shortboard の “PEDAL TONE1” オプションは以下のようになります:

• 1-W/OFF 2-VOL - ペダル 1 は Wah をコントロールし、トゥ スイッチで Wah エフェクトをオン/オフします。Wah 
がオフの場合、ペダル 1 は何も機能しません。ペダル 2 は常に Volume をコントロールします。

• 1-TWK 2-VOL - ペダル 1 は、現在トーン 1 にアサインされている Tweak パラメータをコントロールします（下記、
「TONE1 TWK」の項を参照）。トゥ スイッチは無効です。ペダル 2 はトーン 2 の Volume をコントロールします。

• 1-W/V 2-TWK - ペダル 1 は Wah または Volume エフェクトの Position パラメータをコントロールします。トゥ 
スイッチで、トーン 1 に対するこれら 2 つのエフェクトのコントロールを切り替えます。ペダル 2 は、現在、Tweak 
パラメータにアサインされているトーン 2 のパラメータをコントロールします（下記、「TONE2 TWK」の項を参

照）。

TONE2 PEDAL - これらの “TONE2” 設定では、トーン 2 に対する、ペダル 1 とペダル 2（接続されている場合）の操作
モードを設定します。“TONE2 PEDAL” のオプションは、上記 “TONE1 PEDAL”の項での説明と同様ですが、ここでの設
定は厳密にトーン 2 のみに関するものであり、従って、トーンごとにペダル動作を設定できることになります。“PEDAL 
CNTRL” での設定値（上記参照）により、トーン 2 がペダルでコントロールされるか否かが決定します。また、下記の 

“TONE2 TWK” オプションにもご注意ください。トーン 2 の Tweak ペダルのオプションの動作に関わる設定です。

TONE1 TWK - （Tweak） “TONE1 PEDAL” で、TWK をコントロールするオプションを選択した場合、TWK にアサインさ
れたペダルでコントロールするパラメータをここで選択します。選択可能なパラメータは膨大な数ですので、ここではリ
ストアップしませんが、ノブを回して調べてみてください！

TONE2 TWK - （Tweak） “TONE2 PEDAL” で、TWK をコントロールするオプションを選択した場合、TWK にアサインさ
れたペダルでコントロールするパラメータをここで選択します。選択可能なパラメータは膨大な数ですので、ここではリ
ストアップしませんが、ノブを回して調べてみてください！

TONE1 LP SW （Shortboard onlyのみ） - この “LP SW（Loop Switch）” 設定により、FBV Shortboard の “FUNCTION1” 
スイッチが、トーン 1 の何を実際にコントロールするかを選択できます。この機能は最近になって拡張されました。単な
るループ スイッチのオプションに留まりませんので、名前に惑わされないでください！ トーン 1 のオプションは以下の通
りです:

• COMP - Compressor ブロックをオン/オフ 

• AMP - Amp+Cab ブロックをオン/オフ 

• LOOP -（POD X3 Pro のみ） FX Loop をオン/オフ
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• DUAL - POD X3 ハードウェアの TONE 2（HOLD FOR DUAL） ボタンと同様に、トーン 1 と トーン 2 を切り替え
る動作となります。フットスイッチでデュアル トーンをオン/オフする Hold For Dual 機能も有効です。

ノート: “DUAL” オプションに切り替えると、“TONE2 LP SW” も自動的に “DUAL” オプションに切り替わります。双方と
も同じ機能を持つため、不可欠な動作です。

TONE2 LP SW（Shortboard のみ）- この “LP SW（Loop Switch）” 設定により、FBV Shortboard の “FUNCTION2” ス
イッチが、トーン 1 の何を実際にコントロールするかを選択できます。 トーン 1 のオプションは以下の通りです:

• COMP - Compressor ブロックをオン/オフ 

• AMP - Amp block ブロックをオン/オフ 

• LOOP -（POD X3 Pro のみ） FX Loop をオン/オフ 

• DUAL - POD X3 ハードウェアの TONE 2（HOLD FOR DUAL） ボタンと同様に、トーン 1 と トーン 2 を切り替え
る動作となります。フットスイッチでデュアル トーンをオン/オフする Hold For Dual 機能も有効です。

ヒント: これらの “SYSTEM” 設定はも各ユーザー プリセットに固有のものであることを忘れないでください。編集中
の特定のプリセットで有効となるよう、設定を変更した場合は保存することをお忘れなく！

デュアル トーンで FBV ペダルを使用
Dual Tone（デュアル トーン）プリセットで FBV ペダル（とオプションの Expression Pedal）を使用した場合に可能
な、数々のオプションや動作について説明しましょう。前述の通り、“TONE1” と “TONE2” のペダル モードのオプション

（Wah/Volume/Tweak）により、トーンごとの独自のペダル割り当てが可能です（FBV Shortboard に Expression Pedal 
を接続した場合、ペダルごとの設定も可能です）。従って、1 つのプリセットに、これらのペダルのオプションを設定する
際、各トーンの経路で何をコントロールすべきかについて考慮すべきです。可能性は以下のようになります:

• トーン 1、またはトーン 2の一方の Wah をコントロールする

• 1 つのペダルで両方のトーンの Wah を同時にコントロールする

• ペダル 1でトーン 1 の Wah をコントロールし、トーン 2 の Wah はペダル 2 で別個にコントロールする

• トーン 1、またはトーン 2 の一方の Tweak パラメータをコントロールする

• 1 つのペダルで両方のトーンの共通の Tweak パラメータを同時にコントロールする

• 各トーンで異なる Tweak パラメータを、1 つのペダルで同時にコントロールする

• ペダル 1でトーン 1 の Tweak パラメータをコントロールし、トーン 2 の異なる Tweak パラメータをペダル 2 でコ
ントロールする 

デュアル トーンのプリセットをロードしている場合、“PEDAL CNTRL” を “BOTH TONES” に設定し、“PEDAL TONE1” と 
“PEDAL TONE2” に同じモードを設定すると、事実、この FBV ペダルとトゥー スイッチは同時に両方のトーンの同じエ
フェクトをコントロールすることになります。スマートな方法ですね！ 例えば、“PEDAL TONE1” と “PEDAL TONE2” の両
方に “1-W/V” を設定した場合、FBV のオンボード ペダルは両トーンの Wah または Volume エフェクトを同時にコント
ロールします。トゥ スイッチを作動させると、両トーンで Wah または Volume が同時に切り替わります（*）。 

同様に、両トーンでペダル 2 のペダル モードを “2-TWK” に設定した場合、ペダル 2 の操作により、アサインされた 
Tweak パラメータが両トーンで同時にコントロールされます。また、両トーンで異なるパラメータをコントロールする
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よう、TWK のアサインを個別に行うこともできます。例えば、トーン 1 の Tweak を “Reverb Mix” に、そしてトーン 2 の 
Tweak を “Delay Mix” に設定すると、ペダル操作でこれらのパラメータを同時に調整できます！

* ノート: 一方のトーンの Wah エフェクト ブロックが「オン」、他方のトーンが「オフ」という状態のデュアル トーンをプリ
セットとして保存することが可能です。システム設定 “PEDAL CNTRL” が “BOTH TONES” に、そして両トーンの “PEDAL” 
に “1-W/V” がアサインされている場合、ペダルの動作は「リンク」されたままです。つまり、トゥ スイッチを作動させると、
各トーンの Wah エフェクトはオン/オフが逆の状態で切り替わります。Wah ブロックのオン/オフ状態は、POD 上のコン
トロールで設定可能です。この設定をプリセットに保存してください。

また、“1-W/V” モードでは、トゥ スイッチによって、コントロールの対象エフェクトが切り替わることになります（Wah また
は Volume）。従って、“PEDAL TONE1” と “PEDAL TONE2” の両方が “1-W/V” に設定されている場合、手動で両トーン
に対して Wah/Volume のオン/オフを逆に設定しておくと、トゥ スイッチで両方のコントロールを同時に「逆に」切り替
えることが可能です。このように、各トーンを細かく設定し、ユーザープリセットに保存することにより、思いのままの動作
が実現します！!

各トーンにペダルを個別的に設定すると、非常に風変わりな（悪いとは限りません！）エフェクトを仕上げることもできる
でしょう。異なるユーザー プリセットをいくつか作成し、それぞれにマッチするペダル設定を保存して色々お試しくださ
い。異なるサウンドやエフェクトの組み合わせが発見できるだけでなく、エフェクト コントロールの新たな手法が見つか
るかもしれません！

ボリューム ペダルの最小/最大音量を設定
FBV MkII のペダルで POD X3 の Volume エフェクトをコントロールできるのは当然ですが、ボリュームに関しては POD 
X3 にいくつかのオプションがあります。設定を行うには、POD X3 の「ホーム」ページでボリューム（“VOL”） エフェクト ブ
ロックを選択し、“ON/OFF” ボタンをダブルクリックしてボリュームのエディット スクリーンに入ります。

POD X3 のボリューム ページ

• MIN ‒ ペダルが最小の設定（かかと側）の時のボリュームを設定します。“0%” を設定すると、最小のポジション
で無音となります。

• MAX ‒ ペダルが最大の設定（つま先側）の時のボリュームを設定します。

• CONFIG ‒ POD X3 の信号経路内でのボリューム エフェクトの位置を選択します。“Pre”（Amp+Cab の前）、また
は “Post”（Amp+Cab の後ろ）となります。

ギター エフェクトやアンプの世界同様、いくつかのエフェクトと関連して、ボリューム ペダルを挿入する位置はサウンド
に大きく影響します。例えば、ディストーション エフェクトの前でボリュームを下げるとゲインが減少し、ディストーション
の後ろにボリュームを置くとゲインに影響を与えずに全体的なボリュームレベルを抑制できます。ボリュームを “Pre” ポ
ジションに置いて Delay エフェクトを使用した場合、ギターのボリュームを持ち上げてからペダルを下げても、まだディ
レイのリピートが残りますが、“Post” ポジションの場合、オリジナルのシグナルとディレイのリピートの両方の音量が下が
ります。
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この “VOL” エフェクト ブロックは、POD X3 の “TONE VOLUME” ノブからアクセスされるものと同じであることにご注意
ください。これは、各トーンに独自のボリューム エフェクトが備えてあることを意味します。従って、プリセットに 2 つの
トーンが使用されている場合は “TONE 2” ボタンを押して、トーン 1 とトーン 2 に個別の設定（上記の 3 種類）を行うこ
とができます。これらのボリューム設定も各プリセットごとに行えます。ユーザー プリセットに合わせ、個別の設定を保存
してください。

デュアル トーンのプリセットをコントロールする
完全に異なる 2 つのトーン経路を同時に使用できる...これは POD X3 の機能の内、特に魅力的であると言えるでしょう。 
トーン 1 を POD X3 の “Input 1” 端子に接続されたギター/ベースに使用し、トーン 2 は “Input 2” 端子に接続されたマ
イクに使用する、といった「トーン ペア」という構成が可能です。あるいは、両方のトーンを単一のインプットに使用する

「トーン ブレンド」という手法も可能です（例えば、1 本のギターに 2 台のアンプを適用できます）。各トーンには個別の
エフェクト、スピーカー キャビネット、マイクまでを用意できます！ POD X3 には、シングルのトーン プリセットだけでなく、
トーン ペアやトーン ブレンドのプリセットが多数用意されています。これらがどのように構成されているか探検してみる
のもいいでしょう。心ゆくまで編集し、ご自身のプリセットとしてユーザー フォルダに保存することもできます。

デュアル トーンの作成方法を十分に理解して頂くため、「POD X3 Pilot’s Handbook」の「Dual Tone Concept」の
項もご参照ください。 

FBV MkII から、ユーザー フォルダ内の 128 個のメモリ ロケーションにアクセスすることができます。前述の通り、ユー
ザー プリセットにはトーン 1 のみで構成されるもの、トーン 1 とトーン 2 で構成されるものがありますが、いずれにせ
よ、FBV 上のチャンネル ボタン（“A” 、“B” 、“C” 、“D” ）やバンク ボタンの機能に影響はありません。FBV は単にチャンネル 
ロケーション（そこに保存されたプリセットがシングルでもデュアルでも）を呼び出すだけであるためです。ただし、デュア
ル トーンのプリセットがロードされている際は、FBV Shortboard MkII の他のボタンが何をコントロールするかを把握し

ておくことは重要です...

FBV Shortboard MkII ユニットはエフェクト ボタン（“STOMP”、“MOD”、“DELAY” など）を装備しています。これらを使用
して、現在ロード中のプリセットの選択されたトーンを編集することができます。エフェクト ボタンを 1 つ踏むと、現在選
択されたトーンで、ある機能のオン/オフが切り替わります。FBV MkII Shortboard の FUNCTION 1 スイッチは、POD X3 
ユニットの “TONE 2” ボタンと同じ機能にすることができます。この場合、「選択されたトーン」をトーン 1 かトーン 2 に切
り替えることが可能になると同時に、スイッチを踏み続けてデュアル トーン機能のオン/オフを切り替えることも可能に
なります。“FUNCTION 1” ボタンのアサインを設定するには、POD X3 の “SYSTEM” の画面でトーン 1 とトーン 2 の “LP 
SW” オプションにアクセスしてください（2•6 ページ からの “LP SW” に関する記述を参照）。

ヒント: 工場出荷の「トーン ペア」タイプのデュアル トーンのユーザー プリセットを呼び出してみると、トーン 1 とトー
ン 2 の名称の最後に、それぞれ “L” と “R” が付加されていることに気が付かれるかもしれません（例えばプリセット 
“12A”）。FBV Shortboard の使用時には、LCD を見て各トーンの名称に付加された区別用の文字により、2 つのトー
ンの内どちらが今コントロールされているのかを簡単に見分けられるので便利です。

これで一段落です。以上の知識で武装すれば、ギターから手を離すことなく、POD X3 または POD X3 Pro に埋め込まれ
たパワーを幅広く、思う存分にコントロールできるでしょう！ より詳しい情報をお求めの方は、 Line 6 Online Support の
ウェブページをご覧ください。 

http://www.line6.com/support/


FBV MkII Advanced User Guide:   FBV Control アプリケーション

3•1

Line 6 FBV Control アプリケーション 
「はじめに」の章をお読みであれば、すでに奮起して FBV™ MkII を駆動させていらっしゃるかもしれません。この章では、
Line 6 FBV Control アプリケーションのユーザー インターフェースの特徴と機能の概観が示されています。POD Farm™ 
2, GearBox™ や サードパーティーのソフトウェアの章へ進む前に、この章に目を通しておいてください。それらのすべて
のセットアップに、このアプリケーションを使用します。この章以降は、ソフトウェアのコントロールに関しての個別的な
説明となります。

アプリケーションの用途は？
お求め頂いた FBV Shortboard™ または Express™ MkII はとても洗練されたギアであり、Line 6 Amp や POD® デバイス
のコントロール（RJ-45 ケーブル接続経由）だけでなく、コンピュータに起動した、標準 MIDI コントロール メッセージを
受信する任意のソフトウェアのコントロール（標準 USB 接続経由）も可能です。Line 6 FBV Control アプリケーションは
後者のために使用するものです。シンプルかつパワフルな一連の機能により、各フットスイッチとペダル コントロールか
ら、具体的にどのタイプの MIDI メッセージを目的のソフトウェアに送信するかを「プログラム」することが可能です。さら
に、これらのコントロールの割り当てを FBV プリセット ファイルとしてコンピュータに保存し、後日再現することも可能で
す。常々、MIDI コントローラーにさせたいと考えていた突飛なことでも何でも、どんどん試してみてください！

GUI（グラフィカル ユーザー インターフェース）
ソフトウェア的な話ですが、Line 6 FBV Control アプリケーションのメイン ウインドウは、「グラフィカル ユーザー イン
ターフェース」と呼ばれます（通の人同士では「GUI」と略します！）。まず、GUI 内をクリックする前に知っておくべき重要
事項を説明しましょう。以下の頁で各ナンバーの説明をお読みください。
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デバイスのコントロール
1 - FBV のイメージ図: 選択された FBV MkII デバイスのグラフィカルなイメージがここに表示されます。FBV の任意の
コントロールに対する MIDI の割り当てを編集するには、このイメージのフットスイッチやペダルを直接クリックする
か、下の “Control Properties” のリストで対応する列をクリックして選択します。編集オプションについては、“Control 
Properties” リストの説明（ 3•2 ページ ）をご参照ください。 

ノート: FBV Control アプリケーションは、USB で接続された FBV デバイス（Shortboard または Express MkII）を自動
的に検知して選択します。けれども、FBV デバイスなし、もしくは複数の FBV デバイスを接続してる場合、他のオプショ
ンがあります。詳しくは 「Preferences（初期設定）」（ 3•9 ） をご覧ください。

2 - フットスイッチ: 任意のフットスイッチを直接クリックしてください。フットスイッチ、そして “Control Properties” リスト
（ここで MIDI アサインを編集可能）内の対応する列が選択されます。筐体に記されたフットスイッチ名に関わらず、FBV 
MkII ハードウェアのすべてのフットスイッチから、任意のタイプの MIDI メッセージ（“Control Properties” リストの欄に
有効なもの）を送信させることが可能です。特定のフットスイッチから MIDI コマンドを何も送信したくない場合、 コマン
ドの欄に “Unassigned” を選択してください（インジケーターについては、「フットスイッチの LED」（ 3•6 ） をご参照くださ
い）。

3 - ペダルの WAH と VOL: Shortboard または Express ユニットのオンボード ペダル（「ペダル 1」 とします）には、2 つ
の機能を割り当てることができます。これらの機能の割り当てを選択するには、イメージ上の “WAH” または “VOL” イン
ジケーターをそれぞれ直接クリックするか、“Control Properties” リストでそれらの列をクリックしてください。お望みの
タイプの MIDI CC を 2 つ割り当てると、トゥ スイッチ（ペダル 1 を踏み込む）でそれらを切り替えて送信できます。つま
り、ソフトウェア内の異なる機能を切り替えてコントロールできます。トゥ スイッチに関しては次の項もご参照ください。
FBV ハードウェアで “WAH” LED が点灯している時、ペダルの “Wah” に割り当てられたものが使用されています。“VOL” 
LED が点灯している場合、ペダルの “VOL” に割り当てられたものが使用されています。

4 - ペダル 1 の TOE SWITCH: ここをクリックして「トゥ スイッチ」（実物はオンボード ペダルの下に位置しています）を
選択します。このスイッチには 2 つの機能があります:

• 他の FBV のフットスイッチ同様、トゥ スイッチにも任意の MIDI コマンドをアサインできます。ペダルと関係する
エフェクトのパラメータに使用すると特に便利です。

• また、固定され、編集不可の機能ですが、トゥ スイッチは「ペダル 1 が、“Pedal Wah” と “Pedal Vol” への割り当て
（“Control Properties” リストで設定）のどちらを使用するか」を切り替えます。FBV 本体では、“WAH” と “VOL” の 
LED の点灯により、どちらの機能が使用中か示されます。“Control Properties” リストでトゥ スイッチのオプション
がどのように設定された場合も、トゥ スイッチは常にこの機能を果たします。これは「内蔵された」スイッチの動作
であって、こちらの機能に関して言えば、トゥ スイッチが MIDI コマンドを送信するのではありません。トゥ スイッ
チから送信される唯一の MIDI コマンドは、“Control Properties” リストでトゥ スイッチにアサインされたもののみ
となります。ペダル設定に関しては、前項の「3 - ペダルの WAH と VOL」 の説明もご参照ください。

5 - PEDAL 2（Shortboard のみ）: FBV Shortboard MkII は、オプションの Expression Pedal （Line 6 EX-1 など）を接続
する “Expression Pedal” 端子を背面に備えています。Expression Pedal のアサインを編集するには、イメージ上でこの
“PEDAL 2” のエリアをクリックするか、下の“Control Properties” リストで “Pedal 2” の列をクリックしてください。任意の 
MIDI CC と範囲値を送信するように「ペダル 2」を設定し、ソフトウェア内の「ノブ」や「スライダー」を連続的にコントロー
ルすることも可能です。

6 - “Control Properties” リスト: 選択された FBV Shortboard/Express MkII デバイスで編集可能なすべてのフットス
イッチとペダル コントローラーを表示するリストです。すでに記しましたが、選択して MIDI 設定を編集するには、FBV イ
メージのスイッチをクリックするか、この “Control Properties” リストで任意の列をクリックします。以下、各欄と用意され
たオプションについて説明します...
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• Control: 物理的フットスイッチとペダルの固有名詞で、FBV MkII デバイスのラベルと同じです。これは単にコン
トロールの名称に過ぎません。つまり、与えられたラベルに関わらず、各フットスイッチとペダル コントロールに
は任意の MIDI コマンドを選択できます。

• MIDI Command: コントロールが送信する MIDI メッセージのタイプです。すべてのフットスイッチに対して、以
下のタイプの MIDI コマンドから選択できます（“Pedal Wah”、“Pedal Vol”、“Pedal 2” コントロールの選択肢は 
“MIDI CC” と “Unassigned” のみ）。

• Unassigned: MIDI データは送信されません。基本的にコントロールの無効となります。作成したプリセット
で使用するつもりのないフットスイッチやペダルには、このオプションを選択して、ターゲットのソフトウェア
において機能が不本意にトリガーされないようにしましょう！

• Bank Change: 通常、パッチやプリセット バンクの切り替えに使用される 1 つの数値です。

• Program Change: 通常、選択バンク内でのプリセットの切り替えに使用される 1 つの数値です。

• MIDI CC（MIDI コンティニュアス コントロール）: MIDI ソフトウェアやハードウェアがパラメータにアクセス
するために使用するものです。CC ナンバーと範囲値の組み合わせです。

• MIDI Machine Control（MMC）: 一般的に、トランスポートのパラメータと機械的な機能（再生、停止、録
音など）に使用される特殊なコマンドです。

• Mackie: 「Mackie Universal コントローラー」フォーマットの特殊なコマンドです。、Mackie Control フォー
マットに対応した MIDI ソフトウェアのトランスポートのパラメータと機械的な機能（再生、停止、録音など）
に使用されます。

ノート: FBV MkII デバイスが送信する MIDI コマンドのタイプは上記のものに限られます。MIDI ノートや MIDI SysEx 
のダンプを送信することはできません。

Value: ここには選択された MIDI コマンドの値を設定します。選択された MIDI コマンドによってオプションは異なりま
す。上記、MIDI Command の説明をご参照ください。

• “MIDI Command” に “Bank Change” または “Program Change” を選択し、“Switch Mode” に “Increment” ま
たは “Decrement” を選択した場合、“1” から“127”（*）までの数値を 1 つ選択できます。クリックするごとに、この
数値による増減でバンク/プリセットを切り替えることができます。 

* ノート: “Bank Change” または “Program Change” のコマンド タイプに対して、値 “0” を選択することも可能ですが、
これはお勧めできません。一般的な MIDI アプリケーションは対応していません。

• “MIDI Command” が “Bank Change” または “Program Change” で “Switch Mode” が “Fixed” の場合、“0” から
“127”までの任意の数値を選択し、そのナンバーのバンク/プリセットへと直接切り替えることができます。

• “MIDI Command” が “MIDI CC” の場合、“0” から“127” までの数値を 1 つ、あるいは “Custom” を選択できます。
“Custom” を選択した場合、このコントロール列の “Toggle 1/Up” と “Toggle 2/Down” の欄が選択可となり、切
り替えごとの動作を、MIDI CC の値でそれぞれ定義できるようになります。

• “MIDI Command” が “MMC” の場合、選択肢は “Play”、“Stop”、“Play/Stop”、“Record Punch-Pro Tools”、
“Pause”、“Fast Forward”、“Rewind” となります。

• “MIDI Command” が “Mackie” の場合、選択肢は “Play”、“Stop”、“Play/Stop”、“Record Punch”、“Pause”、“Fast 
Forward”、“Rewind” となります。
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Toggle1/Up と Toggle2/Down の CC/Val 欄: この欄は、“MIDI Command” が “MIDI CC” で、“Value” に “Custom” を
選択した場合に有効となります。ここに個別の値を入力して、“Toggle 1/Up” と “Toggle 2/Down” スイッチの動作を指
定することができます（詳しくは 「フットスイッチ コントロールの動作」（ 3•5 ） をご参照ください）。

Port: データを送信する FBV の MIDI 出力ポートです。FBV MkII デバイスには 4 つの独立した USB MIDI 出力ポート
があります。FBV が送信する MIDI コマンドを受信するように、コンピュータ上の他の MIDI ソフトウェアでは、ポートの
いずれかを選択することが可能です。ポートはすべてのコントロールに独自に設定できます（“1”、“2”、“3”、“4”、または 
“ALL”）。

ヒント: コンピュータに同時に起動した複数のソフトウェア アプリケーションを FBV でコントロールすることをお望み
の場合、コントロールに異なるポートを設定し、また、各アプリケーションでは特定のポート（すなわち特定のコマン
ド）のみを受信するようにしてください。

Channel: 選択したポートのどの MIDI チャンネルでデータを送信するかを設定します。“1” から “16” までの任意のチャ
ンネルを 1 つ選べます。コントロールの “Port” の欄に “All” を設定した場合、この MIDI チャンネルの設定は、4 つの 
MIDI ポートのすべてに適用されます。 

Switch Mode: “MIDI Command” での設定により、ここで有効なオプションは異なります（“Pedal Wah”、“Pedal Vol”、
“Pedal 2” コントロールの場合、“Switch Mode” オプションはありません）。

• “MIDI Command” が “Bank Change” または “Program Change” の場合、有効なオプションは “Increment”、
“Decrement”、“Fixed” となります:

• Increment: フットスイッチを踏むと、バンク/プリセットのナンバーが、“Value” 欄で指定された量（“1” - 
“127” *）だけ増やされます。

• Decrement: フットスイッチを踏むと、バンク/プリセットのナンバーが、“Value” 欄で指定された量（“1” - 
“127” *）だけ減らされます。 

* ノート: “Switch Modes” に “Increment/Decrement” を設定する場合、コマンド タイプ “Bank Change” または 
“Program Change” の “Value” 欄に “0” を選択することも可能ですが、これはお勧めできません。一般的な MIDI アプ
リケーションは対応していません。

• Fixed: フットスイッチを踏むと、バンク/プリセットのナンバーが、“Value” 欄で指定された値（“0” - “127” *）
までジャンプします。

ノート: FBV の バンク チェンジのコマンドは、必ず、その MIDI メッセージの一部としてプログラム チェンジも同時に
送信します。結果として、新たに選択したバンクの最初のプリセットが呼び出されることになります。例えば、現在ソフト
ウェアが「バンク #1、プリセット #23」であるとします。FBV のコントロールに “Bank Change_Increment_Value 1” と
設定されている場合、コントロールを踏むと、ソフトウェアは「バンク #2、プリセット #1」となります。 

• “MIDI Command”が “MIDI CC” の場合、オプションは “Single”、“Momentary”、“Toggle” です。スイッチの動作タ
イプを選択します。スイッチのモードに関しては、「フットスイッチ コントロールの動作」（ 3•5 ） をご参照ください。

• “MIDI Command” が “MMC” もしくは “Mackie” の場合、“Switch Mode” にオプションはありませんが、いくつか
の MMC と Mackie コマンドは自動的に「切り替えスイッチ」として機能します。例えば「再生/停止」のように、2 つ
のメッセージを交互に送信します。
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7 - 「接続デバイスなし」を示すインジケーター: Line 6 FBV Control アプリケーションを起動した際、FBV MkII デバイス
の接続が検知されない場合、アプリケーション ウインドウ下部に警告が表示されます。FBV 本体に USB ケーブルを挿し
忘れていたり、デバイスの検知に問題があることを知らせています:

FBV を接続していない場合、このまま、Line 6 FBV Control アプリケーション が起動中にコンピュータの USB ポートに
接続して構いません。すぐ、アプリケーションによって自動的に検知されます。

Windows® ユーザーの方はご注意ください... Windows® XP / Windows® 7 / Windows Vista® の USB Class 
Compliant ドライバの特性により、複数のアプリケーションが同時に USB デバイスの同じ MIDI ポートを使用すること
は許されません。Line 6 FBV Control アプリケーションは FBV の MIDI 入力ポートを使用して、編集されたコントロー
ル設定を FBV デバイスに送信します。従って、FBV Control アプリケーションを開いたまま FBV と交信する場合には、
MIDI/DAW ソフトウェア側で FBV の MIDI 入力ポートを無効にすべきです（MIDI/DAW で FBV からの MIDI コマンドを

「受信」する場合は、通常、1 から 4 の FBV MIDI 出力ポートの内のどれか 1 つを有効にすれば事足ります）。 

フットスイッチ コントロールの動作
「“Control Properties” リスト」の項（ 3•2 ページ ）で説明しましたが、FBV MkII のフットスイッチ コントロールには、“MIDI 
Command” のタイプと “Value” の設定に応じて、いくつかの異なる動作があります。コマンド タイプに “MIDI CC” を選
択した場合、3 つの異なる “Switch Mode” が選択肢となります（“Single”、“Toggle”、“Momentary”）。各フットスイッチ 
コントロールは、実際には 1 つか 2 つの MIDI CC コマンドを送信可能です（“Switch Mode” により異なります）。これは、
ある種のソフトウェア パラメータにとても有用です。ソフトウェアの開発元によっては、特定のパラメータにどのスイッチ 
モードを使用しているか不明な場合があります。スイッチ モードのベストな選択のためには、取扱説明書で確認すると
よいでしょう。ただ、ここで、スイッチ モードの理解に役立つと思われる例を挙げておきましょう...

例えば、フットスイッチ “A” のコントロールに以下のようなオプションを選択したとしましょう:

“Value” で “065” を選択しています。実際には、フットスイッチ コントロールの両方の MIDI CC 割り当てが「CC #65」に
設定されることになります。一番右、“Toggle 1/Up” と “Toggle 2/Down” の “CC” と “Val” フィールドを眺めると、そのこ
とが確認できます（これらは編集不可ですが、数値が設定されていることは確認できます）。それぞれの値は自動的に 
“127” と “0” となります。これらの設定により、各スイッチ モードにおける動作結果は次のようになります:

• Single: 作動したフットスイッチは、常に “Toggle 1/Up”（のみ）の「CC と Val」（“CC” の「ナンバー」と “Val” の
「値」）を送信します（この例では 「CC 65 と、値 127」）。

• Toggle: ひと踏みごとに、最初と二番目の「CC と Val」を交互に送信します（オン/オフ スイッチと似ています）。
上の例の場合、最初に踏むと「CC 65/127」が送信され、次には「CC 65/0」が送信されます。いくつかのソフトウェ
ア パラメータは、オン/オフの切り替え機能に、このタイプのスイッチ モードを利用しています。一般的に、“0 - 64” 
の値はパラメータを「ある状態」に切り替え、“65 - 127” の値はパラメータを「逆の状態」に切り替えます。しかしな
がら、ソフトウェアによっては、“Momentary Switch ” モードの MIDI CC コマンドを利用してパラメータのオン/オ
フを切り替えるものもあります。用途に応じてどのモードが最適かを、取扱説明書でご確認ください（あるいはソ
フトウェアで別のスイッチ モードを試してみてください）。
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• Momentary: コントロールを踏むと、最初の「CC と Val」が送信され、コントロールを放すと二番目の「CC と Val」
が送信されます。この種の「モメンタリー」スイッチは、ピアノのサスティン ペダルのパラメータなどによく使用さ
れます。フットスイッチを踏んでいる間だけパラメータがオンとなり、足を放すとオフとなる仕組みです。上の例の
場合、スイッチを踏むと「CC65/127」が送信され、スイッチを放すと「CC65/0」が送信されます。

MIDI CC - Custom オプション: また、コマンド タイプに MIDI CC を選択している場合、“Value” の欄に CC ナンバーでは
なく、“Custom” を選択することができます。これを選択すると、“Toggle1/Up” と Toggle 2/Down” の欄を編集できるよ
うになります。2 つの「CC と Val」をお好きなように入力してください。上記説明の通り、スイッチ モードの “Momentary” 
と “Toggle” のオプションの場合、フットスイッチはこれらの「CC と Val」を交互に送信します。特定の動作が求められる
ケースにはとても便利です。スイッチのひと踏みで、ソフトウェアの 1 つのパラメータをトリガーし、次のひと踏みで別の
パラメータをトリガーし、それを交互に繰り返す、というようなことが可能です。

FBV Shortboard MkII に関するヒント: フットスイッチを踏んだりペダルを動かすごとに、FBV デバイスの LCD ディス
プレイに、MIDI メッセージの送信を示す短縮形のテキストが表示されます。

フットスイッチの LED 
FBV MkII デバイスの各フットスイッチの上部に LED インジケーターが備えてあります。USB 接続で FBV を使用する場
合、フットスイッチが送信する MIDI コマンドのタイプとスイッチ モードに応じて、これらの LED が点灯します。

一般的に、スイッチ モード設定より、フットスイッチの LED が以下のように点灯します:

• スイッチ モードが “Single” に設定されている場合、フットスイッチを踏むごとに LED が点灯します。スイッチを
放すと消灯します。踏むごとに同じ値が送られていることを意味します。

• スイッチ モードが “Toggle” に設定されている場合、フットスイッチを踏むごとに LED が点灯と消灯を交互に繰
り返します。踏むごとに、異なる値が交互に送られていることを意味します。 

• MIDI CC のコマンド タイプの場合、MIDI CC の値 “0 - 64” がオンを意味するので LED が点灯します。MIDI 
CC の値 “64 - 127” はオフを意味するので LED は消灯します。

• 上記、“Toggle” スイッチの動作と同様、スイッチ モード “Momentary” の場合も 2 つの「CC と Value」が送信され
ます。ただ、“Momentary” 設定ではフットスイッチを押している間だけ、すなわち、オンの値が送信されている間
だけ、LED が点灯し続けます。フットスイッチを放すとオフの値が送信され、それに合わせて LED も消灯します。

• フットスイッチ コントロールが “Unassigned” に設定されている場合、フットスイッチを操作しても LED は点灯し
ません。メッセージが何も送信されないことを表しています。

• 他のコントロール設定の場合、フットスイッチの LED は踏んだ際にのみ点灯し、すぐに消灯します。

ここで重要なことですが、これらの  LED の動作は、これまでに説明したコントロール設定、すなわち、“Control 
Properties” リストでの設定にのみ依存します。FBV MkII デバイスは、MIDI/DAW ソフトウェアからの MIDI データを受
信したり、応答することはありません。

ペダルによるコントロール
FBV MkIIのオンボード ペダル（FBV Shortboard MkII に接続されたオプションの Expression Pedal も同様）は MIDI CC 
タイプのメッセージ送信に対応しています。パラメータのレンジをゼロから 100％ まで「スイープ」することが可能です。
当然のことながら、ペダル コントロールはソフトウェアのノブやスライダー タイプのパラメータに割り当てて使用するの
がベストです。この場合、パラメータをハンズフリーで操ることができます。ペダル機能の設定は非常にシンプルです。
“MIDI Command” として “MIDI CC” を選択し、次に、ターゲットであるソフトウェアのパラメータに呼応する MIDI CC ナ
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ンバーを選択します。「範囲」の値、“0” から “127” が自動的に設定され、マップされたパラメータをゼロから 100％ まで
調整することが可能になります（いくつかの MIDI アプリケーションの場合、ソフトウェア内でも最小/最大値のカスタマ
イズが可能です。取扱説明書でご確認ください）。

“Control Properties” リストでは、オンボード ペダルに対し、編集可能なコントロール設定が 2 つ用意されています。 
“Pedal Wah” と “Pedal Vol” です。各コントロールを個別に設定できます。そしてトゥ スイッチにより、マップされた 2 つ
のパラメータを切り替えることが可能です！ “Pedal Wah” と “Pedal Vol” の詳細については 3•2 ページ をご覧ください。

FBV プリセットを開く / 保存する
Line 6 FBV Control アプリケーションでは、GUI 内の現在の全設定を「パッチ」（FBV プリセット ファイル）としてコン
ピュータのハード ドライブに保存することができます。これはつまり、FBV Shortboard または Express MkII のハードウェ
アの内蔵メモリに現在ロードされている設定のすべてをバックアップしたり、設定を思う存分カスタマイズしたバージョ
ンを別の FBV プリセットとしてバックアップし、そして、お好きなものをいつでも FBV のメモリにロードできる、ということ
を意味します。以下、FBV プリセットの扱いについて説明します。

すでに記しましたが、FBV MkII デバイスを USB でコンピュータに接続し、Line 6 FBV Control アプリケーションを起動し
てデバイスを選択すると、FBV デバイスの内蔵メモリの内容が自動的に Control アプリケーションの GUI にロードされ
ます。また、Control アプリケーションで何かを 1 つでも編集すると、変更は直ちに FBV MkII デバイスの内蔵メモリに書
き込まれます。

ヒント: Line 6 FBV Control アプリケーションの GUI の全設定は、接続された FBV デバイスに自動的に保存されます
が、設定の編集が済んだら、“Save” または “Save As” コマンドで FBV の現在の設定を FBV プリセットとしてコンピュー
タに保存するようにしましょう。これにより、カスタマイズした全バージョンのバックアップが保証されます。いつでもす
ぐに再現可能です！

既存の FBV プリセットを確認してみたい、または編集したい、けれどもそれを FBV MkII デバイスの内蔵メモリにロード
したくない、という場合には、FBV Control アプリケーションを起動する前に、FBV デバイスと USB ポートの接続を外し
ておいてください。 

既存の FBV プリセットを開く
• FBV Shortboard または Express MkII デバイスをコンピュータの USB ポートに接続し、Line 6 FBV Control アプ

リケーションを起動します。

• アプリケーションで File > Open メニューを選択します。

• 初期設定の場合、以下のディレクトリが開かれます:

• 書類/Line 6/FBV（Mac®）

• マイ ドキュメント\Line 6\FBV（Windows®）

• このディレクトリには、私達が用意したファクトリーの FBV プリセットが含まれています（「FBV-Default.fbv」な
ど）。1 つのファイルを選択して “Open” をクリックしてください。

• FBV プリセットが FBV Control アプリケーションの GUI にロードされると同時に、FBV MkII デバイスの内蔵メモリ
にも自動的にロードされます。
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FBV Shortboard/Express MkII デバイスが一度に保持できるのは 1 つのフルの FBV プリセットに限られます。前記の
手順で新規プリセット ファイルを開くと、現在、FBV デバイスの内蔵メモリに記憶されている USB MIDI のコントロー
ルの割り当てのすべてが、新たに開く「.fbv 」プリセットのものに入れ替わります。現在の設定を後々使用する可能性
がある場合、新規プリセットを開く前に、FBV プリセットとしてコンピュータに保存しておいてください。

FBV プリセットを保存する
Line 6 FBV Control アプリケーションで作業している間はいつでも、GUI の現在の全設定を FBV ファイルとしてコン
ピュータのハード ドライブに保存できます。後日、FBV デバイスにロードできるよう、失いたくない設定はすぐに保存しま
しょう（呪文「はやめな保存、こまめな保存」を忘れずに！）。

Mac® と Windows® ソフトウェアでの決まりごとです。ご存知と思われますが... 

• 現在の FBV プリセットに加えられた変更を、ファイルの以前の設定を上書きして保存するには、アプリケーション
のメニューで File > Save を選択します。

• 現在の FBV プリセットに加えられた変更を、新規 FBV プリセット ファイルとして保存するには、アプリケーション
のメニューで File > Save As を選択します。この場合、ファイルの名称と保存場所の指定が要求されます。FBV プ
リセット ファイルはすぐに見つかるよう、きちんとまとめておきましょう。インストールによってファクトリー プリ
セットが保存されたディレクトリ（以下参照）を使用することをお勧めします:

• 書類/Line 6/FBV（Mac®）

• マイ ドキュメント\Line 6\FBV（Windows®）

ヒント: プリセットがまだ保存されていない状態の場合、現在ロード中のプリセットの名称（アプリケーション ウインド
ウ上部に表示）の後ろにアスタリスク マークが付されます（“FBV-Default.fbv*” など）。

FBV デバイスを接続せずに FBV プリセットを編集 / 保存する
前述の通り、実際には、FBV Shortboard/Express MkII デバイスを USB で接続しなくても、Line 6 FBV Control アプリ
ケーションを起動してプリセットを編集したり保存することが可能です。この場合もコンピュータのプリセットに対して、
“Open”、“Save”、“Save As” コマンドを使用できます（上記手順を参照）。FBV デバイスの内蔵メモリには手を付けず、コ
ンピュータに保存された FBV プリセット ファイルの設定を確認したり編集するだけ、という場合があるかもしれません。 
また、このようなプリセットを FBV MkII デバイスの内蔵メモリにロードする場合、コンピュータの USB ポートにデバイス
を接続してから、上記手順で保存された FBV プリセットを開いてください。これにより、プリセットは自動的にデバイスの
メモリにロードされます。

FBV MkII デバイスを接続せずに Line 6 FBV Control アプリケーションを起動した場合、作業を始める前に、アプリ
ケーションにデバイス モデルのフォーマットの種類を教える必要があります（Shortboard または Express MkII）。 
さて、これで次の項へスムーズに移行できます。すなわち、次の章ではこのようなオプション、すなわちアプリケーション
の初期設定を扱います...
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Preferences（初期設定）
他のソフトウェア アプリケーションに倣い、私たちも、一風変わった設定を分離して初期設定に置きました。Line 6 FBV 
Control アプリケーションの初期設定ダイアログを開くには:

• Mac® - Line 6 FBV Control > Preferences 

• Windows® - File > Preferences

デバイスが見つからない場合のオプション
起動時に Line 6 FBV デバイスが検知されなかった場合、Line 6 FBV アプリケーションは、GUI に表示するデバイス構成
として、FBV Shortboard、Express MkII、のどちらかを選択しなければなりません。デフォルトでは、起動時にユーザーに
尋ねて選択してもらうようになっています。この初期設定ダイアログでどちらかのデバイスを選択しておけば、以降、起動
時に尋ねられることはありません。あるいは、尋ねるダイアログの下部の小さな “Do this every time” ボックスにチェック
を入れて設定することもできます。選択はいつでも、初期設定ダイアログで変更できます。

FBV MkII デバイスが接続されている場合、ここでの設定は Line 6 FBV アプリケーションの起動にまったく影響を及ぼ
しません。アプリケーションは自動的に接続された FBV デバイス用の GUI を表示します。コンピュータに複数台の FBV 
MkII デバイスを接続している場合は（Shortboard と Express MkII など）、Line 6 FBV Control アプリケーションと連携
するデバイスを選択するよう、促されます（ですから、お気に召したなら安心して FBV を買い足してください！）。

Show Warning Dialog at Startup オプション
このチェックボックスは、Line 6 FBV Control アプリケーションの起動時に表示される警告ダイアログ、すなわち、「ソフト
ウェア内での変更は、接続された FBV デバイスのメモリに直ちに保存されます」など、重要な動作や自動的な動作につ
いてお知らせするダイアログに関係するものです。この警告ダイアログにうんざりしたら、初期設定ダイアログで “Show 
Warning Dialog at Startup” のチャックを外してください。また、「警告ダイアログで “Donʼt show again” ボックスを
チェックして、表示しないようにしてしまったが、やはり、警告は大切だ」という方は、初期設定を開き、このボックスを
チェックしてください。



FBV MkII Advanced User Guide:   FBV Control アプリケーション

3•10

Line 6 FBV Control Application ダイアログ
アプリケーションに関して役立つ情報を示すダイアログです。これを開くには:

• Mac® - Line 6 FBV Control > About Line 6 FBV Control 

• Windows® - Help > About Line 6 FBV Control

ここには以下のような明確な情報が示されます:

• Line 6 FBV Control アプリケーションのバージョン ナンバー

• 検知され、現在アプリケーションに使用されているFBV MkII デバイス   
あるいは “None” （なし、FBV を接続していない場合）

• 接続された FBV MkII ユニットのデバイス ファームウェアのバージョン

• 我が社の法律家が主張する著作権情報

ダイアログのどこかをクリックすると非表示となります。

ヒント: FBV をコンピュータに接続したまま、Line 6 Monkey アプリケーション起動すると、このデバイス用のソフトウェ
ア/ファームウェアの最新版を確認してインストールできることを覚えておきましょう！

FBV Shortboard MkII の LCD ディスプレイ
FBV Shortboard MkII をコンピュータの USB ポートに接続すると、デバイスの LCD スクリーンに “USB MODE” と表示さ
れます。FBV が USB MIDI コントローラー デバイスとして動作する準備が整ったことを表しています。 

フットスイッチを踏んだりペダルを動かすごとに、MIDI メッセージが送信されたことを示すテキスト（短縮形）が LCD 
ディスプレイに表示されます。このテキストは他のコントロールを操作するまで残ります。例えば、MIDI CC のコマンドが
アサインされている場合、次のようなテキストが表示されます:

CH 1 CC 111 VAL 127

コントロールが「MIDI チャンネル 1」を使用して、「MIDI CC 111」のコマンドを、「値 127」で送信したことが分かります。 
このコントロールのスイッチ モードが “Toggle” に設定されているとすると、このコントロールを踏むごとに、表示される
“CC” と “VAL”の値は、“Control Properties” リストで設定された “Toggle 1” と “Toggle 2” の「CC と Val」を交互に繰り返
します。ペダルを操作すると、MIDI CC の “VAL” 値の表示はリアルタイムに変化し、実際にペダルから連続的に送信され
る CC の値を示します。

他の “MIDI Command” 設定の場合も、LCD は同様のテキストを表示し、メッセージが送信されていることを示します
（例えば、MMC タイプのコマンドでは “MMC PLAY”、プログラム チェンジでは “CH 1 PGM 1” など）。 
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FBV™ MkIIと共にLine 6 POD Farm™ 2
この章では特にLine 6 POD Farm™ 2のスタンドアローン・アプリケーションとPOD Farm™ 2プラ
グインに含まれている様々なパラメーターを遠隔操作するためのLine 6 FBV Shortboard™、または
FBV Express™ MkIIの使い方について説明します。 それにより、FBV MkIIを操作することで、ワウ、ボ
リューム、またはピッチ・ベンダー・エフェクトをペダルでコントロールできるように設定したり、エフェクトの
オン・オフの切り替えや、自身で作成したPOD Farm 2のセットリストの操作、あるいはDAWオートメーシ
ョンを書いている間にPOD Farm 2プラグインを操作する等、POD Farm 2には、他にも多くの可能性
で使い道を広げることができるのです! まだこういう使い方をしていないのであれば、FBV Shortboard
またはExpress MkIIをコンピュータのUSBポートに接続してからLine 6 Monkey™を起動させ、FBV
が最新のデバイス・ファームウエア・バージョンにアップデートされているか確認してください。詳細は「Line 
6 Monkey でのアップテートとユーザー登録」(1•1ページ)をご覧ください。

POD Farm 2は何ですか?
念のために説明します。 Line 6 POD Farm 2は、Line 6 USBオーディオ・インターフェイス製品の所
有者のために用意されたソフトウエアです。* POD Farm 2スタンドアローン・アプリケーションには、有
名なLine 6ギター&ベースアンプ、プリアンプ、スピーカー・キャビネット、マイクとエフェクト・モデル等全
てにアクセスすることができる、機能満載のコンピュータ・ユーザー・インターフェイスが備わっているので
す。 Line 6 USBオーディオ・インターフェイスを使う事で、実質的にはコンピュータに有名なPODサウン
ドを出させ、好きなオーディオ・ソフトウエアに録音したり、好きな曲でジャム演奏をすることができるので
す。 さらに、POD Farm 2には、POD Farm 2プラグインと、Mac®やWindows®コンピュータで使用
する全てのDAWアプリケーションの中で、オーディオ・エフェクト・プラグインとして作動するPOD Farm
エレメント・プラグインも用意されています。 POD Farm 2スタンドアローン・アプリケーションとPOD 
Farm 2プラグインの両方が外部MIDIコントロールをサポートできるので、FBV MkIIデバイスは完璧な
USB–MIDIコントローラー・デバイスとして、このような作業にはうってつけです!

*注意:POD Farm 2スタンドアローン・アプリケーションは、動作環境として Line 6 POD Studio™, TonePort™ 
または GuitarPort™ デバイスが必要です。 A POD Farm 2ライセンスは、Line 6 POD®xt、POD® X3ユニ
ットまたはiLok USBキーを使用していても、「Add-On」のひとつとして購入すれば、POD Farm 2プラグインを
これらのデバイスのどれかと合わせて作動させることができます。 

POD Farm 2を購入する場合は、Line 6 USBオーディオ・インターフェイスをMac®やWindows®コ
ンピュータに接続し、Line 6 Monkeyを起動させ、その小さなモンキーにダウンロードまでの手順を案内
させてください。 または直接http://line6.com/software/ページへ進み、そこからダウンロードを行っ
てください。
まだここまでの操作が済んでいない場合は、Line 6 FBV Controlアプリケーションをダウンロードして
インストールも行ってください。 FBVデバイスがPOD Farm 2と相互にコミュニケーションがとれるよう
に、MIDIコントロール・インフォメーションを読み込み、エディットする必要があります。 ダウンロードの手順
に関する詳細は、「Line 6 FBV Control アプリケーション」(3•1ページ) をご覧ください。

USB–MIDIポートとチャンネルについて
先ず最初に、このMIDIコミュニケーションがどのようにしてFBV MkIIデバイスとコンピュータの間で行わ
れるのかを知っておくのも、今後役立つことと思います。 Mac®またはWindows®コンピュータのUSB
ポートに接続すると、FBV MkIIデバイスは１つの USB「MIDI In」ポートと４つの USB 「MIDI Out」ポー
トをコンピュータに構築します。 これらは大量にMIDI ケーブルの使用を必要とする「目に見える」ハード
ウエアポートではありません。FBVは全てのMIDIデータをUSBケーブルを渡ってこのような「仮想の」ソ
フトウエア MIDIポートまで伝えるのです。 POD Farm 2スタンドアローン・アプリケーションを操作しよう
という場合は、POD Farm 2スタンドアローン・アプリケーションの Preferencesにある、これらのFBV 

http://line6.com/software/
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MIDIポートにアクセスしてください（「POD Farm 2 スタンドアローン・アプリケーション - MIDI インプッ
トの設定」(4•8ページ)をご覧ください）。 POD Farm 2プラグインを操作しようという場合は、プラグインを
使用してMIDIをFBV MkII MIDIポートから受信させるため、DAW ホット・ソフトウエアを設定する必要が
あります(「POD Farm 2プラグイン - MIDI インプットの設定」(4•9ページ)をご覧ください)。

ソフトウエアとのMIDIコミュミケーション
FBV MkIIデバイスとコンピュータをUSBで接続した後は、FBVデバイスが送信する MIDIコントロール・
データを、特定のMIDI OutポートとMIDIチャンネルからソフトウエア・アプリケーションが受信するように
設定するだけです。 例えば、Ableton Live®または Live® Liteソフトウエアの中では、Preferences > 
MIDI/Syncダイアログで MIDI コントローラー・デバイスを１台か複数台かを選ぶオプションが用意され
ています。 MIDI/DAW ソフトウエアの中で、FBV MIDIポート1〜4のどれが MIDI コントロールデータ
を受信するかを見る事ができるはずです。

注意: Mac OS® X, Windows® 7, Windows Vista® と Windows® XP では、これらの４つのポートの名称
が多少異なります。 セットアップ例に関しては、次のセクションをご覧ください。

デフォルトでは、あなたの FBV MkII Controlの割り当て全てが FBV MIDI Out ポート 1へ送信される
ように設定されています。 とはいえ、個々のどのFBVコントロールに対しても、その MIDI コントロール・
データを、FBV MIDI Out ポートの1〜4のどれかへ送信するように設定することもできます(3•1 ページの
FBV Controlアプリケーションの Control Propertiesリストの欄をご覧ください)。

Windows® MIDI ポート・コミュニケーション
Windows®で使用するFBV MkIIデバイスのWindows® USBクラス対応ドライバーは、本来１つのア
プリケーションだけが、１つの MIDIポートを使用する点に注意してください。 Line 6 FBV Controlアプ
リケーションは、開かれると同時にFBV MIDI In ポートと MIDI Outポート4をFBVデバイスとのコミュニ
ケーションに使用します。 従って、もし現在他のDAWソフトウエア・アプリケーションが、Windowsコンピ
ュータで、これらと同じFBV MIDIポートを使用するように構成されている場合は、ただ１つのアプリケーシ
ョンのみが使用を許可される事になります。
もしも、既にPOD Farm 2スタンドアローン・アプリケーションか、DAWソフトウエアが作動中で、１つに
FBV MIDI イン・ポートを使用可能にさせてあり、Line 6 FBV Controlアプリケーションの起動を試み
たとしても、FBV Controlアプリケーションは、接続されたFBVデバイスを認識できないという結果にな
ります。これは他のソフトウエアが既に「使用中」であるという理由からです。 一つの解決策としては、まず
FBV MIDI Inポートの使用を不可にし、POD Farm 2の中のFBV MIDI Out 4ポート、またはDAWソフ
トウエアに対し、 FBV Controlアプリケーションを使用中でも、それを使えるように許可を与える設定を
することです。 (POD Farm 2、またはDAWソフトウエアにFBV MIDI Outポート1〜3から受信するよう
に設定したままでも大丈夫です。FBVから MIDI コントロール・コマンドをソフトウエアへ送る事ができま
す。) そうしないとFBV Control]ソフトウエアを使用して、FBVコントロール・セッティングを編集するため
に、FBV ControlソフトウエアへMIDI ポートの完全なアクセスを提供しようとする際、他のアプリケーショ
ン全てを先に終了させなければなりません。

注意: Line 6 Monkey アプリケーションは、接続されたFBV デバイスの動作を認識するため、またアップデートを
行うために FBV–MIDI ポートを使用します。 Line 6 Monkeyを起動する場合は、その前にLine 6 FBV Control
だけではなく、その他どのMIDI/DAW ソフトウエアであっても終了させておく事をお勧めします。

MIDI チャンネル
各USB–MIDIポートに、16のMIDI「チャンネル」があります。 MIDI チャンネルは、ご家庭のTVのチャン
ネルだと考えてください。あなたのTVは多くの「チャンネル」を受信する事ができます。しかし、あなたの
見たいと思うプログラムがあっても、それを放映する特定のチャンネルにTVが設定されていなければ、そ
れを見る事ができません。 MIDIの世界でもそれは同じです。 デフォルトでは、FBV MkIIデバイスがそれ
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ぞれのコントロールのためのMIDI データを、選択したMIDIポートのチャンネル1へ送信するように設定
されています。 とはいえ、個々のどのFBV Controlでも、そのMIDIコントロール・データをどの MIDIチ
ャンネルに送信するかを設定する事もできます(3•1 ページのFBV Controlアプリケーションの Control 
Propertiesリスト欄をご覧ください)。 ソフトウエアのオプションに、選択したMIDIポートから、特定した１
つのMIDIチャンネルで受信するための設定があることに気づかれるでしょう。ですから、このようなどの
MIDIチャンネル・オプションも、FBV コントロールの送信に合わせて設定をすることが必要です。 MIDI チ
ャンネル・オプションの詳細に関しては、お手持ちのソフトウエアの説明書をご覧ください。

POD Farm 2の予め設定されたMIDIの割り当て
POD Farm 2スタンドアローン・アプリケーションとPOD Farm 2プラグインには、「予め設定された」
MIDI コントロールの割り当てを含めたトーン・プリセットの完全なフォルダーが１つ含まれています。 こ
れらのトーン・プリセットにアクセスする場合は、PresetsビューのSource Foldersの枠にある、「POD 
Farm 2」のタイトルが付いたフォルダーを選択します。

これらのフォルダーの中で使用可能なトーン・プリセットには「pre-configured」 
MIDIコントロールの割り当てが含まれています。

Source Folders の枠の中から「POD Farm 2」フォルダー (またはそのサブ・フォルダー)を選択します。

POD Farm 2 Presetsビュー

予め設定された MIDIの割り当てを利用すれば、どのMIDIコントローラー・デバイスでもこれらのPOD 
Farm 2トーン用の数多くの便利なパラメーターにアクセスすることができます。 これらのトーンの MIDI
の割り当ては、「Local」MIDI の割り当てを意味していて、それらが個々にそれぞれのトーン・プリセット
と共に保存されていること、そしてPOD Farm 2プラグインの中でのみアクセス可能であり、またそれ
は、POD Farm 2スタンドアローン・アプリケーションでも同様であるという事に注意してください。
加えて、POD Farm 2スタンドアローン・アプリケーションには、幾つかの予め設定された「Global」MIDI
の割り当ても含まれています。 これらのグローバル MIDIの割り当ては、名前が示すようにPOD Farm 2 
システムのセッティングのために設定されているものです。 これらグローバルの割り当ては、現在使用して
いるトーン・プリセットに関係なく利用する事ができ、POD Farm 2アプリケーションの中でそのまま残り
ます(トーンをそのまま留めるために保存する必要はありません)。
Line 6 FBV MkIIコントローラー・デバイスと共に、簡単に操作ができるようにと、これらトーンのMIDIの
割り当てに即座にアクセスするためのFBVデバイスを設定する「POD Farm 2」FBV Control プリセッ
トを用意しました(次のセクションをご覧ください)。

「POD Farm 2」 FBV MkII コントロール・プリセット
FBV MkIIをPOD Farm 2と共に使用する時に「ジャンプスタート」ができるように、「POD Farm 2」
FBV MkIIコントロール・プリセットが用意してあります。Line 6 FBV Controlアプリケーションを使っ
て、FBV デバイスに読み込ませる事ができます。 これらのFBV MkIIコントロール(.fbv ファイル)プリ
セットは、POD Farm 2を即座に機能させるために、デバイスの各フットスイッチとペダルのための完全
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なMIDIコマンドの１セットを読み込みます! FBV MkIIコントローラー・デバイスのためにPOD Farm 2
スタンドアローン・アプリケーション、またはプラグインの設定に進む前に、FBV MkIIデバイスに、FBV 
Controlプリセットをダウンロードして読み込む事をお勧めします。 これらのFBV MkIIプリセットは、POD 
Farm Online Helpサイトからダウンロードして入手することができます:

•	 FBV Shortboard MkIIを使用する - 「POD Farm 2-Shortboard.fbv」のファイルネームのつ
いたファイルをダウンロードします。

•	 FBV Express MkIIを使用する - 「POD Farm 2-Express.fbv」のファイルネームがついたファ
イルをダウンロードします。 

FBV Controlプリセット・ファイルをデバイスにダウンロードした後、Line 6 FBV Controlアプリケーショ
ンを起動して、FBV MkIIにプリセットを読み込みます:

•	 Mac®を使用している場合は、アプリケーション/Line 6 へ進み、Line 6 FBV Controlをダグルク
リックします。 

•	 Windowsの場合は、スタートボタンメニュー・プログラム Line 6\Line 6 FBV Controlへ進みま
す。 

Line 6 Controlアプリケーションの使い方に関する詳細は、「Line 6 FBV Control アプリケーション」(3•1ページ)を
ご覧ください。

これで、「POD Farm 2」MIDI コントロール・セッティングの完全な１セットが自動的にFBV MkIIデバイス
の内蔵メモリーに読み込まれます。 これらのFBVコントロール・セッティングにより、POD Farm 2の中に
既に存在する、多くの便利な「予め設定された」MIDI コントロールの割り当てに、即座にアクセスすること
ができます(前のセクションで説明されているように)。 POD Farm 2 「MIDI Assignments View」画
面を見れば、現在MIDIの割り当てが、どのPOD Farm 2トーン・プリセットに与えられているかを見る事が
できます(「POD Farm 2 MIDI Assignments ビュー」(4•10ページ)をご覧ください)。 MIDIバンク&プロ
グラム・チェンジ・セッティングは、FBV MkIIプリセットに含まれていて、POD Farm 2セットリストとトーン・
プリセットをフットスイッチを使って一覧できるようにすることもできます。 さらに、これらのMIDIの割り当
てを個々にPOD Farm 2トーンのどれにでも自分で作成したり、そしてあるいは、POD Farm 2 「MIDI 
Learn」の機能を使って、簡単に作成することもできます(「POD Farm 2のMIDI ラーン機能」(4•11ページ)
をご覧ください) 。
FBV MkII 「POD Farm 2」コントロール・プリセットがFBV ShortboardまたはExpress MkIIデバイス
に読み込んであれば、FBV ControlアプリケーションのControl Propertiesリストがその MIDIセッティ
ング全てを表示します。

http://line6.com/dispatch/?appid=2097217558&page=manuals
http://line6.com/dispatch/?appid=2097217558&page=manuals
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FBV Shortboard MkII

FBV Controlアプリケーションの中に読み込まれている場合は、POD Farm 2-Shortboard.fbvプリセット・セッティングです。

上記のFBV Shortboard MkII MIDIコントローラー・セッティングは、POD Farm 2と共に以下の機能を
実行します:

FBV Shortboard MkII コントローラー POD Farm 2 予め設定されたモデル & パラメーター
Bank Up 選択した Setlist 内の次のトーン・プリセット 
Bank Down 選択した Setlist 内の前のトーン・プリセット 
A Setlist 0を選択し、「0」の番号の付いたトーン・プリセットを中に呼び出し

ます。
B Setlist 1を選択し、「0」の番号の付いたトーン・プリセットを中に呼び出し

ます。
C Setlist 2を選択し、「0」の番号の付いたトーン・プリセットを中に呼び出し

ます。
D Setlist 3を選択し、「0」の番号の付いたトーン・プリセットを中に呼び出し

ます。
Tap 使用されていません 
Stomp 「Stomp」 エフェクト (ディストーション、ダイナミクス、フィルター) – オ

ン/オフ
Modulation モジュレーション・エフェクト – オン/オフ
Delay ディレイ – オン/オフ
Reverb リバーブ – オン/オフ
Toe Switch ワウ – オン/オフ、 ベンダー・エフェクト オン/オフ
Pedal Wah ワウ - Position ノブを調節
Pedal 2 割り当て無し

FBV Shortboard MkII コントローラー POD Farm 2 予め設定された Global パラメーター
(POD Farm 2 スタンドアローンのみ)

Function 1 A/B スイッチ –トーン A とトーン Bを切り替える
Function 2 Toggles Tuner ウインドウ表示の オン/オフを切り替える
Tap Tap Tempo (システム・テンポを設定する)
Pedal Volume Tone Aレベルとトーン B間のミックスレベルを調整
POD Farm 2-Shortboard.fbvプリセット・セッティングによってPOD Farm 2に備わっている予め設定された機能
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•	 Bank Up & Bank Down フットスイッチ - これら２つのフットスイッチにアクセスする事で、選択し
た Setlistの中のトーン・プリセットを一覧することができます。

•	 A, B, C & D フットスイッチ - 上記で示すように、これらのフットスイッチにアクセスして対応する番
号のセットリストを選ぶ事ができます。 また、選択した Setlist(その左側に「0」が付いている)の中
の最初のトーン・プリセットも同時に読み込みます。 これにより、選択した Setlistの中の全てのトー
ン・プリセットを Bank Up & Downボタンを使って一覧する事ができます。

POD Farm 2の初期設定に、セットリストはありません。そのため、A, B, C と D フットスイッチは、そのままでは
何の機能もありません。前もってセットリストを４つ作成し、トーン・プリセットをそのセットリストに加える必要があ
ることに注意してください。 セットリストの作成と管理に関する詳細は、ベーシック・ユーザー・ガイドをご覧ください 
(POD Farm 2 Helpボタンを押すか、POD Farm Online Help サイトから入手することができます)。

•	 エフェクトが明記されたフットスイッチとペダル・ワウ - これらは、「POD Farm 2」トーン・プリセット
内の上記のリストに記載されている機能を作動させるトリガーになります。これらのPOD Farm 2
トーン・プリセットにのみ、予め設定された Local」 MIDI コントロールの割り当てが含まれているか
らです。 全てのトーン・プリセットに、これらのエフェクトモデルと割り当てが含まれている訳ではな
い事に注意してください。。多くのプリセットの中で、エフェクト・モデルとMIDI の割り当ては幾つか
存在するだけです。

•	 Toe Switch - 上記の表に記載されているように、トー・スイッチは「POD Farm 2」 ソース・フォル
ダー内の幾つかのトーン・プリセットの中にある、ワウ・モデルのオン／オフ、あるいはべンダー・モデ
ルのオン／オフの切り替えに割り当てられています。 トー・スイッチには、 FBV Shortboard MkII 

「Pedal 1」機能を「Pedal Wah」または「Pedal Volume」に割り当てを切り替えるための、「変更
できない」機能が追加されています。

•	 Pedal 2 - このコントローラーは、予め設定された割り当てセッティングへのアクセスを行いませ
ん。 しかし、FBVプリセットがペダル2に対し、MIDI CC コマンドを送信するように設定されている
ため、POD Farm 2 MIDI Learn機能としてこれらのFBVコントロールをPOD Farm 2機能へそ
のまま対応させることができます。

•	 Function 1, Function 2 & Tap - これらのコントローラーは全て、「Global」MIDIの割り当て
に設定されていて、 POD Farm 2 スタンドアローン・アプリケーションの中でのみ予め設定され
た MIDI の割り当てとして存在するのであって、プラグインの中ではありません。 (とはいえ、POD 
Farm 2プラグインの中でMIDI ラーンを使用し、どのFBV MkIIコントロール用でもグローバル 
MIDIの割り当てを手動で作成する事は可能です!) ローカル & グローバルの割り当てと、MIDI ラ
ーンに関しては、次のセクションで詳しく説明します。 

•	 Pedal Volume - Mixerビューの中の Tone AレベルとTone Bレベルフェーダー両方を同時に調整
します。 現在、POD Farm 2がシングル・トーンに設定されていると、Tone A Levelフェーダーしか
コントロールできないという状態になります。 これはグローバルMIDIの割り当てであることに注意
してください。

FBV Express MkII

FBV Controlアプリケーションで読み込まれた際の、POD Farm 2-Express.fbvプリセット・セッティング

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
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上記のFBV Express MkII MIDIコントローラー・セッティングは、POD Farm 2と共に以下の機能を実
行します:

FBV Express MkII Control POD Farm 2 予め設定されたモデル & パラメーター
A 前のセットリストを選択し、最初のトーン・プリセットを中に読み込む
B 次のセットリストを選択し、最初のトーン・プリセットを中に読み込む
C 選択したセットリストの中で前のトーン・プリセットを読み込む
D 選択したセットリストの中で次のセットリストを読み込む
Pedal Wah ワウ - Position ノブを調節
Toe Switch ワウ – オン/オフ、またはベンダー・エフェクト オン/オフ

FBV Express MkII コントローラー POD Farm 2 予め設定された Global パラメーター
(POD Farm 2 スタンドアローンのみ)

Pedal Volume Tone Aレベルとトーン B間のミックスレベルを調整
POD Farm 2-Express.fbvプリセット・セッティングによってPOD Farm 2に備わっている予め設定された機能

•	 A & B フットスイッチ - これらのフットスイッチにアクセスすると、スイッチに応じてそれぞれ番号
の付いているセットリストの１つ前とその次を選ぶ事ができます。 また、その度に選択した Setlist(
その左側に「0」の番号が付いているプリセット)の中の最初のトーン・プリセットも同時に読み込みま
す。 これにより、選択した Setlistの中の全てのトーン・プリセットを C & D フットスイッチを使って
一覧する事ができます。

•	 C & D フットスイッチ - これらのフットスイッチにアクセスすると、現在選択しているセットリストの
中の、番号の付いているトーン・プリセットの１つ前とその次をそれぞれ選ぶ事ができます。

POD Farm 2の初期設定に、セットリストはありません。そのため、Bank Up, Bank Down, A, B, C と D フット
スイッチは、そのままでは何の機能もありません。前もってセットリストを作成し、トーン・プリセットをそのセットリス
トに加える必要があることに注意してください。 セットリストの作成と管理に関する詳細は、ベーシック・ユーザー・ガ
イドをご覧ください (POD Farm 2 Helpボタンを押すか、POD Farm Online Help サイトから入手することが
できます)。

•	 Toe Switch - 上記の表に記載されているように、トー・スイッチは「POD Farm 2」 ソース・フォ
ルダー内の幾つかのトーン・プリセットの中にある、ワウ・モデルのオン／オフ、あるいはべンダー・
モデルのオン／オフの切り替えに割り当てられているかもしれません。 トー・スイッチには、FBV 
Shortboard MkII 「Pedal 1」機能を「Pedal Wah」または「Pedal Vol」に割り当てを切り替える
ための「変更できない」機能が追加されています。

•	 Pedal Wah  - 「Position」ノブで、「POD Farm 2」トーン・プリセットの中のワウ・モデルを調整し
ます。 トーン・プリセットの中の幾つかで、クールなピッチ・ベンディング・アクションのために、１つのペ
ダルでベンダー・モデルの「Position」ノブをコントロールすることもできるでしょう。

•	 Pedal Volume  - Mixerビューの中の Tone AレベルとTone Bレベルフェーダー両方を同時に調整
します。 現在、POD Farm 2がシングル・トーンに設定されていると、トーン A レベル フェーダーし
かコントロールできないという状態になります。 これらのコントローラーは全て、「Global」MIDIの
割り当てに設定されていて、 POD Farm 2 スタンドアローン・アプリケーションの中でのみ予め設
定された MIDI の割り当てとして存在するのであって、プラグインの中ではない事に注意してくださ
い。 (とはいえ、FBV Express MkIIで MIDI Learnを使い、これとまた他のグローバル MIDIの割
り当てを手動で作成することも可能です!)

これらの設定をFBV MkIIで行ってから、FBV Controlアプリケーションを終了し、POD Farm 2 スタン
ドアローン・アプリケーション、またはプラグインを設定するステップへ進んでください。

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
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POD Farm 2 スタンドアローン・アプリケーション - MIDI インプットの設定
FBV MkIIデバイスをPOD Farm 2 スタンドアローン・アプリケーションと共に使う場合は、 先ず最初に 
POD Farm 2 が、接続されたFBV MkIIデバイスの MIDI ポートから MIDIを受信するように設定する必
要があります。

POD Farm 2プラグインをコントロールしたい場合は、「POD Farm 2プラグイン - MIDI インプットの設定」(4•9ペ
ージ)へ進んでください。 POD Farm 2プラグインの MIDI コントロールは、DAW ソフトウエアの中で MIDIセッテ
ィングを設定する必要があります。

•	 Launch the POD Farm 2 Preferences ダイアログを起動し、MIDI タブへ進みます。 ここで、
接続されているどのMIDI コントローラー・デバイス、またはポートのどれでも選択することができま
す。 コンピューターのオペレーティングシステムによっては、４つの FBV MIDI Out ポートが違う名
称になる場合があることに注意してください:

Preferences—MIDI ダイアログ オン Mac OS® X

Preferences—MIDI ダイアログ オン Windows® 7, Windows Vista®

Preferences—MIDI ダイアログ オン Windows® XP

•	 初期設定として、既にLine 6 MIDI デバイスの全てが、全ポートに選択されているのに気づかれる
でしょう。 POD Farm 2 コントロールに使いたいものを除いて、全て選択を取り消したいと思われ
るはずです。 あなたのセッティングは、そのアプリケーションを後でまた使用できるように、記憶され
ます。

•	 上記の例では、接続した Line 6 FBV Shortboard MkIIコントローラーの、Port 1 アウトプット
からのみ MIDIを受信するように設定した事が分かります。 (その Footswitch 1 & 2 の接続
で、MIDI コマンドを送信するようにも設定できるため、接続した Line 6 UX2デバイスは１つのオ
プションであるという事に注意してください。しかし、この例では FBV MkIIポート1だけを使用して
います。)
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•	 OK をクリックして POD Farm 2 Preferences を抜けると、 MIDIインプットの設定手順は終了
します。

POD Farm 2プラグイン - MIDI インプットの設定
POD Farm 2 プラグインは、他全てのオーディオ・エフェクト・プラグインと同様に、DAW ソフトウエアの
オーディオ・トラックの中で使用します。 POD Farm 2 プラグインは、FBV MkII USB MIDIポートから
MIDIを受信して、その多くのパラメーターを遠隔操作することができます。しかし、POD Farm 2プラグ
インにアクセスするために、MIDI コミュニケーションを DAWソフトウエア経由でルートさせる必要があり
ます。 これは、通常のDAW アプリケーションの中で、多少異なる設定といえるかもしれません。従って、詳
細に関してはお手持ちの DAWの説明書をご覧になることをお勧めします。 このプロセスでは、DAW ア
プリケーションの中のFBV MkII MIDIポートから、 MIDI を受信して、次に MIDI In を DAWの MIDIトラ
ックの中の１つへ、そして OutをPOD Farm 2 プラグインが挿入されるオーディオ・トラックへルーティン
グさせる事が必然的になります。
POD Farm 2プラグインの中のパラメーターにアクセスする際に必要なFBV MkIIデバイスの設定方法
を分かり易くするために、人気のあるAbleton Live DAW アプリケーションを使った簡単なチュートリア
ルを用意しました。 その手順は通常の DAW アプリケーションを使った手順と同様ですので、手始めとし
てお役に立つはずです。

ヒント:人気のある幾つかの DAW アプリケーションの中で、POD Farm 2プラグインの外部 MIDI コントロール
をセットアップする際には、チュートリアルとしてPOD Farm 2 Recording Setup Guideを必ず参照してくださ
い。POD Farm Online Helpサイトからダウンロードすることで入手できます!

FBV MkIIデバイスをコンピュータに接続した状態で、Ableton Liveソフトウエアを起動して以下へ進みます：
•	 Mac® - Ableton Live メニュー > Preferences > MIDI/Sync ページ

•	 Windows® - Options メニュー > Preferences > MIDI/Sync ページ 

これでAbleton Liveは自動的に FBV MkII MIDI Outポートを認識します。 お手持ちのコンピュータに
インストールされている MIDI ハードウエア/ソフトウエアの種類によっては、ここに他のデバイスのMIDI 
ポートが追加として表示されることもあります。

MIDI インプット・ポ
ート用に「Track」と

「Remote」 ボタン
の両方をクリックして

「On」にします。*

ここで FBV MIDI 
Out Port を選択しま
す(各FBV ポートは最
大4つの MIDI インプ
ットまで選択する事が
できます)。 

Ableton Live® - FBV MkIIをMIDI インプットとして選択する (Mac OS® X)

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
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*Liveが、選択したMIDIポートからMIDI コントローラー・データを受信するように、MIDI イン「Remote」
オプションをオンに設定する必要があるだけです。 しかし、LiveにMIDIを受信させて、MIDIトラックに入れ
さるためには、「Track」オプションをオンに設定しなければなりません。 そのMIDI トラック・インプットが、 
MIDI コントロール・データを直接POD Farm 2 プラグインへルートさせるように設定する必要がありま
す。
Mac OS® X, Windows® 7, Windows Vista®または XP を使用している場合、DAWの中で FBV 
MkII MIDI ポートを選択すると、USB–MIDI ポートに違うポートネームが付いているのに気づくはずです 
(タイトル表示で FBV Express MkIIは、「Shortboard」の代わりに、「Express」と表示されます):

Mac OS® X Windows® 7, Vista® Windows® XP
MIDI Out ポート 1 FBV Shortboard Mk II (ポート 1) FBV Shortboard Mk II USB オーディオ・デバイス
MIDI Out ポート 2 FBV Shortboard Mk II (ポート 2) MIDIIN2 FBV Shortboard Mk II USB オーディオ・デバイス [2]
MIDI Out ポート 3 FBV Shortboard Mk II (ポート 3) MIDIIN3 FBV Shortboard Mk II USB オーディオ・デバイス [3]
MIDI Out ポート 4 FBV Shortboard Mk II (ポート 4) MIDIIN4 FBV Shortboard Mk II USB オーディオ・デバイス [4]

 次の手順では、POD Farm 2 プラグインをDAW オーディオ・トラックの１つに挿入し、その DAW MIDI
トラックの１つにFBVから MIDI アウトプットを受信させ、それをオーディオ・トラックに与えてから、POD 
Farm 2 プラグインへ送り込むように設定します。 例えば、POD Farm 2プラグインがオーディオ・トラッ
ク 1に挿入される Ableton Liveで設定する場合の手順を紹介します:

新しいMIDIトラックで、コマンドを送信するFBV MkII MIDIポ
ートからインプットが受信するように設定します。

アウトプットがPOD Farm 2プラグインを挿入するオーディ
オ・トラックになるように設定します。

POD Farm 2プラグインは、これにより「MIDI Output 
Channel」の目的地として現れることになります。

POD Farm 2プラグインがオーディ
オ・トラック1に挿入されています。

MIDIスループット（処理量）に余裕を持たせて、 
MIDIトラックを備えるように注意してください。

POD Farm 2 プラグインへ送るFBV MkII MIDI インプットをAbleton Liveで設定する

上記の MIDI ルーティングの設定が終了すれば、FBV MkIIをPOD Farm 2 プラグインと合わせて使う
準備は完了です!

POD Farm 2 MIDI Assignments ビュー
MIDI Assignments ビューは、POD Farm 2 スタンドアローン・アプリケーションとPOD Farm 2 プ
ラグインの中で、現在選択されているトーン・プリセット用の MIDI コントロールの割り当て全てを表示し
ます。 4•3 ページでも記載されているように、FBV MkIIデバイスで「POD Farm 2」 FBV Control プリセ
ットを読み込むと、POD Farm 2トーン・プリセットの中で「予め設定された」MIDI コントロールの割り当
てにアクセスできるようになります。 割り当てたパラメーターのコントロールに必要な、それぞれのMIDI
の割り当ておよび特定のMIDIコマンドと値を参照する場合は、MIDI Assignmentsビューを使います。 
Clearボタンを使って、現存する割り当てを除去します。
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MIDI Assignments ボタン   Automation Assignments ボタン	 Clear All ボタン

Clear ボタン 「Global」 MIDI の割り当て (
白で記載された文)

「Local」 MIDI の割り当て (
黄色で記載された文) 

POD Farm 2 MIDI Assignments ビュー

ローカルとグローバル MIDIの割り当て
「Local」 MIDI の割り当ては、現在選択している POD Farm 2トーン・プリセットに固有のものとして特
定されています（従って保存されている訳です）。 「POD Farm 2」ソース・フォルダーの中のトーン・プリセ
ットには、ローカル MIDI の割り当てが含まれていて、 既にそれぞれのトーン・プリセットファイルと共に保
存されています。 Global MIDI の割り当ての場合、POD Farm 2スタンドアローン・アプリケーションや、
現在のプラグインの例では、使用しているプリセットがどれであってもそのまま残ります。 POD Farm 2
スタンドアローン・アプリケーションには、幾つかの予め設定された「Global」MIDIの割り当ても含まれて
います。 Local と Global MIDI の割り当ては、FBV MkIIコントローラーとPOD Farm MIDI Learn機
能を使い、手動で作成する事ができます(次のセクションをご覧ください)。 MIDI Assignmentsビューに
関する詳細は、POD Farm 2 ベーシック・ユーザー・ガイドをご覧ください。

POD Farm 2のMIDI ラーン機能
POD Farm 2 MIDI Learn 機能を使えば、簡単にFBV MkIIデバイスのフットスイッチやペダル
を、POD Farm 2パラメーターのほぼどれにでも対応させる事ができます。 MIDI Learnを使い、FBV 
MkIIデバイスからMIDIの割り当てを幾つでも含めるように、どのPOD Farm 2トーン・プリセットでも「カ
スタマイズ」する事ができます。 MIDI ラーンの使い方はとても簡単です:

•	 POD Farm 2 (スタンドアローン・アプリケーションかプラグイン)で、トーン・プリセットを読み込む
か、あるいは好きなモデルにトーンを設定します。

•	 シグナル・フロー・ビューの中のどれか１つのモデルをダブルクリックして、Panelビューにエディット・
パネルを読み込みます。

•	 エディット・パネルの中で、遠隔操作したいそのモデルのノブ、スライダー、またはスイッチを直接、右
クリック(Windows®)または Ctrl+クリック(Mac®)して 、MIDI Controlメニューを選択します。

•	 MIDI Controlサブメニューの中でMIDI Learnをクリックします。 これにより、POD Farm 2は 
MIDI Learnモードに入り、接続された MIDIコントロール・デバイスからコマンドを受信する待機状
態に入ります。

•	 ここで選択したパラメーターに「マップ」（対応づけ）させたいFBVのフットスイッチを踏むか、ペダル
を巧く操作します。これでPOD Farm 2から FBVコントロールは即座に「覚える」事ができるので
す。
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MIDI Learnが用意されている全ての POD Farm 2 パラメーターは、どのMIDI コンティニュアス・コン
トローラー (CC)、ノート・オン、そしてピッチ・ホイール・タイプ・コマンドを「覚える」事ができるようになって
います。 従って、もしもFBV Control アプリケーションの中で、自分だけの MIDIコマンドを作成する場
合、POD Farm 2で利用する事ができるのという理由からも、このようなタイプのコマンドを使って、個々
のFBV MkIIコントローラーを設定するのが良い方法です。 また、POD Farm 2 の中の「On/Off」スイッ
チ・パラメーターのほとんどは、 コントローラーの MIDI CC スイッチ・モードで「Toggle」(そのパラメー
ターをオンとオフに切り替えられるように)、または「Momentary」(そのスイッチを押した時だけ、そのパ
ラメーターが「On」になるように)にあらかじめ設定しておく必要があることに注意してください. 
人気のある多くの DAW アプリケーションには、独自の「MIDI Learn」機能が用意されていますが、ここ
で記載しているPOD Farm 2 MIDI Learn 機能とは別の物であるということも注意する必要がありま
す。 MIDI コントロール機能が用意されている DAWアプリケーションの多くが、FBV MkIIコントローラ
ーを使用して、離れた場所から様々な DAW ミックスとトラック・パラメーターにアクセスすることができま
す。そしてその中には、DAW アプリケーションのオプションを経由させたPOD Farm 2プラグインとそ
の他のプラグイン・パラメーターも含まれています。 これらの機能については、第「FBV™ MkII と サード
パーティーのソフトウェア」 章で説明します。

POD Farm 2 MIDI コントロールに関するさらに詳しい説明は、POD Farm Online Help サイトから
入手可能な、もう一つの POD Farm 2 に関する追加資料をご覧ください。

http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
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FBV™ MkII と Line 6 GearBox™ 
この章では、 Line 6 FBV Shortboard™ または FBV Express™ MkII を使用してLine 6 GearBox™ ソフトウェアをコント
ロールする方法を説明しています。早速、その世界へ飛び込んでみましょう...

GearBox とは？
ご存知ない方へ... Line 6 GearBox は、Line 6 USB オーディオ インターフェースの製品（POD Studio™、TonePort™、
GuitarPort™ デバイス *）のオーナーの方が使用できるフリー ソフトウェアです。GearBox により、コンピュータにフル
機能のユーザー インターフェースがもたらされます。数々の名高い Line 6 のギター & ベース アンプ、プリアンプ、ス
ピーカー キャビネット、マイク、エフェクト モデルにアクセスできます。GearBox は元来、Line 6 USB オーディオ インター
フェースを使用して、コンピュータ上に伝説的 POD トーンを再現するものです。慣れ親しんだオーディオ ソフトウェアに
録音したり、お気に入りの曲と一緒に演奏したり、あるいは、GuitarPort のオンライン定期購読サービスにサインアップ
することも可能です！ 

*ノート: GearBox は、USB で接続されたオーディオ インターフェース デバイスとしての PODxt や POD X3 とも一緒
に使用できます。けれども、FBV MkII は、USB 経由でコンピュータに接続せず、これらの POD デバイスに直接、 RJ-45 
ケーブルで接続することが推奨されます。FBV MkII で POD を直接コントロールすると、GearBox のコントロールも
応答することを確認できるでしょう！

GearBox を入手するには、Line 6 USB オーディオ インターフェースを Mac® または Windows® コンピュータに接続し、
Line 6 Monkey を起動してください。愛らしいモンキーにより、ダウンロードへの道が強調表示されます。あるいは直接、 
http://line6.com/software/ のページへ飛んでそこからダウンロードしてください。

まだであれば、Line 6 FBV Control アプリケーションもダウンロードしてインストールしてください。FBV デバイスが 
GearBox と交信する際に使用する MIDI コントロールの情報をロードして編集するには、この Control アプリケーション
が必要となります。ダウンロードの方法は、 「Line 6 FBV Control アプリケーション」（ 3•1 ） に記しています。

接続しましょう！
GearBox を起動する場合、もちろん、Line 6 USB オーディオ インターフェースをコンピュータに接続しなければなりま
せん。そしてまた、FBV MkII デバイスも他の USB ポートに接続しましょう。接続が済んだら、以下の手順で、接続された 
FBV MkII デバイスからの MIDI コントロール データを GearBox が受信するように設定を行います.

• GearBox を起動します。  
アプリケーション > Line 6 > GearBox（Mac®）、または スタート > Programs > Line 6 > GearBox（Windows®）

• GearBox アプリケーションでメニューを選択します。  
GearBox > Preferences > MIDI/Control（Mac®）、または Edit > Preferences > MIDI/Control（Windows®）

• “MIDI Control” 設定で、“Send MIDI...” オプションのチェックを外し、接続された FBV MkII デバイスの最初の有効
ポートを選択します。（*）

“Send MIDI...” オプションを無効に

　　　　　FBV MkII デバイスの 
　　　　　最初のポートを選択

http://line6.com/software/
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• “OK” をクリックしてダイアログを閉じます。

* 下の表のように、コンピュータの OS により、表示される FBV MkII の MIDI 出力ポートの名称が異なることにご注意く
ださい（FBV Express MkII の場合、“Shortboard” の代わりに “Express” と表示されます）:

Mac OS® X Windows Vista® Windows® XP

MIDI 出力ポート 1 FBV Shortboard Mk II（Port 1） FBV Shortboard Mk II USB Audio device

MIDI 出力ポート 2 FBV Shortboard Mk II（Port 2） MIDIIN2 FBV Shortboard Mk II USB Audio device [2]

MIDI 出力ポート 3 FBV Shortboard Mk II（Port 3） MIDIIN3 FBV Shortboard Mk II USB Audio device [3]

MIDI 出力ポート 4 FBV Shortboard Mk II（Port 4） MIDIIN4 FBV Shortboard Mk II USB Audio device [4]

MIDI 入力ポート 1 FBV Shortboard Mk II（Port 1） FBV Shortboard Mk II USB Audio device

GearBox ソフトウェア内での必要な設定は以上です。次に、FBV MkII の設定に進みましょう。目的の GearBox の機能
をトリガーするため、FBV MkII が特定の MIDI コマンドを送信できるように設定します。最も簡単な方法は、Line 6 FBV 
Control アプリケーションに付属する「GearBox.fbv」 FBV コントロール プリセットを選択することです:

• Line 6 FBV Control アプリケーションを起動します。  
アプリケーション > Line 6 > Line 6 FBV Control（Mac®）、 
スタート > Programs > Line 6 > Line 6 FBV Control （Windows®）

• File > Open を選択し、ここで 「GearBox.fbv」プリセット ファイルを選択します: 
書類 > Line 6 > FBV > Presets（Mac®） 
マイ ドキュメント > Line 6 > FBV > Presets（Windows®）

これにより、GearBox MIDI コントロールの割り当ての完全なセットが、FBV MkII デバイスの内部メモリに自動的にロー
ドします。“Control Properties” リストにはすべての設定が表示されるはずです:

 
GearBox.fbv プリセット : FBV Shortboard MkII にロードされた設定

GearBox.fbv プリセット : FBV Express MkII にロードされた設定
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この「GearBox.fbv」プリセットを使用した場合に、FBV の各コントロールが実際に GearBox の何をトリガーするかを表
にまとめました。ご活用ください:

FBV Shortboard MkII

FBV のコントロール GearBox の機能

FUNCTION 1 Comp エフェクト オン/オフ

FUNCTION 2 Amp/Preamp オン/オフ

BANK UP Player トランスポート - 再生/停止 切り替え

BANK DOWN Player トランスポート - 巻き戻し

A Gate エフェクト オン/オフ

B EQ エフェクト オン/オフ

C 割り当てなし

D 割り当てなし

TAP Tap Tempo

STOMP Stomp エフェクト オン/オフ

MODULATION Modulation エフェクト オン/オフ

DELAY Delay エフェクト オン/オフ

REVERB Reverb エフェクト オン/オフ

TOE SWITCH* Wah エフェクト オン/オフ

PEDAL WAH Wah Position

PEDAL VOL Volume Position

PEDAL 2 Delay Mix Level

* トゥ スイッチにはペダルの割り当てを切り替える（“Wah”/“Vol”）という、ハードウェアに組み込まれた機能があります。

FBV Express MkII

FBV のコントロール GearBox の機能

BANK UP Player トランスポート - 再生/停止 切り替え

BANK DOWN Player トランスポート - 巻き戻し

A Gate エフェクト オン/オフ

B EQ エフェクト オン/オフ

C 割り当てなし

D 割り当てなし

TOE SWITCH* Wah エフェクト オン/オフ

PEDAL WAH Wah Position

PEDAL VOL Volume Position

* トゥ スイッチにはペダルの割り当てを切り替える（“Wah”/“Vol”）という、ハードウェアに組み込まれた機能があります。

さて、お楽しみの準備が整いました！ FBV のフットスイッチやペダルを操作してみましょう。GearBox が応答するのを目
と耳で確認できるはずです！ 
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GearBox のコントロールをカスタマイズ
前記でロードされた設定はとても役立つものですが、「もっと色々コントロールしたい」と思われましたか？ 大丈夫です！  
GearBox の機能の多くは MIDI コマンドによって遠隔操作可能です。そのために必要なのは、Line 6 FBV Control アプリ
ケーション内で設定を編集することだけです。任意の GearBox 機能に MIDI コマンドを割り当てます。

まず、GearBox の各機能にどの MIDI コマンドが必要なのかを把握しなければなりません。この情報は書類「MIDI 
Continuous Controller Reference」に記されています（FBV MkII Online Help からダウンロード可）。この書類の

「GearBox MIDI CC Reference Chart」をご参照ください。GearBox の各機能と、その MIDI CC ナンバーと値の割り当て
をリストにしています。また、アンプとエフェクト モデルの MIDI CC の割り当てのリスト「GearBox Model Tables」もご確
認ください。

FBV ペダルの設定 : GearBox のノブ パラメータをコントロールする
GearBox には数多くのノブがありますが、その中でお好きなノブを FBV MkII のペダル（そして Shortboard に接
続されたオプションの Expression Pedal）で操作できます！ 例えば、FBV ペダルの WAH コントロールを使用して、
GearBox の Modulation Mix パラメータ（Wah Position のパラメータではなく）をコントロールするとしましょう。  

「GearBox MIDI CC Reference Chart」をご覧ください。Modulation Mix パラメータの列を見ると、 「CC #56」、「最小値 
0」、「最大値 127」となっています:

Line 6 FBV Control アプリケーションの “Control Properties” の“PEDAL WAH” の列で同じ設定をすればよい訳です:

• MIDI Command: “MIDI CC”

• Value: “CC# 056”

• MIDI Port: “1”（ここでは任意のポートを選択して構いませんが、コマンドを受信するためには、GearBox の 
“MIDI In” 設定も同じである必要があります。 「接続しましょう！」（ 5•1 ）をご参照ください。）

• MIDI Channel: “1”（GearBox は、チャンネル 1 でのみ MIDI を受信します。）

 「MIDI CC Reference Chart」に示された Minと Max（レンジの最小値、最大値）を見ると、このパラメータを「0 から 
100%」（MIDI CC の値で「0 から 127」に相当）までコントロールできるということが分かります。つまり、他に設定をしな
くても、ペダルの操作で、Modulation Mix パラメータのフルレンジをコントロールすることが可能です。「GearBox MIDI 
CC Reference Chart」を参照して同様の手順で設定を行い、お好きなパラメータをペダルで操作してください。 

ヒント: ピッチベンドを足でワイルドにコントロールすることをお望みの場合、ペダルで GearBox の “Bender 
Position” ノブをコントロールするよう設定します。Line 6 FBV Control アプリケーションの “Control Properties” で、
ペダル設定の 1 つに対して、“MIDI Command” を “MIDI CC” に、“Value” を “CC 79” に設定してください。GearBox 
では、エフェクト音のみが聞こえるように、ベンダー エフェクトの “Mix” ノブを “100%” に設定しましょう。そして 
“Heel” と “Toe” ノブに任意のピッチ チェンジ量（半音単位）を設定し...さあ、ペダルで「ワーミー」しましょう！

http://line6.com/manuals/footcontrollers/
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フットスイッチの設定 : アンプ、エフェクトの オン/オフ
すでに「GearBox.fbv」プリセットにより、GearBox のアンプとエフェクトの各アイテムは、オン/オフが「切り替わる」ように
設定されていますが、スイッチの割り当てを変更する場合、PDF 書類「Line 6 MIDI Continuous Controller Reference」
の「GearBox MIDI CC Chart」をご参照ください。GearBox の目的のエフェクト パラメータを確認します。例えば、ラベル 
“C” の FBV フットスイッチで GearBox の Delay エフェクトをオン/オフするとしましょう。「GearBox MIDI CC Chart」を見
ると、「CC #28」が割り当てられています: 

「Notes」の欄に注目してください。CC の値「0-63」によって Delay が「Off」、値「64-127」によって Delay が「On」に設定さ
れることが分かります。けれども、これらの CC の値を手動で入力する必要はありません。FBV フットスイッチ コントロー
ルの “Switch Mode” に “Toggle” を設定すると同時に自動的に入力されます。これにより、フットスイッチを踏むごとに、
MIDI メッセージ 「127」（オン）と 「0」（オフ）の値が交互に送信されます。以下、“C” ボタンのコントロールに関して、FBV 
Control アプリケーションの “Control Properties” リストで設定すべき項目をまとめます:

• MIDI Command: “MIDI CC”

• Value: “CC# 028”

• MIDI Port: “1”（ここでは任意のポートを選択して構いませんが、コマンドを受信するためには、GearBox の 
“MIDI In” 設定も同じである必要があります。 「接続しましょう！」（ 5•1 ）もご参照ください。）

• MIDI Channel: “1”（GearBox は、チャンネル 1 でのみ MIDI を受信します。）

• Switch Mode: “Toggle”

フットスイッチの設定 : GearBox の Player トランスポートをコントロール
GearBox の Player モジュールを使用すると、CD やコンピュータのハード ドライブのオーディオ ファイルをロードして
再生したり、GuitarPort オンライン メンバーシップのレッスンやトラックを再生することができます。ギターから手を離さ
ずに Player とジャムセッションすることをお望みなら、FBV フットスイッチに Player のトランスポートの各オプション、す
なわち、 Rewind（巻き戻し）、Play（再生）、Stop（停止）、Fast Forward（早送り）を割り当てましょう。“MIDI Command” を 
“Mackie” に設定し、“Value” には任意の機能を選択します:

お疲れさまでした！ FBV と GearBox の連携についての説明はここまでです。一旦マウスから手を離して、しばらく音楽に
没頭してください！
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FBV™ MkII と サードパーティーのソフトウェア
機 材 の 接 続 を 済 ま せ 、電 源 を オ ン に し た ら（ ま だ の 方 は 、「 は じ め に 」（  1 • 1  ）の 章 を ご 参
照 くだ さ い ）、F B V  S h o r t b o a r d ™  M k I I  ま た は  F B V  E x p r e s s ™  M k I I  デ バ イ ス  に お 気 に
入 り の  ソ フ ト ウ ェ ア  ア プ リ ケ ー シ ョ ン を 遠 隔 操 作 さ せ る こ と に 取 り か か り ま し ょ う！ 
ここでは、FBV MkII デバイスに反応する MIDI と DAW ソフトウェア アプリケーションの設定方法に関する有用なヒント
や例もご紹介します。

USB MIDI ポートとチャンネルについて
Mac® または Windows® コンピュータの USB ポートと FBV MkII デバイスの接続が確立すると、USB MIDI 入力ポートが 
1 つ、USB MIDI 出力ポートが 4 つ有効になります。これらは煩わしい MIDI ケーブルを必要とする「物理的な」ポートと
は異なります。FBV はすべての MIDI データを USB ケーブル経由でソフトウェアの「架空の」 MIDI ポートに送信します。

FBV MkII デバイスは MIDI 情報を受信するために、FBV の MIDI 入力ポートを使用します。そしてこの主要な機能は、
Line 6 Monkey と FBV Control アプリケーションとの交信にあります。通常、FBV を使用するのは MIDI コマンドを送信
させるためであり、そのためには MIDI 出力ポートを使用するので、この MIDI 入力ポートを他のソフトウェアで使用する
ことはありません。コンピュータからは、MIDI 交信に対応するソフトウェアの「オプション」または「初期設定」などのダイ
アログで、これらの FBV MIDI ポートにアクセスできるでしょう。

Windows® MIDI ポートでの交信
ご注意ください。Windows® 7,  Vista® と XPでは、FBV MkII デバイスに Windows® USB Class Compliant ドライバを使
用しますが、これは、同一の USB MIDI ポートを複数のアプリケーションで同時に使用することを許可しません。起動し
ている Line 6 FBV Control アプリケーションは FBV の MIDI 入力ポートと MIDI 出力ポート 「4」を使用して FBV デバイ
スと交信します。従って、同じ Windows® コンピュータで、同じ FBV MIDI ポートを使用する他の MIDI/DAW ソフトウェ
ア アプリケーションが同時に起動している場合、どちらか 1 つのアプリケーションのみが、そのポートを使用できます。 

すでに MIDI/DAW ソフトウェアを起動している場合、そして FBV の MIDI 入力ポートを使用している場合、Line 6 FBV 
Control アプリケーションを起動しようとすると、おそらく FBV Control アプリケーションは接続された FBV デバイスの
検知に失敗するでしょう。何故なら、これはすでに他のソフトウェアによって使用中であるからです。1 つの解決策として
は、MIDI/DAW ソフトウェアで FBV の MIDI 入力ポートと FBV MIDI 出力ポート「4」の使用を無効にし、FBV Control ア
プリケーションのために解放することです（MIDI/DAW ソフトウェアの FBV MIDI 出力ポート「1 から 3」はそのまま有効
にしておいて構いません。これにより、FBV からソフトウェアに MIDI コントロール コマンドを送信可能です）。あるいは、
FBV Control ソフトウェアを使用する際に他のすべての MIDI/DAW アプリケーションを終了してください。この場合、
FBV コントロール設定の編集時、すべての MIDI ポートが FBV Control ソフトウェアにアクセスします。

ノート: Line 6 Monkey アプリケーションも、接続された FBV デバイスを検知し、更新する際に FBV MIDI ポートを使用
します。Line 6 Monkey を起動する場合、常に前もって Line 6 FBV Control アプリケーション、そして他の MIDI/DAW 
ソフトウェアを終了することを強くお勧めします。

ソフトウェアの設定 : FBV MkII からの MIDI を受信する
一般的に、MIDI/DAW アプリケーションの “Preferences” または “MIDI Options” などのダイアログには、FBV MkII デバ
イスや FBV USB MIDI ポートを選択するオプションが用意されています。これを選択することにより、アプリケーションは 
FBV デバイスからのコマンドを受信できるようになります。これらのオプションの仕様はお使いの MIDI/DAW ソフトウェ
アによって異なります...
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コントロール サーフェスのオプション
いくつかのアプリケーションは「コントロール サーフェス」や「MIDI コントローラー デバイス」に特化したオプションを用
意しています（ここで接続デバイスを 1 台、または複数台選択できます）。まず、ご使用のソフトウェアにこの種のオプショ
ンがあるかどうかチェックしてみてください。接続された FBV MkII デバイスには 4 つの選択肢があるはずです（MIDI 出
力ポートごとに 1 つ）。コンピュータの OS により、表示される FBV MkII の MIDI 出力ポートの名称が異なることにご注
意ください（FBV Express MkII の場合、“Shortboard” の代わりに “Express” と表示されます）:

Mac OS® X Windows ®7 / Vista® Windows® XP

MIDI 出力ポート 1 FBV Shortboard Mk II（Port 1） FBV Shortboard Mk II USB Audio デバイス

MIDI 出力ポート 2 FBV Shortboard Mk II（Port 2） MIDIIN2 FBV Shortboard Mk II USB Audio デバイス [2]

MIDI 出力ポート 3 FBV Shortboard Mk II（Port 3） MIDIIN3 FBV Shortboard Mk II USB Audio デバイス [3]

MIDI 出力ポート 4 FBV Shortboard Mk II（Port 4） MIDIIN4 FBV Shortboard Mk II USB Audio デバイス [4]

MIDI 入力ポート 1 FBV Shortboard Mk II（Port 1） FBV Shortboard Mk II USB Audio デバイス

 

ヒント:  「Ableton Live - FBV MkII : セットアップのチュートリアル」（ 6•4 ） の図をご参照ください。Live の “Preferences” 
ダイアログ内で FBV MkII が選択可能な MIDI コントローラーとして表示されています。

Line 6 FBV Control アプリケーションの “Control Properties” リストで、FBV コントロールの割り当てに使用した FBV 
MIDI 出力ポートを選択してください。デフォルトでは、FBV MkII のすべてのコントロールの割り当ては FBV の MIDI 出
力ポート「1」へ送信されるように設定されていますが、この MIDI 出力ポート設定は “Control Properties” リストでコント
ロールごとに変更しても構いません（ 3•2 ページ を参照）。

ノート: どの MIDI/DAW ソフトウェアであっても、FBV の MIDI 入力ポートを選択する必要はありません。何故なら、ソ
フトウェアから FBV デバイスに MIDI をフィードバックする必要はにないからです（Line 6 FBV Control と Monkey ア
プリケーションは FBV の MIDI 入力を使用して交信しますが、そのための設定は不要です）。

多くの場合、以上で設定は完了です。MIDI/DAW ソフトウェアは FBV の MIDI コマンドを受信するはずです。けれども、
いくつかのアプリケーションには、適切な交信を実現するため、ブランドや MIDI コントローラー デバイスの種類を選
択するオプションが追加されています。このような追加オプションがあるアプリケーションの場合、オプションを探して 
“generic controller device”（一般的なコントローラー デバイス）などを選択してください。また、いくつかのアプリケー
ションでは、MIDI デバイスのポートの名称を「分かりやすいものに」変更できます。詳細は、お使いの MIDI ソフトウェア
の取扱説明書でご確認ください。以下の章もご参照ください。主要なアプリケーションでの例を示しています。

MIDI インプットのオプション
MIDI/DAW アプリケーションによっては、「コントロール サーフェス」や「MIDI コントローラー デバイス」に特化した
オプションを持たず、初期設定や MIDI 設定に「MIDI インプット」のようなセクションだけがあるだけかもしれません。 
MIDI/DAW ソフトウェアのマニュアルで、このセクションを使って MIDI コントローラー デバイスを選択するように指
示されている場合、Line 6 FBV Control アプリケーションの “Control Properties” リストで、FBV コントロールの割り
当てに使用した FBV MIDI 出力ポートを選択してください。デフォルトでは、FBV MkII のすべてのコントロールの割り
当ては FBV の MIDI 出力ポート「1」へ送信されるように設定されていますが、この MIDI 出力ポート設定は “Control 
Properties” リストでコントロールごとに変更しても構いません（ 3•2 ページ を参照）。
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MIDI チャンネル
各 USB MIDI ポートが 16 の MIDI チャンネルを扱っています。デフォルトの場合、FBV MkII デバイスは、自身の MIDI 
データを、各コントロールで選択された MIDI ポートのチャンネル「1」に送信するように設定されています。しかしなが
ら、どの FBV コントロールでも、それぞれの MIDI コントロール データをお好きな MIDI チャンネルに送信するように設
定できます（ 3•2 ページ の 「“Control Propertiest” リスト」の項をご参照ください）。

お使いのソフトウェアに、選択 MIDI ポートから特定の MIDI チャンネルを 1 つ選択するオプションがある場合、そのよう
な「MIDI チャンネルの選択」と「FBV のコントロールが送信するチャンネル」を合致させてください。FBV MkII コントロー
ラーが自身のすべての MIDI コマンドを 1 つの共通 MIDI ポートから送信するように設定した上で、個別のコントロール
は異なるチャンネルに送信するように設定すると、MIDI/DAW ソフトウェアは「フィルタリング」をして、求められるコマン
ドのみを受信できるようになります。MIDI チャンネルのオプションに関してはソフトウェアの説明書でご確認ください。

MIDI 学習機能
MIDI/DAW ソフトウェア アプリケーションの多くは、外部 MIDI コントローラーを簡単に使用できるように、「MIDI 学習
機能」（MIDI Learn 機能）を装備しています。例えば、あるソフトウェアでは...まず「学習モード」を設定し、目的のパラ
メータ（ノブ/スライダー/スイッチなど）をソフトウェアの GUI 画面でクリックして選択してから、FBV MkII デバイスでコ
ントロールを操作すると、ソフトウェアは FBV の操作されたスイッチ/ペダルと選択パラメータを直ちにマップします。
Propellerhead Reason と Ableton Live アプリケーションは、まさにこのタイプの機能を用意しています。トランスポート 
ボタン、トラック オプション、シンセやエフェクトのパラメータまでを含む、ほとんどのパラメータに有効です！

アプリケーションの「MIDI 学習機能」を使用する場合、FBV MkII のフットスイッチとペダルに MIDI コマンドが適切に
アサインされていることをご確認ください。さもないと、ターゲットであるソフトウェアは何も学習できません。この種の 
MIDI 学習機能の利点は、通常、任意の “Value” の MIDI CC コマンドを送信するようにコントローラーを設定するだけ
で済むことです。学習モードのソフトウェアは、単に何かの受信を待ち、そして受信により学習します。ただし、アプリケー
ションのパラメータによっては、特定の「スイッチ タイプ（“Single”、“Toggle” または “Momentary”）の設定」が要求され
る場合もあります。MIDI 学習機能の詳細に関しては、お使いの MIDI/DAW ソフトウェアのマニュアルでご確認ください

（機能の呼び方は異なるかもしれません）。この章、これ以降には、主要な DAW アプリケーションのチュートリアルが用
意されています。役立つ例が紹介されているので、参考にしてください！

MIDI 学習機能を備えたソフトウェアで使用する場合、FBV MkII の各コントロールが別の MIDI CC コマンドを送信する
ように設定しても構いません。ソフトウェアはこの FBV とのやり取りを利用します。これらの設定を構成するには、Line 
6 FBV Control アプリケーションの “Control Properties” リストのセクションのオプションを使用します（ 3•2 ページ を参
照）。あるいは、土台として用意された付属プリセット “FBV-Default.fbv” をロードしてお試しください。必要に応じてカス
タマイズすることも可能です。

MIDI コントロールを手動でアサインする
「MIDI 学習機能」を装備していないアプリケーションの場合、設定のプロセスは、より手作業に負うものとなります。 
ソフトウェア内の各パラメータに対してどのような MIDI コマンドと値が設定されているかを細かくリストにしている  
MIDI リファレンスの書類をソフトウェアの開発元から入手する必要があるかもしれません。多くの場合、アプリケーショ
ンはパラメータに MIDI CC コマンドを使用し、パッチの切り替えにはバンク/プログラム チェンジ コマンドを使用してい
ます。トランスポートのボタンには、MMC または Mackie コマンドが使用される場合もあります。MIDI リファレンスの書
類を手に、Line 6 FBV Control アプリケーションを使用して、FBV の任意のフットスイッチ/ペダル コントロールがソフト
ウェアの目的のパラメータをトリガーするようにアサインしてください。

MIDI コントロールをセットアップする方法、必要となる MIDI コマンドの割り当てなどに関しては、アプリケーションに
よって異なるため、お使いの MIDI/DAW ソフトウェアに付属のマニュアルをご覧ください。
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Ableton Live - FBV MkII : セットアップのチュートリアル
このチュートリアルは、FBV Shortboard または Express MkII デバイスを使用して、人気の高い Ableton Live® ソフトウェ
アのいくつかの異なるリモート機能をコントロールする方法（ソフトウェアの設定）を一手ごとに記しています。ここでは 
Ableton Live のバージョン 8 を例にしていますが、最近のバージョン（他の Line 6 ギアに同梱の Live Lite Line バージョ
ン 6 を含む）であれば手順はそれほど違わないでしょう。Ableton はデモ版の Live も提供しています（ www.ableton.

com/downloads から無償でダウンロード可）。興味がある方はお試しください。このチュートリアルは他の MIDI/DAW 
ソフトウェアを FBV MkII コントローラー用にセットアップする場合にも多いに参考になると思われますが（基本的な
部分）、MIDI のオプションや機能に関しては、ある程度の差異があるでしょう。細かい部分はお使いのソフトウェアのマ
ニュアルでご確認ください！

ノート: 以下の手順は Mac® でのものですが、特に注意書きのない限り、Windows® XP, Windows® 7 または Vista® 
にも当てはまります。

FBV のコントロールの割り当てを構成する
Ableton Live を起動する前に行うべき最初の手順は、FBV デバイスの各フットスイッチとペダルにそれぞれ MIDI を割
り当てたセットを 1 組構成することです。Ableton Live は他の DAW アプリケーション同様、多くの場合、MIDI CC コマン
ドを使用して自身のパラメータにアクセスします。これを踏まえ、このチュートリアルは、Line 6 FBV Control アプリケー
ションを使用して MIDI CC コマンドを FBV フットスイッチとペダルにアサインするところから始まり、それを FBV プリ
セットとして保存して...と進みます。さて、準備はよろしいでしょうか？

• FBV MkII デバイスをコンピュータに接続し、Line 6 FBV Control アプリケーションを起動します。 

• File > Open を選択し、「Blank.fbv」プリセットをロードします。

• File > Save As を選択し、これを新規プリセット「Live.fbv」として保存します。

Ableton Live は MIDI コントロール デバイスの使用に便利な「MIDI 学習機能」を装備しています（詳細は、「MIDI 学習
機能」（ 6•3 ） を参照してください）。従って実際には、各コントロールがそれぞれ異なる CC ナンバーで値を送信する限り、
各コントロールにどの MIDI CC ナンバー（Value）をアサインしても問題とはなりません。 

ここでは、FBV のいくつかのコントロールを次のように設定します（デバイスは FBV Shortboard でも Express MkII でも
手順に違いはありません）:

• “A”、“B”、“C”、“D” のフットスイッチ コントロールが、それぞれ MIDI CC の “001” から “004” までを使用するように
設定します。

• “A”、“B”、“C”、“D” のコントロールの “Switch Mode” を “Single” に設定します。これにより、フットスイッチを踏む
ごとに、同じ MIDI CC コマンドが 1 つ送信されます。

• “Pedal Wah” と “Pedal Vol” コントロールは、 それぞれ MIDI CC の “005” と “006” を使用するように設定します。

• 以上のコントロールのポートとチャンネルはすべて “1” に設定します。これにより、すべての MIDI コマンドは FBV 
USB MIDI 出力ポート「1」のチャンネル「1」に送信されます。

• FBV のその他のコントロールについては “Unassigned” のままにしておきます。この例では使用しません。

結果として、“Control Properties” リストは以下のようになります:

http://www.ableton.com/downloads
http://www.ableton.com/downloads


FBV MkII Advanced User Guide:   サードパーティのソフトウェア

6•5

以上の設定が済んだら、File > Save を選択してプリセットを保存し、FBV Control アプリケーションを終了します。

Ableton Live : MIDI インプット デバイスの設定
次に、FBV コントローラー デバイスからの MIDI コマンドを受信するようにAbleton Live を設定します...

Ableton Live ソフトウェアを起動し、Ableton Live > Preferences > MIDI/Sync ページ（Mac®）または Options > 
Preferences > MIDI/Sync ページ （Windows®）と進んでください。ここで Live は自動的に FBV MIDI 出力ポートの 4 
つすべてを検知します。他のデバイスの MIDI ポートも表示されているかもしれません（コンピュータに他の MIDI ハード
ウェア/ソフトウェアがインストールされている場合）。

Mac OS® X, Windows® XP, Windows® 7 または Vista® により、これらのポートの表示名は異なります。

• 最初の FBV MIDI 出力ポートの列、一番右の “Remote” ボタンをクリックして “On” にしてください。“Track”、
“Sync”、“Remote” の欄で、その他にアクティブな “On” ボタンがある場合、選択を解除して “Off” にしてください

（下のスクリーン ショットを参照）。この設定により、Ableton は FBV の MIDI 出力ポート「1」からの MIDI コント
ロール コマンドを受信します。

最初の FBV ポートを “ON”
にして、“Track”、“Sync”、
“Remote” のその他のボタン
は “OFF” にしてください。

Live に有効な “Inputs” とし
て FBV MIDI 出力ポートの 4 
つすべてが表示されていま
す。

Mac OS®  X
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Windows®  XP Windows®  7 / Windows  Vista®

Windows® XP と Windows® 7 / Vista® の場合も同様ですが、 FBV ポートの表示名が異なります。

• 次に、このダイアログの最上部の “Input” 欄で同じ “FBV Port 1” デバイスを選択します。この設定により、Live は 
FBV を MIDI コントローラーのインプット デバイスとして使用します。繰り返しになりますが、FBV ポートの表示
名は OS により異なります（上の図、Mac® と Windows® を参照）。“Input” 欄では、単にリストの最初の FBV USB 
MIDI ポートを選んでください:

“Input” 欄では、最初の FBV ポート
を選んでください。Live が FBV から
の MIDI コントロール データのみ
を受信するよう、その他の “Control 
Surface”、“Input” と “Output” はすべ
て “None” にしてください。

• “Preferences” ダイアログを閉じます。これで MIDI インプット デバイスの設定は完了です。

FBV のコントロールをマップする
次に必要な手順は、FBV のコントロールを Live のいくつかの機能に「マップ」することです。Live ではこの作業を「マニュ
アル マッピング」と呼んでいます。ここで、Live の 「MIDI マップ アサイン モード」（一般的アプリケーションの「MIDI 学習
機能」）にアクセスする必要があります。

• MIDI マップ アサイン モードに入るには、Live 画面右上の “MIDI” ボタンをクリックしてください:

 

• 次のスクリーン ショットのように、Live のコントロールの多くが青く強調表示されます（Live での設定やバージョ
ンによって強調表示色が異なる場合もあります）。これらの強調表示は、そのコントロールが「マップ可能」（つま
り、遠隔操作可能）であることを表しています。
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• 強調表示されたコントロールにマップを行います。コントロールの 1 つをクリックすると Live は MIDI コマンドの
受信を待機します。ここでは Live トランスポート機能の再生、停止、録音ボタンに FBV のそれぞれ “A”、“B”、“C” 
のフットスイッチをマップすることにしましょう...

Live のソフトウェア画面の最上部で再生トランスポートボタンをクリックします。

Live 画面下部に、「MIDI コントローラーメッセージの受信を待っています
（動かしてください）」という意味のテキストが表示されます。

FBV のフットスイッチ “A” を踏んでください。今度は「メッセージは受信されました（マップされました）」というテキスト
が表示されます。これで再生ボタンのマップは終了です。このまま、“Absolute”のモードを続けてください。 

この時、再生ボタンの上に重なって “1/1” と表示されます。ボタンが MIDI チャンネル「1」に、そして MIDI CC が「#1」に
アサインされたことを意味しています。これはもちろん、すでに FBV のスイッチ “A” に設定したものと同一です。

MIDI マップ アサイン モードのまま、停止ボタンと録音ボタンにも同様の手順を繰り返し、FBV の “B” と “C” スイッチを
これらにマップしてください。マップを済ませると、トランスポート ボタンの上に重なるマップ表示は以下のようになる
はずです:
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Live の MIDI Mappings パネルを開くと、これら作成したばかりのマッピングが示されます。削除したいものがある場
合、このリストでマッピングを選択し、コンピュータのキーボードで [Delete] キーをタイプしてください。

• Live 画面右上の “MIDI” ボタンを再度クリックして、MIDI マップ アサイン モードを終了します。FBV の “A”、“B”、
“C” のフットスイッチを踏んで試してみましょう。Live の トランスポートが適切に応答するはずです！ お望みであ
れば、 FBV の “D” スイッチにも手順を繰り返し、他の任意の「スイッチ タイプ」のボタンにマップしてください。

ノート: Ableton Live のトランスポート設計では、再生と停止ボタンが独立したものとされています。これらはそれぞ
れ、MIDI CC の “Single” スイッチ モードに反応します。他のアプリケーションのトランスポートでは、これらがまとめて
二重機能の「再生/停止」ボタンとされていることもありますが、その場合、2 つの機能を交互にトリガーするには、FBV 
Control アプリケーションを開き、FBV のコントロールの MIDI CC “Switch Mode” を “Toggle” に設定してください。ま
た、いくつかのアプリケーションのトランスポート機能は、MIDI CC コマンドではなく、MMC または Mackie タイプのコ
マンドに対応しています。詳細はソフトウェアのマニュアルでご確認ください。

ここで重要なのですが、任意の 1 つの FBV コントロールを、ターゲットであるMIDI/DAW ソフトウェアの複数のパラメー
タにマップすることが許されています。つまり、望むと望まないに関わらず、マップされたすべてのパラメータは FBV で
同時にコントロールされます。この仕組みを利用し、FBV フットスイッチの 1 つに、Live の 再生と録音の両方をマップす
ると、「ワンプッシュ」で両機能が同時に切り替わり、レコーディングにとても便利です。

FBV のペダル コントロールを Live のパラメータにマップする
次に、FBV のペダル コントロールをマップしましょう。FBV の “Pedal Wah” と “Pedal Volume” コントロールは、それぞ
れ連続的な MIDI CC の値を送信します。Live のエフェクトのノブやスライダーなど、範囲を持つパラメータにマップする
と、パラメータをリアルタイムでコントロールできます。ここでは、FBV の “Pedal Wah” コントロールに Live の Chorus エ
フェクトの “Dry/Wet” パラメータをマップすることにします。コーラス エフェクトのドライ/ウェット バランスをリアルタイ
ムで調整できるようになります。また、FBV のペダルを使ってリアルタイムにパラメータのオートメーションを書き込むこ
とも可能です。さらに...これ以上については後述しましょう。

• FBV デバイスを眺め、“Wah” の LED が点灯していること、つまり、オンボードのペダルが “Wah” に設定されてい
ることを確認します。消灯している場合、ペダルをフルに踏み込んでトゥ スイッチを作動させてください。

• Ableton Live では、まず、オーディオ トラックに録音するかオーディオ ファイルをロードし、エフェクトの効果を確
認できる状態にします。

• このオーディオ トラックにコーラスをインサート エフェクトとしてロードします。Live Devices  パネルで 
Effects>Chorus>Chorus を選択し、このコーラス エフェクトをオーディオ トラックの最上部にドラッグしてイン

サートしてください。 
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このコーラス エフェクトをオーディオトラッ
クにドラッグしてインサートします。

• Live 画面下部のエフェクト パネルにコーラス エフェクトのモジュールが表示されます。ここで Live を MIDI マッ
プ アサイン モード（この項の最初で説明しています）に設定します。MIDI マップ アサイン モードに入ると、コーラ
ス エフェクトのパラメータが強調表示となり、マップ可能であることが示されます:

• このコーラスの “Dry/Wet” ノブにマップします。ノブをクリックしてください。Live は MIDI コントロール コマンド
の受信を待機します。Live の画面下部に「マップ完了」を意味するテキストが表示されるまで、FBV ペダルを動か
してください:

この “Dry/Wet” ノブをクリックします。

ここにテキストが表示されます。この図では「マップするコント
ロールを動かしてください」と表示されています。

新たにマップされた MIDI チャンネル/CC が表示されます。

テキストはマップの詳細を示します。

• FBV の “Pedal Wah” コントロールは MIDI CC 「#5」を送信するよう設定してあります。Live の コーラスの “Dry/
Wet” ノブは「チャンネル 1、CC #5」にマップされ、そのことをノブに重ねて表示します。
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Live の MIDI マップ アサイン モードを終了し、動作を確かめてみましょう。FBV のペダルを動かすとコーラスの “Dry/
Wet” ノブが反応するはずです！ 今度はご自身で設定してみてください。FBV ペダルを切り替え、“VOL” LED を点灯さ
せ、“Pedal Volume” コントロールを設定したら、上記手順に倣って、異なるエフェクト パラメータをマップしてみましょ
う。ペダルのトゥ スイッチを作動させることにより、“Pedal Wah” と “Pedal Volume” コントロールに設定した 2 つのマッ
プを切り替えて使用することが可能になります。

FBV Shortboard MkII ユーザーの方へ: オプションの Expression Pedal を接続している場合、上記の手順で他のパラ
メータをマップすることができます！

AU/VST のエフェクト パラメータにマップする
他の DAW ソフトウェアと同様、Ableton Live においても、FBV フットスイッチとペダルのコントロールを Live のパラ
メータ以外のものにマップできます。サードパーティの AU または VST プラグインをソフトウェアに起動した場合、プラ
グインのパラメータにマップすることも可能です。この例では、FBV の “Pedal Wah” コントロールを Line 6 POD Farm プ
ラグインの “Wah Position” パラメータにマップすることにします。FBV ペダルを踏んで POD Farm の Wah エフェクトを
リアルタイムでコントロールすることが可能になります！ お手持ちの Line 6 POD GearBox プラグインやサードパーティ
の AU/VST プラグイン エフェクトの場合でも、その手順は同様となります。

• “WAH” LED が点灯するように FBV のオンボードのペダルを切り替えます。“Pedal Wah” コントロールを使用する
ことになります。

• Ableton Live では、オーディオ トラックに録音するかオーディオ ファイルをロードします。この例の場合、クリーン
なリズムギターだとベストです。下は Live の “Arrangement View” 画面です:

• Live の “Plug-In Devices” ブラウザパネルでプラグインを選択し、それをオーディオ トラックの上部にドロップし
てください:

• Live の下部のパネルにエフェクト モジュールがロードされたことを確認できます。このエフェクト モジュールの
左上の小さな矢印マークをクリックすると、モジュールは展開して “Configure” オプションが表示されるようにな
ります。これを使用すると、プラグインのエディット ウインドウからパラメータを追加してエフェクト モジュールの
ディスプレイからアクセスできるようになります。
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“Configure” ボタンをクリックして POD 
Farm のプラグイン パラメータをこのモ
ジュールに追加します。

この矢印をクリックしてエフェクト モジュー
ルを展開します...

POD Farm のプラグイン ウインドウです。Wah 
エディット パネルの Position ノブを直接クリック
し、このパラメータを選択します。

プラグイン パラメータを選択すると、エフェクト モジュールに
パラメータ用のスライダーが追加されます。

• 前記手順で Live の MIDI マップ アサイン モードに入ります。エフェクト モジュールでパラメータをクリックし、
FBV ペダルを動かしてマップします。下図では、FBV ペダルのチャンネル「1」、MIDI CC 「5」が “Wah Position” の
パラメータに適切にマップされたことが示されています。MIDI マップ アサイン モードを終了してください。

さあ、Live を走らせ、 FBV ペダルを動かしてみましょう！ マップされたエフェクト パラメータが適切に機能していることを
耳でご確認ください。エフェクト自身のウインドウでは、選択したパラメータのコントロールがペダル操作に反応して動
いているかもしれません。この例、POD Farm プラグインの Wah Position ノブの場合は反応します。マップの機能はこ
れだけではありません。読み進んで頂ければ、さらに楽しい世界が開けるでしょう！
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FBV のペダルを使用してコントロールのオートメーションをレコーディング
多くの DAW ソフトウェアでは、パラメータに FBV ペダルがマップされている場合、ペダルの動きを、トラックのオート
メーション エンベロープとしてリアルタイムに「レコーディング」することが可能です。ちょうど適切な例として、さきほど
作成した POD Farm プラグインの Wah パラメータのマップを利用しましょう。FBV Wah ペダルの動きを記録して、ギ
ター トラックにワウの効果を追加します。この例で基本的な仕組みは把握できると思われますが、トラックやエフェクト 
オートメーションの詳細は DAW アプリケーションによって異なるので、お使いの DAW ソフトウェアのマニュアルでご
確認ください。POD Farm プラグインの Wah パラメータ（あるいは任意のプラグイン パラメータ）に FBV ペダルがマッ
プされていることを確認し、以下の手順に進んでください...

• Live の “Arrangement View” で、オーディオ トラックが録音不可に設定されていることを確認します（私達はこ
れからオーディオを録音するのではなく、オートメーションのみを録音するためです）。また、POD Farm プラグイ
ンの Wah パラメータがトラックに表示されていることもご確認ください。ここで FBV のペダルを動かすと、トラッ
クを横断する既存のエンベロープの水平ラインが動きに合わせて上下します。

POD Farm プラグインの “Wah Position” パラメータのマップを済ませると、Live のオーディオ トラックは、こ
のパラメータをオートメーション セレクタに表示し、トラックには横断するエンベロープのライン（未編集）を
表示します。FBV ペダルを動かすと、エンベロープのラインが応答します。

以下の手順では、録音ボタンをオフにしておきます。

• トラックの最初まで巻き戻し、Live のメインのトランスポートで録音ボタン、再生ボタンを順にクリックしてくださ
い。Live が走り出したら、思いのままに FBV ペダルを踏んで Wah ペダルによるオートメーションをトラックに記
録します。エンベロープに「エディット ポイント」が次 と々追加され、ペダルの動きがキャプチャーされて行きます:

• Live を停止し、トラックを再生してみましょう。Wah ペダルの操作がリアルタイムでキャプチャーされたことを耳
で確認できます。このテイクにはご不満ですか？ アンドゥしてもう一度トライするか、あるいはエンベロープに
ズームインし、マウスを使って手動でエディット ポイントを修正して、最高のワウに仕上げてください。
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Apple GarageBand® - FBV MkII : セットアップのチュートリアル
Apple GarageBand では、ソフトウェアのパラメータの多くを独自のプロトコルでコントロールしているため、残念な
がら FBV MkII MIDI コントローラーで GarageBand の全機能に直接アクセスすることはできません。けれども、現在の 
GarageBand のトラックのボリュームとパンのパラメータをペダルに割り当ててコントロールすることは可能です。また、
サードパーティのソフトウェア ユーティリティーを Mac® をインストールすると、FBV フットスイッチのボタンを使用して 
GarageBand のトランスポート機能をコントロールすることができるようになります。 

FBV ペダルを設定するため、Line 6 FBV Control アプリケーションを起動し、“FBV-Default.fbv” プリセットを開きます...

• ペダルの Wah コントローラーの “Value” を “CC 010” に設定します。

• ペダルの Vol コントローラー設定はそのままで変更しません（MIDI “CC 007”）。

• ペダルからの送信には FBV USB MIDI 出力ポート「1」を使用することにご注意ください。  
設定は以下のようになります:

ここで、GarageBand を起動して任意のソングをロードします。FBV ペダルを動かすと、トラックのボリューム（ペダルが 
“Volume” に設定されている場合）、またはパン（ペダルが “Wah” に設定されている場合）が調整されます。Shortboard 
をご使用で、オプションの Expression Pedal を接続している場合、そのペダル（“Pedal 2”）に “MIDI CC” と “Value 010” 
を設定すると、2 つのペダルをそれぞれボリューム、パン専用で使用することもできます。

FBV で GarageBand のトランスポート機能をコントロールする場合、Garageband のバージョン 2.0.1 以降が条件とな
ります。そして Line 6 FBV Control アプリケーションを開き、GarageBand のトランスポートに使用する任意の FBV フッ
トスイッチに MIDI CC の値を送信させるようして、スイッチ タイプに “Momentary” を設定する必要があります。すでに
触れた通り、Garageband ソフトウェアはネイティブでトランスポートや他の多くの機能のコントロールを提供していま
せん。従って、MIDI メッセージで GarageBand のパラメータをコントロールする場合、アドオンのソフトウェアをダウン
ロードしてください。

GarageRemote はそのようなサードパーティのソフトウェアの 1 つです。以下からダウンロードできます:  
http://www.muratnkonar.com/otherstuff/garageremote/

GarageRemote をインストールしてセットアップを済ませ、GarageRemote の “Listener” （デフォルトでオフ）を開始す
ると MIDI メッセージを GarageBand にリレーすることが機能になります。

GarageBand は MIDI CC の「007」と「010」に反応します（現在のトラックのボリュームとパン）。Line 6 FBV Control アプ
リケーションを使用して、これらの MIDI CC 設定を行い、FBV プリセットとして保存すると、いつでもこの設定を FBV に
ロードできます。

http://www.muratnkonar.com/otherstuff/garageremote/
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Apple Logic® - FBV MkII : セットアップのチュートリアル 
Line 6 FBV MkII デバイスのフットスイッチとペダル コントローラーに設定を行うと、Logic のトランスポート機能、ミキ
サー フェーダー、ソフトウェア インストゥルメントとプラグインのパラメータ、そしてその他をトリガーすることが可能で
す。ここでは、FBV MkII を Logic Pro 8 で機能させるための設定手順を説明します（Logic の最近のバージョンであれば
手順はそれほど違いません）。

Line 6 FBV Control アプリケーションでの設定
まず、Line 6 FBV Control アプリケーションを起動して「FBV-Default.fbv」プリセットをロードします: 

• 上図は、FBV Shortboard MkII 用の「FBV-Default」プリセットの設定です。FBV Express MkII の場合は、“A”、“B”、
“C”、“D” のフットスイッチとペダルの列のみが表示されます。このプリセットにより、デバイスの MIDI コントロー
ラーのすべてに MIDI コマンドが設定され、これらを Logic でマップすることができます。 

• いくつかのフットスイッチ コントローラー（“B”、“C”、“D”、その他）は、MMC（MIDI Machine Control）コマンドを送
信するように設定されていることにご注目ください。これらは Logic のトランスポートをコントロールするように
マップできます。また、お望みなら、他のフットスイッチ コントローラーに任意の MMC メッセージを送信させるよ
うに設定し、それらの各フットスイッチで Logic のトランスポートをコントロールすることも可能です。

• FBV Control アプリケーションで変更を行った場合は、File > Save As を選択して、「Logic.fbv」など分かりやす
い名称を与え、新規プリセットとして保存しましょう。 

Logic の MIDI 学習機能でコントローラーをマップする
Logic Pro は、いくつかの MIDI 「コントロール サーフェス」デバイスに対応しています。コントロール サーフェスは、典
型的には大きな筐体のハードウェアで、フェーダーやノブ、その他のコントロールを装備し、アナログのミキシング コン
ソールをエミュレートするものです。Line 6 FBV MkII は Logic がサポートするコントロール サーフェスのリストから外れ
ていますが、Logic の MIDI 学習機能により、FBV の任意のコントローラーを Logic（または Logic 内のプラグイン パラ
メータ）に簡単にマップできます。ここでは、Logic にインサートされた POD Farm AU プラグインの “Wah Position” パラ
メータを FBV ペダル でコントロールするためのマッピングについて説明しています。FBV MkII デバイスの他のペダル 
または フットスイッチ コントローラーを Logic の他のパラメータにマップする場合も手順は同様です。Logicの MIDI 学
習機能とコントローラー機能に関しては、Logic の説明書内のコントロール サーフェスに関する記述もお読みください。

最初に、役立つヒントを... Logic Pro のトランスポートは、常に MIDI データの受信状況、そして MIDI チャンネル、コマン
ド タイプと数値を表示します。例えば、トランスポートのインジケーターに注視しながら、FBV でペダルかフットスイッチ
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を踏んでみてください。この MIDI インプットの情報がインジケーターに表示されます。下のスクリーンショットは、Wah 
ペダルを前に一杯に踏み込んだ場合です。直前に Logic が受信したのは、「MIDI チャンネル 1、CC 11 で値は 127」とい
うことが分かります:

このインジケーターにより、デバイスからの MIDI を受信の有無を確認できます。しかも、そのコマンドと値が示されるの
で非常に便利です。Line 6 FBV Control アプリケーションのダイアログに戻る必要がありません！

さて、FBV のペダルに POD Farm プラグインの “Wah Position” パラメータをマップしてみましょう。POD Farm プラグイ
ンをお持ちでない場合、Logic または Audio Units の任意のエフェクト プラグインをインサートして同じ手順を行ってく
ださい...

• FBV ペダルを “Pedal Wah” に設定します（FBV 本体で “Wah” LED を点灯させてください）。

• エフェクト効果の確認用に、Logic セッションでオーディオ トラックを作成し、録音を行うかオーディオ ファイルを
ロードします。この例では、クリーンなギターの素材だとベストです。

• このオーディオ トラックでエフェクト インサート スロットをクリックし、POD Farm プラグインをインサートします。

• POD Farm のプラグイン ウインドウで “Tone” プリセットを選択し、Wah モデルの 1 つをトーンに追加します。 
“Signal Flow View” で Wah をクリックし、Wah エフェクトの編集設定をエディット パネルに表示させます。

Wah エフェクトの “Position” ノブ

エディット パネルの POD Farm プラグイン、Wah エフェクト

• エディット パネルで POD Farm Wah の “Position” ノブを直接マウス クリックし、少し動かしてください。これによ
り、“Wah Position” パラメータが「選択」されます。

• 次に（他のものをクリックする前に）、Logic > Preferences > Control Surfaces > Learn Assignment for 
“Wah - Position” を選択してください。

 
• “Learn Assignment...” メニュー コマンドの名称を見ればお分かりのように、Logic は自動的に POD Farm プラグ

インの “Wah - Position” パラメータを検知しています。最終的に（前の手順で）選択されたアイテムがここに示さ
れます。
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ヒント: Logic の初期設定メニューを使用せず、ショートカット [Command+L] を使用することもできます。

• この  “Learn Assignment...” メニュー コマンドを選択すると、Logic の “Controller Assignments” ダイアログが
開かれ、「MIDI コマンドを学習するため、MIDI コントローラーにアクセスしてください」というメッセージが示され
ます。

“Controller Assignment” ダイアログには “Expert View” というビューが用意されています。手動で MIDI コントロー
ラーをマップするためのオプションがいくつか用意されています。このダイアログを探検したい方は、Logic のマニュ
アルでご確認ください。コントローラーを素早くマップするには “Easy View” が適切です。

• FBV ペダルを動かしてみましょう。“Controller Assignments” ダイアログが MIDI コントロールメッセージ（Line 6 
FBV Control アプリケーションにおいて、すでに選択した「FBV-Default」プリセットに準じて MIDI CC 11、値はゼ
ロから 127）を受信し、「学習」することが確認できます。 

「学習」された MIDI コントロール コマンドが
ここに示されます。 

• “Controller Assignments” ダイアログを終了し、FBV ペダルを踏んで試してみましょう。GearBox プラグイン ウイ
ンドウの “Position” ノブが反応して動くはずです。Logic で再生ボタンをクリックしてオーディオ トラックを再生
すると、ペダルの操作に合わせて、トラックにワウ エフェクトが適用されることを耳で確認できます！

• Logic のオーディオ トラック に POD Farm プラグインの “Wah Position” パラメータのオートメーションを記録す
ることも可能です。つまり、ペダルを使ってワウの「パフォーマンス」を記録できます。

上記手順を繰り返せば、ミキサー フェーダー、パン ノブ、ソロ スイッチ、ソフトウェア インストゥルメントのノブ、他のプラ
グイン パラメータなど、Logic のマップ可能な任意のパラメータを FBV コントローラーにマップできます。
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Logic のトランスポート機能をコントロールする
FBV フットスイッチを使用して Logic の トランスポート機能をコントロールするためには、Logic が MMC コマンド（現
在の設定によって FBV のフットスイッチが送信するもの）を「聞く」ように設定する必要があります...

• Logic を起動して Preferences > MIDI を選択します。

• “Sync” タブを選択します。

• このタブ右下の “MIDI Sync Project Settings...” ボタンをクリックします。これにより、“Song Settings” ダイアログ
が開かれます。

• “MIDI Machine Control（MMC）” セクションで、“Listen to MMC Input” オプションにチェックを入れます:

Logic では、これはソングごとのオプション設定となります。このオプションを「グローバル」にするには、Logic のテン
プレート ファイルを編集する必要があります。テンプレートで MMC を上記のように設定してください。
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Cakewalk SONAR™ - FBV MkII : セットアップのチュートリアル 
SONAR に内蔵された ACT（Active Controller Technology）機能により、Line 6 FBV MkII デバイスのフットスイッチとペ
ダル コントローラーに設定を行うと、Cakewalk SONAR の機能やソフトウェア インストゥルメント、プラグイン パラメー
タ、その他をトリガーすることができます！ ここでは、FBV MkII を SONAR 8 Producer で機能させるための設定手順を説

明します（SONAR の最近のバージョンであれば手順はそれほど違いません）。

Line 6 FBV Control アプリケーションでの設定
まず、SONAR を起動する前に、FBV をコンピュータの USB ポートに接続し、Line 6 FBV Control アプリケーションを起動
し、「FBV-Default.fbv」プリセットをロードしてください。

• 上図は、FBV Shortboard MkII 用の「FBV-Default」プリセットの設定です。FBV Express MkII の場合は、“A”、“B”、
“C”、“D” のフットスイッチとペダルの列のみが表示されます。このプリセットにより、デバイスの MIDI コントロー
ラーのすべてに MIDI コマンドが設定され、これらを SONAR でマップすることができます。 

• 通常は、このデフォルト設定を変更することはありませんが、File > Save As を選択して、これを新規プリセットと
して保存するとよいでしょう。「SONAR.fbv」など、分かりやすい名称を付けておくと便利です。

• FBV Control アプリケーションを終了します。

SONAR の MIDI Device Settings ダイアログでの設定
FBV MkII から送信されるサーフェス コントローラーの MIDI データを受信するよう、SONAR を設定するには、SONAR 
の “MIDI Device Settings” ダイアログでデバイスを選択する必要があります。SONAR の起動時は常に、FBV デバイス
が USB ポート に接続されていることをご確認ください。SONAR を起動し、SONAR の “Options/MIDI Devices” を開き、
MIDI インプット デバイスとして、最初の FBV MIDI 出力ポートを選択し、“OK” をクリックします。
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Windows® 7 / Vista® の場合、MIDI 出力ポートは “FBV Shortboard MIDI Out” または “FBV Express MkII MIDI Out” 
という名称で表示されます。

SONAR で FBV MkII をサーフェス コントローラーとして使用する
SONAR に内蔵された独自の「ACT MIDI Controller」プラグイン機能により、任意の MIDI サーフェス コントローラーの
マップを簡単に作成、カスタマイズして保存することが可能です。SONAR ACT 機能は非常にパワフルですので、是非、
SONAR のマニュアルをご一読ください。以下、FBV のフットスイッチまたはペダル コントローラーのマップをご自身で
作成する方法を説明します。SONAR でプロジェクトを開くか新規のものを作成し、以下の手順を実行してください...

• SONAR で Options > Controllers/Surfaces を選択します。

• “Controllers/Surfaces” ダイアログでは、“Add new Controller/Surface” ボタンをクリックします。“Controllers/
Surfaces” の欄に “ACT MIDI Controller” を、“Input Port” の欄に最初の FBV MIDI 出力ポートを選択します。
“Output Port” の欄は “None” で構いません。“OK” をクリックしてください。設定は以下のようになります:

• 設定が済んだら “Controllers/Surfaces” ダイアログを閉じます。

• 次に、Views > Toolbars と進み、“Controllers/Surfaces” ボックスが選択されていることを確認し、ウィンドウを
閉じます（これにより、SONAR のツールバーに便利な ACT オプションが追加されます）。
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• “ACT Controllers” ツールバーのオプションで、“Control Surfaces” ツールバーの右端にある“Controllers/
Surfaces Properties” ボタンをクリックします。

• “ACT MIDI Controllers” ダイアログでは、“Presets” メニューから “Default” プリセットを選択します。このプリセッ
トがロードされると、ダイアログの「セル」から SONAR の膨大なパラメータにアクセスできます。また、プラグイン
やソフトウェア インストゥルメントのエディット ウィンドウをクリックし、アクティブ ウィンドウとして「フォーカス」
すると、そのプラグイン/インストゥルメントのパラメータが ACT ダイアログのセルに使用可能となります。けれど
も、“Default” プリセットでは、まだ、FBV コントローラーがパラメータをコントロールするようにマップされていま
せん。マップを構成するために、MIDI 学習機能を使うことができます。 

“ACT MIDI Controller” ダイアログ - “Default” プリセット（SONAR メイン ウィンドウが「フォーカス」されています。）

SONAR ACT MIDI 学習機能を使用する
FBV ペダルの Wah コントローラーを Line 6 GearBox プラグインの “Wah Position” パラメータにマップする方法を示
します。レコーディングのシグナルをインプット モニターしたり、オーディオ トラックを再生する際、GearBox の Wah を
リアルタイムで遠隔操作することが可能になります。以下のマップ手順は、任意のノブ、ボタン、フットスイッチ コント
ローラーを、“ACT MIDI Controllers” ダイアログで有効な任意のパラメータにマップする場合にも適用されます...

• SONAR の “ACT MIDI Controllers” ダイアログを開き、“Default” プリセットをロードします（上記参照）。このダイ
アログは、どこか見える場所で開いたままにしておいてください。

• プラグイン エフェクトの効果の確認用に、SONAR プロジェクトでオーディオ トラックを作成し、録音を行うかオー
ディオ ファイルをロードします。この例では、クリーンなギターの素材だとベストです。

• このオーディオ トラックの “FX Bin Insert” スロットをクリックし、GearBox プラグインをインサートします。

• GearBox プラグイン ウィンドウでトーンのプリセットをロードします。“WAH” ペダルをクリックしてオンにし、 Wah 
エフェクトの設定をエディット パネルに開きます。
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GearBox プラグインのエディット パネル、Wah エフェクト 

• GearBox プラグイン ウィンドウにフォーカスしたまま、ACT ダイアログに目を移してみましょう。数多くの GearBox 
プラグイン パラメータがセルに表示されています。私達の目標は “Wah - Position” パラメータです。これを表示
するには、一番上の “Rotary” セルに Bank 4 を選択する必要があります。これにより、“Wah - Position” パラメー
タが、“Rotary 1” コントローラーのスロットに現れます。

“Default” プリセットを選択します...

“Controllers” タブで、  
最上列に “ Bank 4” を選択します。 

GearBox プラグインの “Wah-Position” パラメータが
“Rotary 1” スロットに表示されます。 

• “Rotary 1” コントローラー スロットの下側のセルをクリックし、MIDI 学習機能モードに入ります。Sonar は、アサイ
ンされた MIDI サーフェス コントロール デバイス（FBV）からの MIDI コマンドの受信を待機します...

• ここで FBV の Wah ペダルを動かします。“Rotary 1” のセルは直ちに MIDI 学習機能を終了します。これは、ペダ
ルの MIDI コマンドが「学習された」ことを意味します。つまり、コントローラーがパラメータにマップされました。

• ペダルを動かして、GearBox プラグインの大きな “Wah Position” ノブが反応することを確認してみましょう。 
トラックを再生するとワウが適用されます。

• 同様の手順で MIDI 学習機能を使用し、FBV MkII デバイスの他のコントローラーを、SONAR の他のパラメータ、
プラグインやインストゥルメントのパラメータにマップしてください。終了したら、ACT ダイアログ最上部のプリ
セット フィールドに新規名称をタイプ入力して、“Save” ボタンをクリックし、これらすべての新たなマップ設定を 
SONAR ACT プリセットとして保存します。

SONAR の ACT は MIDI コントロールに関して数多くの機能を提供しています！ 詳細については、SONAR のヘルプ書類
でご確認ください。 
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Propellerhead Reason® - FBV MkII : セットアップのチュートリアル
「キーボード タイプ」である Line 6 KB37 コントローラーの場合、鍵盤やノブを使用して Reason のインストゥルメント デ
バイスを演奏したり、MIDI 演奏を録音することが可能です。当然のことながら FBV MkII デバイスはこれらを装備してい
ませんが、FBV MkII デバイスのフットスイッチとペダルのコントローラーを使用して、Reason のパラメータの多くをトリ
ガーしてコントロールすることが可能です！ この機能を FBV に設定するには、Reason で FBV を「一般的な MIDI コント
ロール サーフェス」としてセットアップすることが必要です（念のために記しておくと、最愛の FBV が「一般的」に分類さ
れるのはちょっと心外です）。以下の手順に従ってください。特に注意書きがない場合、Windows® でも Mac OS® X でも
同じ手順となります...

• Reason の “Preferences” ダイアログで、“Keyboards and Control Surfaces” を選択し、Add ボタンをクリックし、
次にデバイス リストから <Other> を選択します。

• “Control Surface” ダイアログで以下の設定を行います:

“Model” に MIDI Control Surface を選択します。

デバイスの名称を入力します（Reason の MIDI コント
ローラー メニューに表示される名称です）。 

Reason が受信に使用する USB MIDI ポートを選択し
ます。最初の FBV MIDI 出力ポートを選択してください

（Mac® または Windows® により、ポートの名称は異
なって表示されます - 6•1 ページ を参照）。

最後に OK をクリックしてください。
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• 以上の手順に準じて FBV デバイスが設定されたことが示されます。“Preferences” ダイアログが以下のように設
定されたことを確認し、ダイアログを閉じてください:

FBV の MIDI コントローラーを Reason のパラメータにマップする方法は以下の項で説明しています。

FBV の MIDI コントローラーを Remote Override で設定する
Reason は “Remote Override” という機能を内蔵しています。これを使用すると、素早く Reason に MIDI コントロール 
デバイスから送信される MIDI メッセージを「学習」させ、それを直ちに Reason のパラメータにマップすることが可能で
す。FBV MkII が「一般的」MIDI コントロール デバイスとして設定されている場合に（上記参照）、“Remote Override” オ
プションを使用することができます。 

まず、FBV フットスイッチとペダルのコントローラーが、「一般的」MIDI コントロールの設定手順で選択した MIDI ポート
から MIDI CC メッセージを送信するように設定されていることを確認します。Reason アプリケーションを終了し、Line 6 
FBV Control アプリケーションを起動して「FBV-Default.fbv」 プリセットをロードしてください...

• 「FBV-Default」 プリセットをロードすると、FBV の “Pedal Vol” コントローラーが “MIDI CC 007” を送信するように
設定されています。ここで、“Pedal Vol” コントローラーがコマンドを FBV の MIDI 出力ポート “1” に送信する設定
となっていることにもご注意ください。このポートこそ、Reason の「一般的」コントローラーの設定手順で Reason 
が MIDI を受信するポートとして選択したものです。これらを確認できたら、FBV Control アプリケーションを終了
します。以下、このポートを Reason のパラメータにマップする方法を説明しましょう。 

• FBV ペダルが “Pedal Vol” コントローラーの設定となっていることを確認します（本体の “Volume” LED インジ
ケーターが点灯）。
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• Reason を起動し、Reason プロジェクトをロードします。Reason のコンポーネントのノブやスライダーなど、ペダ
ルでコントロールできるものを選択して右クリック（Windows）または [Ctrl]-クリック（Mac）してください。この例
では、Reason のシンセ デバイスの“FREQ” ノブを選択します...

コントロールしたいノブを直接、右クリック/[Ctrl]-ク
リックします...

Edit Remote Override Mapping...メニューを選
択します。

• ダイアログでは、“Learn From Control Service” のボックスにチェックを入れます。アサインされた MIDI コント
ロール サーフェスから送信される MIDI CC メッセージの受信を待機します。

FBV のペダルを動かすと、“Control Surface 
Activity” インジケーターにより、MIDI シグナルの
受信が示されます。 

受信すると、上の “Control Surface” と “Control” の
フィールドに、「学習された」MIDI デバイスの名称と 
CC の値が自動的に入力されます（左図）。

OK をクリックして手順は完了です。

• 準備完了となりました！ ここでペダルを動かすと、選択したノブが反応して動きます。以上の手順を繰り返せば、
任意の FBV コントローラーを Reason のアサイン可能なノブ、スライダー、スイッチなどに直接マップできます。

Reason の “Remote Override” 機能は他の役割も備えています。Line 6 MIDI コントローラーに、このパワフルな機能を
適用することに関しては、Reason のマニュアルでご確認ください。
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Pro Tools® LE トランスポート コントロール - FBV MkII :  
セットアップのチュートリアル

このチュートリアルは、FBV Shortboard または Express MkII デバイスを使用して、Digidesign Pro Tools® LE 8 ソフト
ウェアのトランスポート機能を遠隔操作する方法（ソフトウェアの設定）を一手ごとに記しています（他のバージョンでも
手順はそれほど違わないでしょう）。Pro Tools では、この目的で MIDI コントローラー デバイス（FBV MkII など）をセット
アップするのは非常に簡単とは言えないまでも、手順を把握してしまえば極めて単純な作業となります。レコーディング
でパンチインする際など、フット コントローラーによるトランスポート機能操作の威力は絶大です！ 

ノート: 以下の手順は Mac® でのものですが、特に注意書きのない限り、Windows® XP, Windows® 7 または Vista® 
にも当てはまります。

FBV のコントロールの割り当てを構成する
Pro Tools を起動する前に行うべき最初の手順は、FBV デバイスの各フットスイッチとペダルにそれぞれ MIDI を割り
当てたセットを 1 組構成することです。Pro Tools は、間接的には MIDI Machine Control（MMC）コマンドを使用して自
身のパラメータにアクセスします。これを踏まえ、このチュートリアルは、Line 6 FBV Control アプリケーションを使用して 
MMC コマンドを FBV フットスイッチにアサインするところから始まり、それを FBV プリセットとして保存して...と進みま
す。さて、準備はよろしいでしょうか？

• FBV MkII デバイスをコンピュータに接続し、Line 6 FBV Control アプリケーションを起動します。 

• File > Open を選択し、「Blank.fbv」プリセットをロードします。

• File > Save As を選択し、これを新規プリセット「PT-Transport.fbv」として保存します。

ここでは、FBV のいくつかのコントロールを次のように設定します（デバイスは FBV Shortboard でも Express MkII でも
手順は同じです）:

• “A”、“B”、“C”、“D” のフットスイッチ コントロールの MIDI コマンドをすべて “MMC” に設定します。

• “A” コントロールの “Value” を “Play” に設定します。

• “B” コントロールの “Value” を “Stop” に設定します。

• “C” コントロールの “Value” を “Record Punch（Pro Tools）” に設定します。

• “D” コントロールの “Value” を “Rewind” に設定します。この巻き戻しに関しては、スイッチ モードでの選択によ
り、それぞれ異なる動作となります:

• “Single” の場合、フットスイッチを踏むと、巻き戻しがスタートします（ずっと巻き戻しています）。

• “Momentary” の場合、フットスイッチを踏むと、巻き戻しがスタートしますが、足を離すと巻き戻しがストッ
プします。

• “Toggle” の場合、フットスイッチを踏むごとに、巻き戻しのスタート/ストップが切り替わります。

• 以上の設定を変更し、どれかのフットスイッチ（あるいは Shortboard をお持ちの方は他のフットスイッチ）の 
“Value” に “Fast Forward” をアサインしても構いません。ここで、 MMC の “Value” の “Pause” は、単に “Stop” と
同じ意味となるのでご注意ください（Pro Tools のトランスポートに一時停止のボタンはありません）。

• 上記コントロールのすべての “Port” と “Channel” を “1” に設定します。すべての MIDI コマンドを FBV の「USB 
MIDI 出力ポート 1、チャンネル 1」に送信させるためです。

• FBV コントロールは “Unassigned” にしておきます。この例では使用しません。
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結果として、“Control Properties” リストは以下のようになります:

• 以上の設定が済んだら、FBV Control アプリケーションを終了します。FBV とコンピュータの接続は外さないでく
ださい。

Pro Tools LE : FBV MkII デバイスの設定
次に、FBV コントローラー デバイスからの MMC コマンドを受信するようにPro Tools を設定します。Pro Tools を起動
し、セッションを開くか、新規のセッションを作成し、以下の設定を行ってください...

• “Setup” メニューで “Peripherals” を選択します。

• “Peripherals” ダイアログで、“Machine Control” タブを開き、以下のように設定します:

• MIDI Machine Control（Master）- “Enable” ボックスにチェックを入れ、右のプルダウン メニューをクリッ
クして “Predefined” サブメニューから、接続された FBV MkII デバイスを選択します。“ID” は “125” にしてく
ださい。“Preroll” は “90 frames” のままにしておきます。

• MIDI Machine Control（Slave）- “Enable” ボックスにチェックを入れます。“ID” は “126” のままにしてお
きます。 

• “Peripherals” ダイアログを閉じます。
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次に、トランスポートで小さな “Pro Tools” メニュー にアクセスします...

Pro Tools - “Transport” サブメニューで “Pro 
Tools”を選択してチェックを入れます。

次に、“Online” サブメニューで “MMC”を選択し
てチェックを入れます。 

...これで完了です！ FBV のスイッチ “A”、“B”、“C”、“D” を踏んでみましょう。スイッチに応じて Pro Tools トランスポートが
コントロールされることをご確認ください。
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Steinberg Cubase® - FBV MkII : セットアップのチュートリアル
Line 6 FBV MkII デバイスは、Cubase のトランスポート機能、ミキサー パラメータ、その他多数のパラメータをコント
ロール可能です！ ここでは、FBV MkII を Windows® の Steinberg Cubase® 4 で使用するための設定手順を記します
が、最近のバージョンの Cubase または Nuendo® であれば、Windows® でも Mac® でも手順は同様です。

Line 6 FBV Control アプリケーションでの設定
まず、Cubase を起動する前に、FBV をコンピュータの USB ポートに接続し、Line 6 FBV Control アプリケーションを起動
して「FBV-Default.fbv」プリセットをロードします: 

• 上図は、FBV Shortboard MkII 用の「FBV-Default」プリセットの設定です。FBV Express MkII の場合は、“A”、“B”、
“C”、“D” のフットスイッチとペダルの列のみが表示されます。このプリセットにより、デバイスの MIDI コントロー
ラーのすべてに MIDI コマンドが設定され、これらを Cubase でマップすることができます。

• FBV フットスイッチのいくつかは、MMC（MIDI Machine Control） コマンドを送信するように設定されています
（Cubase のトランスポートをコントロール）。また、他のいくつかは、MIDI CC メッセージを送信するように設定さ
れています（その他の機能をトリガー）。

• 通常、このデフォルト設定を編集する必要はありませんが、変更を行った場合は、File > Save As を選択して、
「Cubase.fbv」など分かりやすい名称を与え、新規プリセットとして保存しましょう。

• FBV Control アプリケーションを終了します。

Cubase : MIDI ポートのセットアップ
この例では、FBV MkII デバイスを MIDI コントローラー デバイスとして使用するので、Cubase の “All Inputs” MIDI ポー
ト設定では FBV MkII を除外しておきましょう。これにより、ある MIDI トラックで “All Input” オプションを選択した場合
も、トラックが FBV デバイスからのインプットを受信したり、MIDI コントローラーのデータをトラックに録音することは
なくなります。この設定は Cubaseの Devices > Device Setup ダイアログで行います。また、Line 6 FBV Control アプリ
ケーションに使用したプリセットにより、すべての FBV コントローラーは FBV USB MIDI 出力ポート「1」へ送信するよう
設定されるので、ここでは最初の FBV MIDI ポート だけを選択し、FBV MIDI ポート「2、3、4」は非選択として構いません。
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“MIDI Port Setup” を選択します。 FBV USB MIDI ポートのすべての “All Inputs” 
ボックスのチェックを外します。 

最初の FBV USB MIDI ポートのみチェックします。 
FBV ポート「2、3、4」のチェックは外します。

この例では Windows® XP を使用しているので、FBV の MIDI ポートは “USB Audio Device” という名称で表示されて
います。Windows® 7, Windows Vista® または Mac OS® X の場合、表示名が異なるのでご注意ください（ 6•1 ページ を参
照）。

Cubase : パラメータのコントロール
Cubase はサードパーティの数多くの MIDI コントロール サーフェス デバイスをサポートしています。コントロール サー
フェスは、典型的には大きな筐体のハードウェアで、いくつかのフェーダーやノブ、その他のコントロールを装備し、ア
ナログのミキシング コンソールをエミュレートするように設計されたものです。Line 6 FBV MkII デバイスは Steinberg 
がサポートするコントロール サーフェス デバイスのリストに含まれていませんが、FBV MkII デバイスを “Generic 
Remote” デバイスとして設定することにより、FBV の任意の MIDI コントローラーを Cubase の様々なパラメータにマッ
プすることができます。Cubase の Devices > Device Setup ダイアログをもう一度開いてください...

• 左パネルの Remote Devices に “Generic Remote” が表示されていない場合、ダイアログ左上の “+” ボタンをク
リックしてメニューから “Generic Remote” を選択して追加してください。 

“Generic Remote” を選択します。 “MIDI Input” に最初の FBV USB MIDI ポートを選択します。
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• 右のリストには、FBV デバイスのコントローラーにマップ可能な Cubase のパラメータのリストが示されます。こ
のマップ作業を最も楽に行うには「学習機能」を使用します。例えば、リスト最上部の “Fader 1” パラメータに FBV 
の “Pedal Vol” をマップする手順は以下のようになります:

• FBV のペダルが “Pedal Vol” に設定されていることを確認します（本体の “Volume” LED が点灯）。

• “Cubase Device Setup” ダイアログの右パネル最上段で、Control Name “Fader 1” を直接クリックします。 

• FBV のペダルを動かします。

• ダイアログの右、Learn ボタンをクリックします。

• “Fader 1” の列で “MIDI Channel” と他の設定が変更されます。これは、FBV の “Pedal Vol” コントローラー
が送信する MIDI CC メッセージ（Line 6 FBV Control アプリケーションで設定されたもの、すなわち、MIDI 
CC 011、MIDI ポート 1、チャンネル 1）が「学習された」ことを意味します。

• Cubase のミキサー ウィンドウを開き、トラック 1 のチャンネル ストリップを眺めてみてください。FBV ペダ
ルを動かすと、フェーダーも反応して動きます。

• 上記手順を繰り返し、FBV の他のコントローラーをリスト内の Cubase の他のパラメータにマップします。

• ご注意ください。Cubase のフェーダー、ノブ、スライダー タイプのパラメータにはペダル コントローラーを
マップする必要があります。フットスイッチ ボタンは Cubase のスイッチ タイプのパラメータにマップしてく
ださい。

• また、通常、これらの Cubase パラメータは MIDI CC タイプのコマンドのみを受信します。従って、 FBV フッ
トスイッチ、またはペダル コントローラーが同タイプの MIDI メッセージを送信するように設定されているこ
とを Line 6 FBV Control アプリケーションでご確認ください。

右パネルでは、トラック 1 - 16 に渡るチャンネル ストリップのパラメータをマップできます。また、このダイアログでは、他
のオプションにより、これら “Generic Remote” のパラメータのリストをカスタマイズすることも可能です。詳細について
は、Cubase のマニュアルをご参照ください。

Cubase : トランスポートのコントロール
シンプルな MIDI Machine Control Slave オプションにより、Cubase のトランスポートをコントロールすることが可能
です。このスレーブ オプションを設定すると、Cubase は選択デバイスからの MMC コマンドを聞き、それに応じて反応
します。すでに FBV Control アプリケーションで FBV のいくつかのフットスイッチに MMC コマンドがアサインされてい
るため、後は、FBV MkII デバイスからの MMC コマンドを聞くように Cubase を設定するだけです。

Cubase の Transport メニューで Project Synchronization Setup...を選択してください:
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“MMC Slave Active”ボタンをチェックします。 

“MIDI Input” には最初の FBV USB MIDI ポート
を選択します。

“OK” をクリックしてダイアログを閉じます。

MMC コマンドを送信するようにアサインされた FBV フットスイッチを踏んでみましょう。Cubase のトランスポートが応
答するはずです。

この章では、サードパーティのアプリケーションでの設定手順を例を挙げて説明してきました。Line 6 FBV MkII デ
バイスを USB MIDI コントローラーとして使用するための設定については、以上で十分な情報であると思われます。 
MIDI 遠隔操作に対応する他の DAW アプリケーションの場合も同様の手順で設定できるでしょう。次の章では、とても
役立つヒント、そして Line 6 のオンライン リソースについて記すことにします！
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リファレンス
これまでの章でご不明な部分が残された方、あるいはせっかちなタイプですぐに解決を求められる方のために、便利な
リファレンスの章を設けました！ 数々の質問とその解決策、トラプルシューティングのヒント、また、質問するにはちょっと
気後れなさるかも、という情報をまとめています。でも本当は、是非他の章をご一読くださるよう、お願いします！

Q & A

一般的な Q & A
「RJ-45」 ケーブルとは? FBV MkII は、両端が「RJ-45」タイプのコネクタを使用して Line 6 のアンプや POD デバイス
に接続します。私達が名称を与えた訳ではありません。これは、この種のコネクタに対する業界標準の名称です。コン
ピュータの Ethernet ネットワーク ケーブルに使用されているものと同じです。従って、紛失や破損などより交換が必要
な場合も、電気店やコンピュータ ショップで標準的「カテゴリ 5」ネットワーク ケーブルとご指定になれば、すぐにお買い
求め頂けるでしょう。

FBV MkII と Line 6 Monkey を使用して、所有する Spider IV / Spider Valve MkII アンプをアップデートできると
聞いたのですが...どのようにすればよいのでしょう？ それは正しい情報です。簡潔にお答えします。RJ-45 ケーブルを用
いて Spider IV / Spider Valve MkII と FBV を接続し、FBV とコンピュータを USB で接続してから Line 6 Monkey ソフト
ウェアを起動してください。これにより、Line 6 Online サーバーに接続され、お使いの Spider アンプに必要なアップデー
トの有無が示されます。詳しくは、FBV MkII Online Help のページにリンクされた「Spider IV / Spider Valve MkII 
Advanced User Guide」をご参照ください。

FBV の「ファームウェア」とか「フラッシュ メモリ」とは？ アップデートの必要があるのでしょうか？ FBV MkII デバイスの
ファームウェアは、デバイスを作動させる内部の「永久的なソフトウェア」と考えることができます。フラッシュ メモリは、
指示やデバイス設定を記憶するセクションです。デバイスが最新で最も優れたデータ セットを保つよう、そして他のデ
バイスや機能とのベストな互換性のため、頻繁に Line 6 Monkey を起動し、推奨されるフラッシュ メモリのアップデート
をインストールすることを強くお勧めします。

FBV には特別な USB ケーブルが必要ですか？ いいえ！ USB 周辺機器をコンピュータに接続するために購入するよう
な標準の USB ケーブルで構いません。24 カラットの金のチップ付き、ウルトラ シールド、あるいは怪しげな種類のケー
ブルにお金を費やす必要はありません（どうしてもとお望みなら...）。

FBV MkII を USB ハブに接続して構いませんか? はい。けれども必ず、パワードのハブ（コンピュータから電源を取る
ハブでなく、ハブ自身に電源を供給する AC 電源ケーブルを付属するもの）に接続してください。一般的には、ベストな 
USB 交信のためには、ハブを使用せず、直接、コンピュータの USB ポートの 1 つに接続してださい。

FBV MkII 用インストーラー CD はどこにあるのですか？ お買い求めの FBV MkII デバイスは、デバイス ドライバのイン
ストール ソフトウェアを必要としません。Mac® または Windows® コンピュータの USB ポートに接続するだけです（「は
じめに」（ 1•1 ）をご参照ください）。FBV と共に使用する他のすべての Line 6 ソフトウェアは line6.com/software からダウ
ンロード可能です。あるいは Line 6 Monkey ソフトウェアを起動して入手できます。

http://line6.com/manuals/footcontrollers/
http://line6.com/software/
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USB/MIDI に関する Q&A

すでに FBV をインストールしてあるのにも関わらず、別の USB ポートに接続すると Windows® がインストールを要求
します。何故ですか？ これは、Windows® コンピュータの正常な反応です。別の USB ポートに初めて接続した場合、USB 
デバイスのインストールが必要となります（ 「はじめに」（ 1•1 ）を参照）。求められる場合、そのままデバイスのインストー
ル作業を行ってください。以降は同じ USB ポートに FBV を接続しても、インストールは要求されません。

FBV MkII は MIDI デバイスなのに、何故、5-pin MIDI ケーブル端子を備えていないのですか？ FBV MkII は、コン
ピュータとの MIDI 交信をすべて USB 経由で行います。MIDI/DAW ソフトウェアを起動すると、全 4 つの FBV USB MIDI 
出力ポートから 1 つを選択して MIDI を受信させることが可能です。煩わしい MIDI ケーブルは必要ありません！

FBV MkII を使用して POD Farm 1.x プラグインやスタンドアローンのソフトウェアをコントロールできますか？ POD 
Farm 1.x バージョンは MIDI 経由のリモート コントロールに対応していないので、FBV から直接コントロールすること
はできません。けれども、DAW ホスト アプリケーション内で POD Farm Plug-In を使用する場合、通常、設定を行うこと
により、FBV でリアルタイムに任意のプラグインのパラメータをコントロールしたり、オートメーションを録音することが
可能になります。この方法で POD Farm プラグインのパラメータをコントロールできるかもしれません。「Ableton Live 

- FBV MkII : セットアップのチュートリアル」（ 6•4 ） 、そして他のセットアップ チュートリアルをお読みください。お使いの 
MIDI/DAW ソフトウェアのマニュアルもご参照ください。

より新しいPOD Farm™ 2バージョン・プラグインとスタンドアローン・アプリケーションは、共にFBV MkIIコントローラー
経由でMIDI コントロールを完全にサポートします(「FBV™ MkIIと共にLine 6 POD Farm™ 2」 （4•1） 参照)。

MIDI/DAW ソフトウェアのいくつかの機能をコントロールするのに SysEx メッセージが必要なのですが、カスタマイ
ズして FBV MkII に SysEx を送信させることは可能ですか？ SysEx メッセージの一種である MMC（MIDI Machine 
Control）を送信するようにFBV MkII デバイスを設定することは可能です。けれども、Line 6 FBV Control アプリケーショ
ンは、SysEx MIDI データの手動入力、読み込み/書き出しなどの拡張機能を備えていません。

ソフトウェアが FBV MkII を有効な MIDI デバイスとして認識しないのですが？ USB ケーブルをコンピュータと FBV に
接続する前に MIDI/DAW ソフトウェアを起動しませんでしたか？ その場合、すべてのソフトウェアを終了し、FBV が接続
されていることを確認した上でソフトウェアを再起動してください。それでも問題が解決しない場合、FBV を USB ハブで
はなく、直接、コンピュータのオンボード USB ポートに接続してみてください。

FBV デバイスに現在記憶されている設定を自動的に「上書きせず」、コンピュータで FBV プリセット を編集、保存するに
はどうしたらよいですか？ Line 6 FBV Control アプリケーションを使用する場合、アプリケーションで設定を変更すると、
直ちに変更が接続された FBV デバイスに送信され、FBV の内部メモリに記憶されている現在の設定が上書き（更新）さ
れます。が、FBV プリセット ファイルを編集して保存する場合、単に FBV から USB ケーブルを外しても、そのまま、Line 6 
FBV Control アプリケーションを使用できます。その後は、お好きな時に、FBV を再接続し、File > Open を選択して保存
された「.fbv」プリセット ファイルを FBV デバイスにロードできます。

友達も FBV MkII を所有しています。プリセットを共有できますか？ もちろんです！ 無償のLine 6 FBV Control アプリ
ケーションを使用して、ご自身のカスタム FBV プリセットを作成、編集、保存し、その「.fbv」ファイルをお友達に送って、
他の FBV MkII にロードしてもらいましょう。この場合、一方が Shortboard MkII で、もう一方が Express MkII であっても
互換性に問題は生じません（Shortboard 側で作成されたプリセット内の追加コントロールは、Express 側で単に無視さ
れます）。
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トラブルシューティング
問題に直面しましたか？ 以下は、FBV MkII デバイスの操作に問題が生じた場合のチェック リストです。

Line 6 Amp/POD の操作
Line 6 アンプ/POD を接続しても FBV がオンになりません！ - FBV MkII デバイスは、アンプ/POD との RJ-45 ケーブル
接続を介して電源を受け取ります。従って最も疑われるのは、RJ-45 ケーブルが端子にしっかりと接続されていない状況
です（ケーブルの「両端」をデバイスにしっかり、カチッと感触があるまで差し込んでください）。あるいはケーブル自体に
問題があるかもしれません。また、接続したアンプ/POD の電源がオンでないと、FBV は電源を受けられません！

FBV を使用して Line 6 アンプ/POD の何もコントロールできません！ - FBV MkII が FBV とアンプ/POD に接続した RJ-
45 ケーブルがしっかりと差し込まれていないのかもしれません（ケーブルの「両端」をデバイスにしっかり、カチッと感
触があるまで差し込んでください）。あるいは以下のことが原因かもしれません:

• アンプ/POD をオンにする前に FBV を接続してください - すでに電源がオンとなっている Line 6 アンプ/POD に 
FBV を接続したのであれば、適切に初期化するため、FBV を接続したまま、アンプ/POD を一度オフにして、再度
オンにしてみてください。

• FBV が “USB Mode” に設定されている -  USB ケーブルが接続されると、FBV は「USB モード」となり、この場合、
RJ-45 で接続されたアンプ/POD デバイスとの交信をすべて上書きしてしまいます。USB モードを終了させるた
め、USB ケーブルを外してください。

• POD X3 のデュアル トーンの動作 - POD X3 の場合、FBV がコントロールするのは、モデルの現在選択中のトー
ン（トーン 1 またはトーン 2）だけです。また、POD X3 のプリセットごとに、独自のペダル割り当て（トーン 1 とトー
ン 2 のコントロールに使用するペダル）が設定されています。

FBV ペダルが、 POD X3 のプリセットによって時々異なる機能をコントロールするのは何故ですか？ POD X3 の各プリ
セットは、ペダル設定を編集して個別に保存することができます。POD X3 の “SYSTEM” 画面を開き、現在のプリセット
のペダル設定を確認してください。

Shortboard の “Function 1” スイッチが、 POD X3 のプリセットによって時々異なる機能をコントロールするのは何故
ですか？ POD X3 の各プリセットは、Shortboard の “Function 1” フットスイッチの設定を編集して個別に保存すること
ができます。“Function 1” スイッチの動作については、POD X3 の “SYSTEM” 画面を開き、現在のプリセットの “LP SW” 
の設定で確認してください。 

USB/MIDI の操作
コンピュータに接続しても、FBV がオンとなりません！ コンピュータに接続されている場合、FBV MkII は USB ケーブル経
由で電源を受け取ります。USB ケーブルの両端がしっかりと差し込まれていることをご確認ください。一般的には、コン
ピュータのオンボードの USB ポートの 1 つに直接（USB ハブを経由せず）接続するのがベストです。また、ケーブル自体
に損傷がないことを確認するため、ケーブルを交換してみてください。

Line 6 Monkey が FBV MkII デバイスを検知しません！ FBV は Line 6 Monkey の起動以前から適切にパワーを受け
ていましたか？ FBV が適切にコンピュータの USB ポートに接続されていることをご確認ください。

• Windows® の方へ... Line 6 Monkey を起動する前に、必ず、Line 6 FBV Control アプリケーション、そして FBV を
使用している可能性のある MIDI/DAW ソフトウェアを終了してください。Windows® の Class Compliant USB ド
ライバは複数のアプリケーションが同時に同じ MIDI ポートを使用することを許しません。Monkey はその動作
にいくつかの MIDI ポートを使用します。
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Line 6 FBV Control アプリケーションが FBV MkII デバイスを検知しません！ まず、前頁の項目をご参照になり、FBV 
が適切に電源を受けていることをご確認ください。以下は他に考えられる解決法です:

• フラッシュ メモリが最新のバージョンであることを確認してください - FBV をコンピュータに接続し、Line 6 
Monkey を起動します。Monkey は Line 6 オンライン サーバーをチェックし、FBV 用の最新版のフラッシュ メモ
リやその他のアップデートが入手可能かどうかを知らせます。パフォーマンスと製品の互換性の向上のため、フ
ラッシュ メモリとFBV Control アプリケーションは最新アップデートをインストールすることが非常に重要です。

• Windows® ユーザーの方へ - Windows® Class Compliant USB ドライバの特性により、複数のアプリケーショ
ンが同時に同じ MIDI ポートを使用することは許されません。従って、 Line 6 FBV Control アプリケーションや 
MIDI/DAW アプリケーションを複数起動している場合、FBV デバイスを使用するアプリケーションは 1 つを除い
てすべて終了するか、これらのアプリケーションで MIDI 設定を変更する必要があります。詳しくは 「Windows® 

MIDI ポートでの交信」（ 6•1 ）をご参照ください。

• Windows® 7 / Vista® のスリープ モード - Line 6 FBV Control アプリケーションを起動している場合、もし
くは、FBV を USB ポートに接続している場合、Windows® をスリープ モードにすることはお勧めできません。
Windows® の USB Class Compliant ドライバの特有な挙動により、スリープからの脱却時に USB デバイス（FBV
など）が適切に初期化されず、結果、アプリケーションがデバイスを検知できない場合があります。この問題を解
決するには、Line 6 FBV Control アプリケーションを終了し、FBV の USB ケーブルを一度抜き差ししてください。

MIDI/DAW ソフトウェアで FBV の USB MIDI ポートを有効にできません！ - まず、MIDI/DAW を起動する「前に」FBV 
の接続と電源が適切であることを確認します。Windows® ユーザーの方は、上の項の Windows® USB Class Compliant 
ドライバの挙動についてもご確認ください（起動している他のソフトウェアで FBV の MIDI ポートを不使用としたり、FBV 
Control アプリケーションを終了する必要があるかもしれません）。お使いの MIDI/DAW ソフトウェアのマニュアルもご
参照ください。MIDI コントローラー デバイスを選択して有効にするための方法は、ソフトウェアにより大きく異なります。

MIDI/DAW ソフトウェアで適切な FBV USB MIDI ポートが有効になっているのに、ソフトウェアが FBV からの MIDI 
コマンドを受信しません！ - まず、MIDI/DAW を起動する「前に」FBV の接続と電源が適切であることを確認します。
MIDI/DAW によっては、FBV などの MIDI コントロール デバイスからの MIDI コントロール データを受信させるため
に数多くの設定を行う必要があるでしょう。お使いの MIDI/DAW ソフトウェアのマニュアルでご確認ください。また、 

「FBV™ MkII と サードパーティーのソフトウェア」（ 6•1 ） もお読みください。有用なヒントとセットアップの事例を示して
います。いくつかの DAW ソフトウェアの場合、「MIDI コントロール サーフェス」や「MIDI コントローラー」に関して特殊
な設定が必要となります。この設定は、例えば、MIDI トラックで MIDI インプットを受信するための MIDI 設定とは別にさ
れているかもしれません。以下、いくつかのチェック項目を記します:

• FBV の各フットスイッチとペダル コントロールは、4 つの MIDI ポート（FBV MIDI 出力ポート「1」から「4」）のいず
れかにデータを送信可能です。そして、各コントロールは選択ポートの 16 の MIDI チャンネルのいずれかを使用
します。これらのポートとチャンネル設定は FBV Control アプリケーションで確認/編集可能です。MIDI/DAW ソフ
トウェアが MIDI コントロール データを受信するポート/チャンネルが、FBV の送信ポート/チャンネルと同じに設
定されていることをご確認ください。

• FBV が適切なタイプの MIDI コマンドを送信していることをご確認ください。いくつかの DAW アプリケーショ
ンはパラメータに MIDI CC コマンドを使用します。トランスポートのボタンにアクセスする際に MIDI Machine 
Control（MMC）や Mackie フォーマットのコマンドを使用するアプリケーションもあります。さらに、いくつかの 
MIDI/DAW アプリケーションは、アクセス可能なパラメータの 1 つのセットに対して、アサインされた MIDI コマン
ドの「固定された」セットを持っています。これらを把握するにはソフトウェアの開発元の資料に頼るより道はあり
ません。この資料を入手するには、ウェブで検索したり、開発元のユーザー フォーラムに投稿して聞いたりするの
も有効な手段でしょう。



FBV MkII Advanced User Guide:   リファレンス

7•5

オンライン リソース
さらに情報が必要ですか？ ワンクリックで手の届く有用なリソースをご紹介しましょう...

• FBV に関する最新のニュースやサポート情報、製品のリリース ノートその他は:  

FBV Online Support

• POD Farm 2プラグイン & POD Farm 2 スタンドアローン・アプリケーションの MIDI コントロールの機能に関して
は、Line 6 POD Farmの公式サイトから入手できる、より詳細なユーザー・ガイドをご覧ください:

POD Farm Online Help

• 他の Line 6 ギアをお持ちですか？ Line 6 の製品マニュアル最新版はこちらからダウンロードできます:

Line 6 Product Manuals

• 技術的な質問のある方、Line 6 のサポートでは、ナレッジ ベースでの検索等、解決手段を多数用意しています:

Line 6 Support

• Line 6 ギアをもっと欲しい、最新のアドオンやアクセサリをチェックしたい、という方は Line 6 オンライン ストア
へどうぞ！

Line 6 Online Store

• Line 6 オンライン コミュニティにご参加ください！ Line 6 ユーザーの方は大歓迎です。以下の特典があります:

• POD Farm のトーンの無償ダウンロード

• GarageBand®, Acid®, Reason® などのループの無償ダウンロード

• LA セッション プロによる無料ギターレッスン

• ニュース速報、リンク、ビデオ クリップ

• コンテスト情報、スペシャル オファー

• ディスカッション フォーラムへのアクセス、ソフトウェアのアップデート、その他諸々

Line 6 Community

http://line6.com/manuals/footcontrollers/
http://line6.com/dispatch/index.html?page=manuals&appid=2097217554
http://www.line6.com/support/manuals/
http://www.line6.com/support/
http://www.line6.com/store/storefront.html
http://line6.com/community/
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